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Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

Uvod T

Trajanje
Tecaj je namijenjen polaznicima koji Zele nauditi koristiti Blender, poglavlja:
besplatan open-source program za izradu 3D racunalne grafike. 10 mi
min

Cilj teCaja je da polaznici steknu osnovnu razinu znanja alata Blender i
upoznavanje s mogucénostima softvera, kojih je mnogo, kako bi se lakse
usmijerili prema svrsi koriStenja softvera koja polazniku vise odgovara.

Polaznici ¢e nauciti koristiti osnovne naredbe i njihove kratice, upoznat
¢e se s postavkama rada u Blenderu, osnovnim vizualnim efektima,
vrstama i svrhama modifikatora (modifiers), fizikalnim svojstvima
(physics properties), animacijama, koristenjem ¢vorova (nodes) itd.

Drugi dio teCaja namijenjen je za naprednije zadatke i ukratko govori o
teoriji i praksi vezanoj za koristenje 3D pisaCa. Ukljucit cemo koriStenje
Blendera i besplatnih softvera namijenjenih za doradu i spremanje
datoteka u drugim formatima koji se koriste za 3D printing.
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1.Upoznavanje radnog prostora e

programa Trajanje
poglavlja:
Po zavrsetku ovoga poglavija moci cete: XX min

instalirati i pokrenuti alat Blender

prepoznati dijelove sucelja programa

razlikovati osnovne obradne metode softvera

bolje razumjeti svrhu alata unutar alatne trake i toolbara

koristiti razli¢ite radne prostore Blendera.

.1. Pokretanje i upoznavanje sucelja Blendera

1.1.1. Sustavi na kojima je dostupan Blender i instalacija

programa

Blender je besplatan profesionalni alat otvorenog koda za 3D racunalnu
grafiku koji se koristi za izradu animiranih filmova, vizualnih efekata,

modela za 3D pisace, interaktivnhog sadrzaja i slicnog. Blender je
dostupan za korisnike operacijskih sustava Windows, Mac i GNU/Linux.

Zanimljivosti i napomene

Proces instalacije programa Blender na sustavu Windows prili€no je Uz klasi¢ni nacin instalacije,
jednostavan. Blender se moze takoder

koristiti preko USB sticka

Potrebno je preuzeti instalacijsku datoteku programa (verzija 4.4.) sa kao prijenosna varijanta bez

stranice https://www.blender.org/download/. NajlakSe je preuzeti

potrebe za instalacijom.

instalacijsku datoteku odabirom bilo kojeg od dvaju dolje navedenih
linkova.

The Freedom to Create

& Download Blender

== Windows - Installer - v4.4.1

342MB - April 15,2025

Slika 1. Poveznica za preuzimanje instalacijske datoteke

Nakon odabira potrebno je instalacijsku datoteku.exe spremiti na
racunalo i pokrenuti. Proces same instalacije slijed je nekoliko osnovnih
opcija koje je potrebno procitati i odabrati one koje odgovaraju
zahtjevima. Sluzbena stranica takoder ima dostupne i starije verzije
programa u sluc¢aju da ih je potrebno koristiti.

Lista starijih verzija s datumom izlaska nalazi se na:
https://www.blender.org/download/previous-versions/ .

@ srce ’
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1.1.2. Pokretanje Blendera

Za pokretanje programa u sustavu Windows odabere se Start > Sve
aplikacije > Blender.

Za pokretanje Blera na Linux sustavima pritisne se Applications ->
Graphics - Blender.

Za pokretanje na sustavima Mac potrebno je odabrati mapu
Applications te potom Blender.

1.1.3. Upoznavanje sa suceljem programa

Nakon prve instalacije Blendera, prije nego $to se pojavi pocetni prozor,
pojavit ¢e se prozor s brzim postavkama (Quick Setup).

Prva postavka, odabir jezika sucelja, neka ostane na engleskom jeziku.

Nakon odabira jezika, unutar postavki Shortcuts, ostavite pod Blender.
Ova opcija sluzi za korisnike koji imaju iskustva s drugim softverima za
3D modeliranje poput Maye kako bi mogli koristiti kratice s kojima su
upoznati.

Potom treba izabrati preferiranu tipku na miSu za selekciju: lijevu ili
desnu buduéi da se duze vrijeme koristila desna tipka za selekciju u
Blenderu. Pretpostavka je da ¢e vecina izabrati lijevu tipku jer je to
naj¢esc¢i nacin za selekciju putem misa.

Nize na meniju moze se dodijeliti specificnu postavku za tipku
[Spacebar] na tipkovnici. Preporuka ju je vezati s opcijom Search. Cesto
Cete trebati koristiti specificnu operaciju €ije se lokacije mozda necete
moci sjetiti u danom trenutku, ima ih jako puno. U tom slu€aju dosta je
korisno imati moguénost pretrage putem tipke [Spacebar].

Zadnje, postavka za temu iskljucivo ovisi o preferencijama korisnika jer
je to sasvim estetska promjena. Promijenit ¢e boju pozadine, menija te
cijelog korisnickog sucelja. Preporuka iz iskustva je postaviti na Dark
Mode ako planirate viSe sati provoditi ispred ekrana, tako ¢e biti maniji
stres na o€i. Nakon postavljanja teme pritisnite Save New Settings i
Quick Setup postavke su gotove.

Slika 2. postavke Quick Setup
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Pri pokretanju Blendera pozdravni zaslon (Splash screen) pojavi se u
centru sucelja. Sadrzi opcije za stvaranje novog projekta ili otvaranje
nedavno koristenog.

Kako biste zatvorili pozdravni zaslon i pokrenuli novi projekt, pritisnite
bilo gdje izvan Splash zaslona, ali da je unutar Blenderova sucelja ili pri
tisnite [Esc]. Pozdravni zaslon ¢e zatim biti uklonjen te e biti prikazano
pocetno sucelje (default screen). U slu€aju da je potrebno ponovno
otvoriti pozdravni zaslon potrebno je pritisnuti na Blenderov logo unutar
gornje trake te odabrati Splash Screen. Pozdravni zaslon sadrzi:

¢ Information Region (Informacijska regija)

Gornji dio pozdravnog zaslona sadrzi sliku s verzijom Blendera u
gornjem desnom kutu.

¢ Interactive Region (Interaktivna regija)
Donja polovica pozdravnog zaslona.

o New File (Novi projekt)
Pokreni novi projekt baziran po predlosku

¢ Recent Files (Otvaranje postojeceg projekta)

Nedavno otvoreni Blender projekti odnosno blend-datoteke
(Blender datoteke imaju ekstenziju .blend). Omogucuje brz
pristup nedavno koridtenim projektima. Podrazumijeva se da ova
opcija nece bit prisutna pri prvom koridtenju Blendera.

e Open (Otvori)
Otvara postojecu blend-datoteku.
o Recover Last Session (Obnovi posljednju sesiju)

Blender ¢e pokusati obnoviti zadnju sesiju bazirano na
privremenim datotekama. Za viSe detalja pogledajte poglavlje
Recovering data na njihovoj sluzbenoj stranici:
https://docs.blender.org/manual/.

e Getting Started (Poveznice)

Poveznice koje vode na Blenderovu sluzbenu stranicu. Ista
poveznica moze se naci na kartici Pomoc unutar trake glavnog
izbornika.
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General __,I_ Manual

2D Animation __r Blender Website

Sculpting __,I, Credits

fideo Editing

m Open...

Recover Last Session

Slika 3. Prikaz interaktivne regije

Nakon pokretanja Blendera i zatvaranja pozdravnog zaslona Blender
prozor bi trebao izgledati sliCan donjoj slici.

Blenderovo sucelje je podijeljeno na tri dijela:

1. Traka glavnog izbornika, na samom vrhu, sastoji se od izbornika
koji se koristi za spremanje, uvoz i spremanje datoteka u drugom
formatu, konfiguriranje postavki i renderiranje (postupak
stvaranja slike).

2. Prozor u sredini, $to je glavna radna povrsina, sastoji se od:
o 3D preglednika (3D Viewport) — zuti okvir
o Vremenska linija (Timeline) — crveni okvir

o Lista objekata koristenih u Blenderu (Outliner) — zeleni
okvir

o Editor svojstava (Properties) — plavi okvir

3. Statusna traka na dnu sucelja, prikazuje preporucene kratice i
relevantne informacije i statistike o trenutnim prikazanim
objektima.

® Hei A Pren

Slika 4. Izgled Blenderova sucelja
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1.2. lzrada novog projekta

Pri pokretanju Blendera kao standardni izgled sucelja pojavi se ekran
koji je prikazan na prijasnjoj slici bez potrebe da se ide na File 2 New >
General. Osim postavke General, koja ¢e se primarno koristiti, postoje i
druge standardne postavke projekta za 2D Animation (2D animaciju),
Sculpting (kiparenje), VFX (vizualni efekti), Video Editing (uredivanje
videa).

A% Blender

@' File | Edit Render Window Help Lavout

L. = CEr] T e General
B Open.. 20 Anirmation

Open Recent Sculpting

Recover Video Editing

Slika 5. Prikaz standardnih postavki projekta

1.3. Alati u Blenderu

Mesh modeling (modeliranje mreze) u Blenderu je proces stvaranja 3D
modela koriste¢i mesh (mrezu) koja se sastoji od vertices (vrhova ili
toCaka), edges (bridova) i faces (lica). To je jedna od osnovnih tehnika
modeliranja u Blenderu i drugim 3D softverima. Blender podrzava viSe
tehnika modeliranja, a mesh modeling je bazi¢na i najéeS¢a tehnika
modeliranja. Modeliranje mreze tipicno po€inje s mesh primitive
(primitivnom mrezom) oblika kocke, kugle, cilindra, ovisno o Zelji
korisnika te se zatim manipulira mrezom kako bi stvorio vedéi i
kompleksniji oblik. Mesh modeling omogucen je kada se odabere Edit
Mode na padajuc¢em izborniku ili kartica Modeling (prikazano na slici
dolje u crvenom).

J@ File Edit Render Window Help _ayout Modeling Sculpting

2. ¥ EditMode ~ ®J ()@ View Select Add Mesh Vertex Edge Face
il

User Perspective

{1) Cube

Slika 6. Radni prostor Modeling

3D preglednik ima dvije osnovne metode koje daju mogucnost kreiranja,
editiranja i manipuliranja mrezom modela. Svaka metoda ima razne
alate, a neki od alata mogu se naci u jednoj ili viSe metoda. Metode koje
Ce se pretezito koristiti su Object Mode i Edit Mode.

Operacije u Object modeu (objektna metoda), na dolje prikazanoj slici,
imaju efekt na cijeli objekt. Object mode ima sljedeci izgled u 3D
pregledniku:

@ srce ’
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+%. W Object Mode v

A0

Slika 7. Operacije u Object Modeu

Operacije u Edit Modeu (obradna metoda) utje€u samo na geometriju
selektiranog objekta, ali nemaju utjecaja na globalne postavke poput
lokacije i rotacije objekta. Moze se samo modificirati mreza objekta koji
obradujete. Kako biste modificirali druge objekte, potrebno je izaéi iz Edit
Modea, uci u Object Mode te zatim selektirati traZzeni objekt i onda se
vratiti u Edit Mode. Edit Mode ima sljedeci izgled u 3D pregledniku:

Slika 8. Operacije u Edit Modeu
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1.3.1. Alatna traka

Unutar 3D preglednika gornja traka sadrzi skup alata i pomagala koji su
nuzni za obradu objekata i snalazenje u sucelju Blendera.

2~ ¥ EditMode ~ S0 () @) View Select Add Mesh Vertex Edge Face UV I, Global v (Pv Bl (=

Slika 9. Gornja traka preglednika

1.

Editor type sluzi za prebacivanje iz jednog u drugi editor
(uredivac), primjerice uredivac gdje se radi na objektima je 3D
Viewport, u njemu se radi vecina posla vezanog za modeliranje.
Blender pruza velik broj razli€itih editora za prikazivanje i obradu
razliCitih aspekata podataka. Editor se nalazi unutar podrucja
(Blenderov prozor je podijeljen na viSe segmenata) Cija se
veli€ina moZze prilagoditi unutar Blenderova prozora. Editor type
je prva tipka s lijeve strane zaglavlja, koja omogucuje promjenu
editora u tom podrucju. Takoder je moguée imati simultano u
viSe prostora otvoren jednaki editor.

Object interaction mode sluzi za prebacivanje iz
Object Modea i Edit Modea te sluZi kao pokaziva¢ u kojoj metodi
je trenutno postavljen.

Selection mode (Bl omogucuje biranje izmedu 3 selekcije,
vertex (tocka), edge (brid) ili face (lica/poligon).

Transformation orientation prikazuje osi x
(apscisa), y (ordinata) i z (aplikata) u 3D prostoru ¢im se
selektira ili pritisne 3D pokazivacem te kao drugu ulogu
omogucuje da se namjesti prema kojem ¢&e se prostoru
orijentirati osi, bilo prema lokalnom (local space), koji predstavlja
prostor selektiranog objekta, ili globalnom (global space), koji
predstavlja prostor cijele scene ili prema normalama objekta
(normal). O normalama u viSe detalja kasnije.

Transform pivot point uloga glavne tocke je odrediti kako
Ce se i oko koje tocke Siriti ili rotirati objekt. Pivot center ima viSe
opcija. Medijan ili centralna vrijednost (medijan point) omogucuje
da se manipulira ve¢im brojem objekata kroz zajednicku srednju
toCku, dok individualno podrijetlo (individual origins) za svaki
selektiran objekt odredi zasebnu srediSnju toc¢ku po kojoj ¢e se
manipulirati. 3D pokaziva¢ (3D cursor) kao glavna to¢ka
omogucuje da se odredi lokacija to¢ke oko koje Ce se
manipulirati selektiranim objektima.

Snap 28R4 omogucuje hvatanje objekata i dijelova mreze za
razliCite tipove elemenata scene tijekom transformacije
selektiranog objekta. Snap ima viSe opcija na Sto ¢e se zahvatiti,
ovisno o potrebi. MoZe se izabrati da to bude lice objekta, brid ili
toc¢ka, dok inkrement daje opciju da se veZe za pozadinsku
reSetku scene koja je podijeljena na kvadrate.

Proportional editing m nacin transformiranja selektiranih
elemenata (poput toCaka) dok u meduvremenu ta manipulacija
elementom utje€e na okolne elemente. Primjerice, pomicanjem
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jedne tocke uzrokuje pomicanje okolnih neselektiranih to¢aka u
odredenom krugu. Neselektirane toc¢ke locirane blize selektiranoj
tocci bit ¢e pod vecim utjecajem za razliku od udaljenih,
odnosno micat ¢ée se proporcionalno relativno lokaciji
selektiranog elementa.

8. Show Gizmo and Overlays prikazuje naprave
poput navigacijskog orijentira, linija koje prikazuju osi,
koordinatne mreze (reSetka) i druge naprave. Pritiskom na ikonu
ili koristeci kraticu [Shift]+[Alt]+[Z] iskljuCuje se ili ukljuCuje
naprava.

9. Toggle X-Ray[El objekti su relativno prozirni, vidljive su tocke,
bridovi i lice s druge strane relativno na kut gledanja.

10. Viewport Shading [Z _LSI@A daje moguénost da se objekti
promatraju na viSe nacina da bi se olak3alo ili dalo na znanje
kako bi otprilike objekt izgledao nakon obrade. Zadana metoda
pregleda je solidan pregled (solid view), druge koje ¢e se koristiti
su mrezni pregled (wireframe), pregled materijala (material
preview) i prikazni pregled (rendered). Wireframe omogucuje
pregled objekata poput mreZe i olakSava selektiranje odredenih
toCaka koje inace nisu vidljive iz prednje perspektive. Material
preview je posebno pogodan za pregledavanje materijala i
slikanje tekstura. Mogu se odabrati razliite uvjeti osvjetljenja
kako bi se testirali materijali. Rendered view prikazuje kako ¢e
objekt izgledati pod boljim uvjetima i postavkama buduci da je to
dosta zahtjevan proces, rendered view prikazuje objekt pod
nizom kvalitetom od krajnjeg produkta kako biste mogli rotirati
kameru oko objekta i pregledavati kako ¢e izgledati bez velikih
zahtjeva za racunalo.

1.3.2. Toolbar

Toolbar pre€ac tipka [T], koja se nalazi s lijeve strane unutar 3D
preglednika, sadrzi tipke za razliCite alate. Tipke s manjim trokutima u
njihovu desnom donjem kutu su Tool Groups (grupe alata) koje se mogu
otvoriti drzeci lijevu tipku miSa na njima.

Scale

Scale Cage

Slika 10. Scale opcije

Drzeéi pokaziva¢ miSa na alatu nakratko ¢e se prikazati njegovo ime,
dok duze drzanje prikazuje kratak opis alata.

° @ srce
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Slika 11. Kratak opis Scale alata

Toolbar tipke moguce je rasporediti na viSe nacina. Postaviti ih u jedan
stupac, stupac s nazivima ili kako je prikazano nize, rasporedeno u dva
stupca. Dok je postavljen Object Mode, prikazane su osnovne tipke za
skaliranje, translatiranje, rotiranje, Transformiraj (engl. Transform), koji
omogucuije sve prije navedene opcije u jednom, Metar (engl. Measure)
koji sluzi za mjerenje duljine i kutove i Dodaj kocku (engl. Add Cube)
gdje je moguce dodati kocku i ostala osnovna geometrijska tijela, tipka je
oznacena crvenim okvirom na donjoj slici.

User Parspective

{1) Collection | Cube.001

1.000

1.000

Slika 12. Prikaz Toolbar tipaka

S desne se strane tijekom rada u Object Modeu pojavljuje dijaloSki
izbornik prozor, pre€ac je tipka [N] za isklju€ivanje i ukljuCivanje te sadrzi
osnovne informacije o objektu kaoji je trenutno selektiran. Od osnovnih
informacija koje su prikazane u navedenom prozoru, koje se i najviSe
koriste, tu su Lokacija (Location), §to prikazuje koordinate po osima x, y
i z, Rotacija (Rotation) prikazuje pod kojim je kutom rotiran objekt oko
odredene koordinatne osi, Skaliranje (Scale) omogucuje mijenjanje
proporcija objekta po odredenim osima te Dimenzije (Dimensions) koji
prikazuje duljinu objekta po osima, odnosno dimenzije objekta koji je
selektiran.

Navedena svojstva mogu se mijenjati na viSe nacina, primjerice ako se
pritisne i drzZi lijevom tipkom misa na jednu od vrijednosti, pomicanjem
na lijevu ili desnu stranu smanijuje se ili povecava vrijednost koja je
selektirana, a pritiskom na strelice moze se mijenjati vrijednost. Takoder
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je moguce upisivanje Zeljene vrijednosti. Postoje i nacini koji koriste
preCaca, no oni Ce se proci detaljnije u sljede¢em poglavlju.

» Transform

Location:

< X Om »

\Y‘ M e
7 Location of the object.

Slika 13. Vrijednosti za lokaciju objekta

Za razliku od Object Mode prikaza, Edit Mode prikaz otvara nove opcije
unutar Toolbara. Ispod Add Cubea pojavljuju se tipke namijenjene za
nesto kompleksnije uredivanje objekata:

1. Extrude Region (istisnuti) sluzi za istiskivanje odnosno
izvlaCenje geometrije (lica, bridovi ili tocke) odabranog objekta.
Alat Extrude radi kopiju toCaka dok simultano drzi nove tocke
spojene s originalnim to¢kama.

2. Inset Faces (umetni lica) omogucuje umetanje novih lica unutar
originalnog lica.

3. Bevel (zaobljivanje) je alat za dodavanje lica na brid i
zagladivanje promijenjenog brida.

4. Loop Cut (dodavanje bridova) dodaje dodatne bridove i lica za
bolju manipulaciju objekta.

5. Kbnife (noz) reze geometriju objekta postavljajuci linije ili
zatvorene petlje za rezanje rupa.

Usar Parspsactiva

(1] Cube 3

5

Slika 14. Dodatne opcije Toolbara u Edit Modeu

U Edit Modeu dijaloski okvir prikazuje Medijan (centralnu vrijednost) te
koordinate te vrijednosti. Medijan predstavlja referentnu tocku za
transformaciju, koja se postavlja na sredinu svih odabranih toaka
(vertexa), bridova ili poligona unutar objekta. Ova funkcionalnost
omogucava precizno transformiranje geometrije objekta s obzirom na
njegovu sredinu. Primjerice, ako se odabere nekoliko vertexa unutar
jednog objekta u Edit Modeu i pokusa ih se translatirati, rotirati ili
skalirati, Median ¢e Koristiti srednju to¢ku tih odabranih vertexa kao
referentnu toCku za transformaciju, $to znaci da ¢e transformacije
primjenjivati u odnosu na tu srednju tocku.
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12, Global » 5

< Transform

Slika 15. Dijaloski okvir prikazuje Median

1.4. Workspaces

U Blenderu su Workspaces (radni prostori) organizirani setovi prozora i
alata koji su optimizirani za odredene zadatke ili radne procese. Svaki
radni prostor u Blenderu pruza prilagodeno okruzenje koje olakSava
izvodenje specifinih zadataka kao $to su modeliranje, animacija,
uredivanje materijala, renderiranje scene itd.

Layout

Hd  Object

Slika 16. Izbor radnih prostora

Blender dolazi s nekoliko ugradenih radnih prostora, a korisnici takoder
mogu stvoriti vlastite prilagodene radne prostore prema svojim
potrebama. Pocetni radni prostor ili predefinirani prostor je Layout
workpsace, a koristi se za opéenito modeliranje i uredivanje scene. U
tom radnom prostoru, ima prozore za prikaz 3D pogleda, izbornik za
manipulaciju objektima, alate za modeliranje, moguce je imati prozor za
pregled kamera ili svjetala, te druge panele koji vam mogu biti korisni
tijekom modeliranja i uredivanja scene. Evo nekoliko uobi¢ajenih
ugradenih radnih prostora u Blenderu:

Modeling (Modeliranje): Radni prostor optimiziran za modeliranje
objekata. UkljuCuje alate za stvaranje, uredivanje i manipulaciju
geometrijom.

Sculpting (Kiparenje): Radni prostor namijenjen kiparenju digitalnih
modela.
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UV Editing (Uredivanje UV mapiranja): Ovaj radni prostor koristi se za
uredivanje UV mapa objekata, $to omogucuje precizno mapiranje
tekstura na geometriju.

Texture Paint (Uredivanje tekstura): Ovaj radni prostor pruza alate za
ruéno slikanje tekstura izravno na modele.

Shading (Uredivanje materijala): Ovaj radni prostor fokusiran je na
uredivanje materijala i tekstura objekata.

Animation (Animacija): Ovaj radni prostor namijenjen je animiranju
objekata i karakterima. UkljuCuje alate za stvaranje klju¢nih okvira,
krivulje animacije, postavljanje ikona itd.

Rendering (Renderiranje): Ovaj radni prostor koristi se za postavljanje
parametara za renderiranje slika ili animacija, kao i za pregled rezultata
renderiranja.

Radni prostori omogucuju korisnicima da se fokusiraju na odredene
aspekte procesa rada u Blenderu i olakSavaju prelazak izmedu razli€itih
zadatka. Osim toga, korisnici mogu prilagoditi radne prostore
dodavanjem ili uklanjanjem prozora i alata kako bi bolje odgovarali
njihovim specificnim potrebama i radnim tijekovima. Svaki prozor
odnosno Editor type unutar workspacea, ima ikonu za padajuci izbornik
u gornjem lijevom kutu za mijenjanje tipa prozora.

elect Add Object

2 3D Viewport SHIFERS] *5*

™ Editor O Timeline
i v
d

Slika 17. Tipovi editora

Primjerice, Shading workspace ¢e biti od veée vaznosti kod naprednijih
zadataka i vjezbi, dok je Layout workspace koristan za osnovne zadatke.

Izgled Shading workspacea:
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| Juteli

T S—
1) Cotlection | Cube

Use Nodes.

Slika 18. Radni prostor Shading
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1.5. Vjezba: Upoznavanje radnog prostora u

Blenderu

Otvorite novi projekt i odaberite General.

Postavite display method (Viewport shading EL 1« EM)na
mrezni pregled odnosno Wireframe.

Iskljucite Show Overlays koristeci kraticu [Shift]+[Alt]+[Z] da se
ne prikazuje mreza.

Na dijaloskom okviru Transform (kratica [N]) s desne strane, u
opciji Location, postavite objekt na postavke x=5m, y=0m, z
=0m.

U opciji Rotation postavite vrijednosti x = 45°, y = 45°, z=0°.

U istom dijaloSkom okviru, u opciji Scale, postavite vrijednosti na
x=5y=3,z=2.

U izborniku Object interaction mode postavite prikaz u Edit
Mode.

Postavite radni prostor iz sadasnjeg Layout prikaza na Shading.

Spremite dokument (File > Save As) pod nazivom
Prva_vjezba.blend.
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2.0snovni 3D objekti i njihove -

mogucnosti Trajanje
poglavija:
Po zavrSetku ovoga poglavija moci cete: XX min

e bolje poznavati sloZzeno sucelje alata Blender
e dodati, pomicati i manipulirati objektima
e raditi u Edit Modeu i baratati osnovnim alatima za obradu

e dodavati materijal za objekte i koristiti osnovne efekte

2.1. Stvaranje osnovnih grafickih objekata

U softveru Blender objekti se mogu izraditi koristeci razlicite metode i
precice. Ako se Zeli dodati objekt, na gornjoj traci glavnog prozora
odabere se Add > Mesh - Cube ili drugi objekt po izboru.

1o :I Object Mode ~ View Select | Add Object
o
User Perspective
(1) Collection | Torus

& —
» (-
v U

v
—~
jer

L4
=
L

Image

..
4 [ 13
oy

L Light
',-_ Light Probe

% Camera

7 N

P

Slika 19. Dodavanje objekta u scenu

Pre€ac za dodavanje objekata je [Shift]+[A], kojim se otvori isti izbornik
kao na prethodnoj slici. Za odabir ili poniStavanje odabira svih objekata u
sceni potrebno je pritisnuti tipku [A]. Za brisanje jednog ili vise objekata
potrebno ih je prvo selektirati i zatim tipkom [Delete] ukloniti s radne
povrsine.

Medu osnovnim objektima koji su dostupni unutar kategorije Mesh
koriste se kocka (engl. Cube), kugla (engl. Circle), cilindar (engl.
Cylindar), konus (engl. Cone) te torus (engl. Torus), koji su vrlo korisni
zbog svoje jednostavnosti za prilagodavanje i slaganja kompleksnijih
objekata po potrebama korisnika.
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Slika 20. Prikaz osnovnih objekata

Takoder je, pomocu vec¢ spomenutog Toolbara, koji se nalazi na lijevom
rubu 3D preglednika, moguce dodavati osnovne objekte u radni prostor.
Pri dodavanju objekta mogu se aktivirati tri opcije koje modificiraju oblik
objekta pri dodavanju u radni prostor. Drzanje tipke [Ctrl]] omogucuje
automatsko poravnavanje objekata s drugim objektima prilikom njihova
povlacenja miSem (Toggles snap while dragging), drzanje tipke [Alt]
omogucuje povlacenja objekata iz njihova srediSta umjesto iz njihovih
rubova ili kutova (Toggles dragging from center), a drzanje tipke [Shift]
omogucuje odrzavanje fiksnog omjera dimenzija izradujete ili neki objekt
(Toggles fixed aspect).

p while dragging.
1g from the center.
ed aspect.

Slika 21. Prikaz opcija koje modificiraju oblik

Pritiskom na ikonuAdd Cube moze se odabrati objekt koji se zeli
dodati u radni prostor. Prvo je potrebno odrediti dimenzije baze
povlaéenjem mida te zatim pustiti tipku i pomicanjem misa prema gore
se odrediti visinu te, kada su dimenzije objekta prema potrebama,
potrebno je pritisnuti lijevu tipku misa [Left Mouse Button, LMB] da se
potvrdi. Dolje je primjer dodavanja torusa: s desne je strane formiran i
potvrden objekt, dok je s lijeve strane prikaz zi¢anog oblika prije potvrde
ljevom tipkom misa.

|

Slika 22. Primjer torusa prije i poslije potvrde
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Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

Pregled objekata na sceni nalazi se unutar prozora u gornjem desnom
kutu glavnog prozora Blendera odnosno u Outlineru koji sluzi za pregled
i upravljanje svim objektima, scenama, grupama i drugim elementima
koji se nalaze u projektu. Osim ve¢ spomenutih Mesh objekata, na sceni
su prisutni i objekt potreban za slaganje rasvjete (Light) te kamera
(Camera). Kamera je klju€an element za snimanje scena. Glavna svrha
kamere je stvaranje perspektivhog pogleda na scenu ili objekte kako bi
se generirala slika ili animacija. Kamera ¢e se viSe implementirati u
procesu renderiranja.

v H-@® 00000 -
Options v

Light

Slika 23. Pregled objekata na sceni

2.2. Navigacija i kretnje u radnom prostoru

Kada se ubaci objekt na radnu povrsinu, vazno je primijetiti gdje i zasSto
se taj objekt pojavio na toj poziciji. Sam centar radne povrSine odnosno
pocetak koordinatnog sustava za tu scenu naziva se World Origin
(porijeklo svijeta) i sluzi kao osnova za pozicioniranje objekata i
manipulaciju njima. Pri otvaranju nove scene u Blenderu World Origin se
nalazi u sredistu 3D prostora. Koordinatni sustav sastoji se od osi x, y i
z, a Porijeklo svijeta oznaCava mjesto gdje se sve tri osi susrecu, to je
toCka s koordinatama (0,0,0). Koriste¢i World Origin kao referentnu
to¢ku koja predstavlja poCetak koordinatnog sustava znatno se olaksava
pozicioniranje i rasporedivanje objekata u sceni.

Slika 24. World Origin kao referentna tocka

@ srce 2



Osnove rada u 3D grafiCkom alatu Blender (oznaka tecaja)

Takoder, u samom srediStu scene pojavljuje se i crveno-bijeli krug koji
predstavlja Cursor (pokaziva¢ misa), interaktivni alat koji sluzi kao
referentna toCka u 3D prostoru koja se Koristi za razliCite svrhe,
prvenstveno za pozicioniranje objekata i Snap (prikaci) naredbe.

Pritiskom na ikonu kursora . unutar Toolbara, moze se odrediti pozicija
pokazivaca lijevom tipkom miSa [LMB] na Zeljenu lokaciju. Kada se
koristi naredba Add, postavljanjem pokazivac¢a mi$a na odredenu
lokaciju u 3D prostoru,odreduje se mjesto gdje ¢e se novi objekt stvoriti
ili pomaknuti. Dok Snap koristi pokaziva¢ misa kao referentnu tocku za
prikaciti objekt na odredene tocke u sceni. Pre€ac [Shift]+[S] otvara
prozor alata Snap sa svim mogucnostima:

Selection to Grid: prikvaci trenutacno odabrane objekte na najblizu
toCku redetke (grid).

Selection to Cursor: premjesta odabrane objekte tako da budu
centrirani na pokazivacu.

Selection to Cursor (Keep Offset) postavlja selektirano na polozaj
pokazivaa miSa; ako je viSe objekata odabrano, oni se ne premjestaju
pojedinacno na polozZaj kursora, umjesto toga centriraju se oko
pokaziva€a odrzavajuéi njihove relativne udaljenosti.

Selection to Active poravnava sve odabrane objekte prema aktivhom
objektu, posljednje odabranim objektom u grupi. Ovo je korisno za
poravnanje viSe objekata prema jednom od njih.

Cursor to Selected postavlja pokaziva€ na sredinu odabranih objekata.
Korisno za postavljanje pokazivaca na centar odredenih elemenata u
sceni.

Cursor to World Origin postavlja pokaziva¢ natrag na Porijeklo svijeta,
tj. na poletak koordinatnog sustava scene.

Cursor to Grid koristi se za postavljanje pokazivaca na to¢ku reSetke
koja je najbliza trenutnom polozaju u 3D prostoru.

Cursor to Active: omogucuje postavljanje 3D pokazivaca na poziciju
aktivnog objekta, posljednjeg objekta koji je odabran u trenutnoj sceni.
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.
QR
s ¥ Ssclection to Cursor

h : \\'\

¥ Selection to Cursor (Keep Offset) ¥ Selection to Active

\ Snap selected item(s) to the 3D cursor. .

):_( Cursor to Grid ¥ Selection to Grid

| |

):( Cursor to World Origin }:( Cursor to Active

\
\\. XY Cursor to Selected

Slika 25. Snap to opcije

2.2.1. Koristenje misa za navigaciju u radnom prostoru

Uz znacajan broj naredbi i njihovih pre€aca, navigiranje i kretanje u 3D
prostoru Blenderova sucelja nezamislivo je bez misa. Mi$ je neophodan
alat za interakciju s 3D prostorom i korisni¢kim suc€eljem u Blenderu,
omogucuije korisnicima da efikasno stvaraju, ureduju i manipuliraju 3D
sadrzajem. Predefinirani pogled Blenderova sucelja je User Perspective,
u gornjem lijevom kutu preglednika vidi se kada je korisnik u tom
pogledu.

User Perspective

{1) Collection | Camera

Slika 26. Perspektiva korisnika

Koriste¢i mi§, Blender omogucuje rotiranje, pomicanje i zumiranje unutar
pogleda. Nacini na koje se mi$ koristi za orijentaciju u Blenderu:

Rotiranje pogleda: drzanjem srednje (Scroll) tipke mi8a pritisnutom i
pomicanje miSa u Zeljenom smjeru. To Ce rotirati pogled na scenu.

Pomicanje pogleda: drzanjem pritisnutom kombinaciju tipke [Shift] i
srednje tipke misa ili koluta [MMB] dok se pomie mis. To ¢e omoguditi
pomicanje kamere ili pogleda u ravnini.

Zumiranje pogleda: koriStenjem tipke Scroll, rotiranje prema naprijed za
zumiranje u scenu, a prema natrag za udaljavanije iz scene. To
omogucuje priblizavanije ili udaljavanje od objekata u sceni.

2.2.2. Pomicanje objekata u radnom prostoru

Pomicanje odnosno translatiranje objekata u Blenderu je moguce na
viSe nacina, od klasi¢nog “drag and drop” do upisivanja vrijednosti za
lokaciju unutar menija Transform [N], vazno ih je sve metode prodi i

Zanimljivosti i napomene

Obratiti paznju na status
traku na dnu pri kori$tenju
raznih naredbi, koja
prikazuje preporucene
precice, relevantne
informacije i statistike o
trenutno prikazanim
objektima.
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dobiti bolju percepciju 3D radnog prostora Blendera kako biste lakse i
brze koristili sve opcije koje nudi ovaj softver.

Za pocetak, za selekciju objekta koristi se lijeva tipka miSa [LMB], za
selektiranje viSe objekata miSem treba se drzati tipka [Shift]. Uklanjanje
selekcije s objekta takoder se moze pomocu drzanja tipke [Shift] i
ponovnim odabirom tog objekta lijevom tipkom misa [LMB]. Nize na slici
vidi se da je postavljeno na Select Box, $to omogucuje da se selektiraju
objekti pomocu tipke [LMB]. Provjerite je li postavljeno kao Sto je
prikazano na slici. Tipkom [W] moZe se rotirati izmedu viSe vrsta
selekcija, ali radi jednostavnosti, druge ¢e se Koristiti putem precaca.

Select Box
Select itemr g box selection.

Slika 27. Ikona Select Box

Za selekciju vide objekata postoji vise nagina ovisno o namjeni i potrebi.
Za selektiranje svih objekata u radnom prostoru koristi se tipka [A], za
ponistavanje odabira precac [Alt] + [A] (u postavkama se mozZe odrediti
da se duplim pritiskom tipke [A] ponistava odabir). Selektiranje je
takoder moguce tipkom [B], daje opciju da se zaokruze objekti, dok se
drzanjem tipke [Shift] poniStava selekcija zaokruzenih objekata.

Taj nacin za pomicanje koristan je za jednostavnije zadatke, ali nije
precizan, tako da je za ozbiljnije radnje potrebno unijeti vrijednosti za
lokaciju unutar prozora Transform ili koriStenjem koordinatnih osi po
kojima se pomicu objekti te za kraj upisati neku vrijednost.

Pomocu alata Grab/Move (pomicanje), aktiviranog tipkom [G], radi se
ista radnja kao i pritiskom desne tipke miSa na objekt. No u ovom slucaju
nakon $to je objekt selektiran potrebno je odabrati os. Nakon odabira
tipke [X],[Y] ili [Z] treba upisati vrijednost. Blender ¢e prepoznati da su,
nakon $to je alat Move aktiviran i odabrana os, naknadno upisane
vrijednosti odnose na operaciju Move. Primjerice, ako se Koristi x-0s,
upisom vrijednosti 10 objekt ¢e se pomaknuti za 10 jedinica po osi x. Isto
vrijediiza osiyi z

D: [10]] = 10 m (10 m) along global X

Slika 28. Pomicanje objekta po X-osi
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Takoder, moguce je pomicanje objekata pomoc¢u naprava (gizmos). U
gornjem lijevom kutu 3D preglednika treba odabrati ikonu u obliku kriza.
Pritisnuti na ikonu da bi se omogucio prikaz naprave za odabrani objekt.

Alat Gizmos za translaciju odnosno Move i ostali koji su dostupni mogu
se ukljudivati i iskljuCivati u gornjem desnom kutu 3D preglednika. Kada
se ukljuci naprava za translaciju, na selektiranom objektu ¢ée se pojaviti
lokacijske strelice za svaku od osi. Crvena predstavlja x-os, zelena
predstavlja y-o0s, a plava z-0s. Za pomicanje objekta koristeci osi
potrebno je lijevom tipkom miSa [LMB] pritisnuti jednu od strelica i drzati
te miSem povlaciti u Zelienom smjeru.

Slika 29. Pomicanje objekta s Gizmos

2.3. Manipulacija objektima i rad u Edit Modeu

Osim jednostavnog translatiranja po 3D prostoru objekti u Blenderu,
mogu se manipulirati i mijenjati na mnogo nacina. Velika vecina njih ipak
zahtijeva da se korisnik prebaci iz prikaza Object Mode u Edit Mode. Za
pocetak treba se dobro upoznati s alatima Rotate [R] i Scale [S] koji su
dostupni i u Object Modu. Preporucljivo je da se Rotate i Scale koriste u
Edit Modeu kada se rade kompleksnije promjene, pogotovo gdje su
involvirane teksture i modifikatori, no o tome kasnije.

Za jednostavnije primjere i upoznavanje koristit ¢e se Rotate i Scale u
Object Modeu. Kao i do sada, koristit ¢e se osnovna kocka kao primjer
koja se dobije pri otvaranju nove scene. Osim tipki [R] i [S], rotacija i
skaliranje mogu se obavljati putem prozora Transform, koristenjem
Toolbara s lijeve strane ekran i Gizmos u gornjem desnom kutu, isti
princip kao i kod translatiranja.

Slika 30. Nacini za rotiranje i skaliranje objekta
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Za rotiranje objekta koristit ¢e se tipka Rotate na Toolbaru. Kada se
pritisne tipka za rotiranje, pojavit ¢e se vizualni prikaz naprave Rotate na
aktivnom objektu koji se sastoji od 4 kruga. Plavi, zeleni i crveni krugovi
koji predstavljaju moguénost rotacije oko z-, y- i x-osi te bijeli krug koji
predstavlja rotaciju koja se vrsi relativno u odnosu na ono $to je trenutno
prikazano u pregledniku (viewport). Drzanjem lijeve tipke miSa [RMB] i
povlaéenjem u Zeljenom smjeru rotira se objekt. Na desnom prozoru
Transform moze se vidjeti promjena pod Rotation na Z-vrijednosti kako
se rotira objekt.

Slika 31. Rotiranje objekta pomocu tipke Rotate

Za skaliranje objekata koristit ce se Gizmos kao primjer. Kako bi Gizmos
za skaliranje bio aktivan, potrebno ga je ukljuciti pritiskom na padajuci
izbornik G/'zmoste pod Object Groups odabrati Scale, kao sto je
prikazano dolje na slici. Sli¢no kao kod alata Rotate, vizualni prikaz alata
za skaliranje je na aktivnom objektu, u obliku tri poluge za svaku od
koordinatnih osi i bijelog kruga koji sluzi za skaliranje objekta u svim
smjerovima ravnomjerno, umjesto posebno po odredenoj osi. Nacelo je
isto kao kod Rotate: drzanjem lijeve tipke miSa [RMB] na poluzi i
povlaéenjem u Zeljenom smjeru skalira se objekt po odabranoj osi ili
drzanjem kruga i povla¢enjem, gdje se objekt skalira u svim smjerovima,
Sto je prikazano na slici dolje na desnoj kocki.

Slika 32. Skaliranje objekta pomocu Gizmos

Unutar prozora Gizmos pod Object Gizmos postoji postavka koja se
referira na opciju Transformation orientation (nalazi se unutar alatne
trake, na sredini). Ta postavka modificira orijentaciju odabranih alatki, u
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ovom primjeru alata Move. Ako je postavljeno na Default, koristi
orijentaciju scene odnosno radnog prostora. Standardna postavka scene
uvijek je postavljena na Global. Dakle, ako je postavljeno na Default
unutar prozora Gizmos, to je ustvari Global. Isto pravilo vrijedi za druge
postavke unutar Transformation orientation. Vrlo koristan dodatak za
pomicanje objekata pod razli€itim uvjetima na sceni.

Slika 33. Modificiranje orijentacije alata

Kao primjer, na slici ispod ¢e se prikazati razlika izmedu dviju najvaznijih
i najviSe koristenih orijentacijskih postavki. Razlika izmedu postavke
Global (koja predstavlja prostor cijele scene) s lijeve strane i postavke
Local (koja predstavlja prostor selektiranog objekta) s desne strane je
orijentacija strelica koordinatnih osi. Na prvi pogled suptilna razlika, no
izuzetno vaZna pri pomicanju i doradi objekata unutar Edit Modea.

Slika 34. Razlika izmedu postavki Global i Local
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Zanimljivosti i napomene

Ako se odredene opcije ne
prikazuju odnosno da su
slu¢ajno onemogucene,
moguce je vratiti poCetne
postavke putem File -
Defaults - Load Factory
Settings.

Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

2.3.1. Rad u Edit Modeu

Edit Mode ili obradna metoda sluZi za uredivanje oblika objekta,
prvenstveno za manipuliranje mrezom (mesh) koja se sastoji od toCaka,
bridova i lica. Kako bi se moglo selektirati posebno tocke, bridove i lica,
potrebno je promijeniti selekciju u Selection modeu. Dolje na slici su
prikazani razli¢iti izbori selekcije. Lijeva kocka je u Vertex selection
Modeu, namijenjenom za toCke, srednja kocka je u Edge selection
Modeu, namijenjenom za bridove te postoji i Face selection mode za
lica objekta. Za prebacivanje izmedu vrsta selekcija moze se koristiti
preCac [Ctrl] + [Tab] te tipke [V], [E] i [F] za odabir to¢aka, bridova ili lica.
Moguce je imati sve vrste selekcija aktivne u isto vrijeme drZzanjem tipke
[Shift] i pritiskom na ikone, no radi lakSeg baratanja preporucljivo je
drzati se jedne vrste u vecini sluCajeva.

Slika 35. Vrste selekcija

Obrada u Edit Modeu utjeCe na geometriju aktivhog objekta te nema
utjecaja na globalne postavke poput lokacije i rotacije objekta. Modificira
se samo mreza objekta koji se obraduje. Za obradu drugih objekata
potrebno je izadi iz Edit Modea, u¢i u Object Mode te zatim selektirati
traZeni objekt i vratiti se nazad u Edit Mode. Prebacivanje iz jedne u
drugu metodu radi se pomocu tipke [Tab].

Slika 36. Prebacivanje iz Object Mode u Edit Mode

U Edit Modeu nalazi se mnogo alata za obradu objekata, ali se zbog
prakti¢nosti ve¢inom koristi samo maniji broj njih. Alat Extrude (alat za
ekstruziju) jedan je od osnovnih alata za obradu objekata, a aktivira se
tipkom [E] te se miSem povlaci slobodnim izborom ili koristeéi osi x,y i z.
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Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

Alat za ekstruziju duplicira toCke istovremeno odrzavajuéi novu
geometriju povezanu s originalnim to¢kama. TocCke postaju bridovi, a
bridovi formiraju lica.

Slika 37. Prikaz osnovnih Edit alata

Unutar Toolbara s lijeve strane sucelja nalaze se osnovni alati za obradu
objekata koji ¢e se koristiti na te€aju, ukljuujuéi i Extrude Region, koji
radi na slichom nacelu kao i Extrude. Kako bi se izbjegla konfuzija
izmedu viSe vrsta Exfrude alata, treba se objasniti razlika izmedu
Extrude koji se aktivira tipkom [E] i alata Extrude sa svojim varijantama
unutar Toolbara. Kada se izabere Extrude tipkom [E], koji je i najbrzi
nacin za ekstruziju, povrSina koja je selektirana je ekstrudirana i Blender
je automatski postavlja u Move/Grab Mode, kao da se aktivira alata za
pomicanije tipkom [G]. Selekcija se zatim moze ekstrudirati koristenjem
osi, normala ili slobodnim kretanjem misa u bilo kojem smjeru bez
restrikcija, a za to je potrebno pritisnuti srednju tipku misa [MMB].

Normale ili Normals su vektorske informacije koje se pripisuju svakoj
toc&ci, bridu ili licu u 3D modelu. Primjerice, kod lica normale pokazuju
,smjer u kojem lice gleda. Normale nisu vidljive sa standardnim
postavkama u Blenderu. Da bi se vidjele, potrebno ih je aktivirati na
Mesh Edit Mode > Normals - Display Normals kako bi se prikazale
normale za lica objekta. Unutar prozora mogu se ukljuciti normale za
tocke te se moze definirati duzina normala (prikazane su kao linije).
Postavke za Normals i prikaz linija koje ih predstavljaju mogu se vidjeti
dolje na slici.

Vertex Edge Face UV I, Global ~ (v

~ Faces

Creases Sharp Bevel Seams

I{*[ Size 050N CA

" Edge Marks & Face Marks

Slika 38. Prikaz normala
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Nakon $to je objasnjen osnovni Extrude, moze se nastaviti dalje s
Toolbar Extrudeom i ostalim alatima:

Extrude Tool, kao 5to je ve¢ gore objadnjeno, sluZi za
istiskivanje, odnosno ekstruziju geometrije (lica, bridova ili
toCaka) odabranog objekta. Alat Extrude radi kopiju to¢aka, dok
simultano drzi nove toCke spojene s originalnim tockama.
Extrude Tool ima nekoliko nacina rada:

o Extrude Region bit ¢e primijenjen na sve odabrane regije
zajedno, ali bez obzira na veze medu njima. To znaci da
Ce se sve odabrane regije ponasati kao jedna cjelina
tijekom ekstruzije. Kod Extrude Region pojavljuje se
Gizmo koiji sluzi za povlacenje, odnosno ekstruziju
odabranih lica koja su selektirana, kao sto je prikazano
dolje na slici.

Slika 39. primjer Extrude Regiona

o Extrude Manifold uzrokuje da alat automatski razdvaja i
uklanja susjedna lica prilikom unutarnje ekstruzije. Na
slici niZze, nakon ekstruzije segmenta lijeve kocke prema
gore, na desnoj kocki vidi se kako pri povlaenju na
desnu stranu brid viSe nije vidljiv te povrSina postaje
jedno lice.

Slika 40. Primjer za Extrude Manifold

o Extrude Along Normals omogucuje da se novostvorena
geometrija ekstrudira duz normala odabranog lica ili
skupa lica. Umjesto da se ekstrudira duz globalnih osi,
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kao §to su x, y ili z, ovaj alat koristi orijentaciju lokalnih
normala svakog lica za odredivanje zajednitkog smjera
ekstruzije. Ekstruzija lica radi se kao cjelina. Normale su
vidljive na desnoj kocki na slici dolje, radi boljeg
prepoznavanja smjera ekstruzije.

Slika 41. Primjer za Extrude Along Normals

o Extrude Individual omogucuje da ekstrudirate odabir
vide lica kao pojedinacna umjesto kao regiju. Lica se
ekstrudiraju duz svojih vlastitih normala umjesto njihova
prosjeka.

Slika 42. Primjer za Extrude Individual

o Extrude to Cursor ekstrudira lica u smjeru pozicije
pokazivaa misa.

Slika 43. Primjer Extrude to Cursora
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1. Inset Faces omogucuje umetanje novih poligona unutar
postojecih lica 3D modela. Ovaj alat koristan je za detaljnije
modeliranje i dodavanje kompleksnih oblika na model. Drzanjem
lijeve tipke misa [RMB] i povladenjem zutog kruga miSem prema
sredini, prikazanog na lijevoj kocki, odreduje se veli€ina
umetnutog poligona, odnosno novonastalog lica. Moze se
umetnuti to¢na vrijednost za veliinu umetnutog lica kao $to je
prikazano dolje na slici na desnoj kocki. U lijevom kutu nize
pojavi se prozor Inset Faces s dodatnim opcijama. Promjenom
vrijednosti Thickness regulira se veli€ina dodatnog lica u sredini.
Inset faces aktivira se i pomocu tipke [l], nacelo je isto, samo se
odmah krene iz pozicije desne kocke na slici dolje (nema zutog
widgeta).

Slika 44. Primjer za Inset Faces

2. Bevel sluzi za dodavanje zaobljenja na bridove 3D modela. Ovaj
alat je koristan za izradu realisticnih i glatkijih geometrijskih
oblika, kao i za dodavanje detalja na modele. Povlatenjem Zute
poluge prema dolje na lijevoj kocki na slici nize stvara se
zaobljenje na bridu. Nakon dodavanja efekta alata Bevel moze
se dodati veéi broj segmenata (veéi broj rezova) umjesto jednog
kao $to je trenutno postavljeno, i to pomoéu postavke
Segements, locirane unutar prozora Bevel s dodatnim opcijama
koji se otvori lijevo nize u pregledniku. Sto je veéi broj
rezova/segmenata, to ¢e rub biti viSe zaobljen. Bevel se takoder
moze aktivirati pre€icom [Ctrl] + [B].

Slika 45. Primjer za Bevel
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Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

3. Loop Cut u Blenderu omogucuje dodavanje novih rezova petlje
(engl. loop cuts) na objekt. Ova funkcija korisna je za dodavanje
detalja i preciznih modifikacija modelu. Loop cut moze se
pokrenuti pomocu precice [Ctrl] + [R]. Prije nego sto je rez
prihvaéen, kao na lijevoj kocki dolje na slici, moguée je miSem
povlaciti rez i pozicionirati ga gdje korisniku odgovara. Nakon §to
je rez potvrden, lijevom tipkom misa [LMB] ili tipkom [Enter],
pojave se dodatne opcije za doradu unutar prozora Loop Cut
and Slide, lociranog nize u lijevom kutu izbornika. Jedna od
opcija, koja se i najvise koristi, je Number of Cuts, u koju
mozete upisati broj rezova koje ¢e Blender automatski generirati
umjesto korisnika, sa proporcionalnim razmacima izmedu njih.

Slika 46. Primjer za Loop Cut

Offset Edge Loop Cut sluzi vise kao dodatni korak u obradi
nakon alata Loop Cut. Offset Edge omogucuje dodavanje novih
rezova petlje na model, s dodatnom mogucnoSc¢u pomicanja tih
rezova duz postojecih rubova. Nakon $to su rezovi potvrdeni,
lijevom tipkom mi8a [LMB] ili tipkom [Enter], pojave se dodatne
opcije za doradu unutar prozora Offset Edge Slide, lociranog
nize u lijevom kutu izbornika, koji sluzi za definiranje razmaka
izmedu rezova upisom neke vrijednosti za Factor, Sto je
prikazano dolje na slici.

[mﬂ Offset Edge Loop Cut

Slika 47. Primjer za Offset Edge Loop Cut

4. Knife omogucuje precizno rezanje kroz 3D modele. Koristan je
za dodavanje novih bridova ili dijeljenje postojeéih povrSina na
modelu. Kako bi se krenulo rezati, treba pritisnuti na po&etnu
to¢ku reza na modelu te zatim povudi liniju reza preko povrsine
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na koju se planira praviti rez. Moze se pritisnuti na razliite to¢ke
kako bi se definirao put reza. Tipkom [Enter] potvrdi se rezanje
povrSine. PreCica za Knife na tipkovnici je [K].

Slika 48. Knife primjer

Medu osnovnim i vrlo korisnim alatima za obradu koji nisu prisutni unutar
Toolbara je Subdivide. Tipkom [W] otvara se prozor, §to je prikazano
nize na slici, s dodatnim specijalnim naredbama (Special pop-up menu)
te na samom vrhu se nalazi Subdivide, koji dijeli objekt na manje cjeline.
Jednostavan, ali jako koristan alat. Nakon $to je objekt podijeljen nize u
lijevom kutu izbornika pojavi se prozor s dodatnim opcijama vezanim za
alat Subdivide. Moguce je podesiti broj podjela ili Number of Cuts, kao
Sto je prikazano nize na slici na desnoj kocki.

Slika 49. Alat Subdivide

2.4. Osnove Material Propertiesa

Material Properties u Blenderu se odnose na svojstva materijala koji se
koriste u stvaranju i oblikovanju 3D modela unutar Blendera. Ova
svojstva omogucuju korisnicima da prilagode izgled i ponaSanje
materijala u njihovim 3D scenama. Odabirom objekta moze se dodati
materijal unutar prozora Editor svojstava (Properties), lociranog u
desnom donjem kutu glavne radne povrsine Blendera te pritiskom na
New (lijevi stupac, slika dolje, ozna¢eno crvenim). Materijal ima dosta
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postavki te vecina njih nisu relevantne u ovoj fazi, tako da ce se
spomenuti nekoliko bitnih stavki vezanih za postavke. Pod Viewport
Shading potrebno je postaviti na Material Preview kako bi
promjene na materijalima bile vidljive u sceni.

Use Nodes

Surface & Principlec

Slika 50. Postavke Material Properties

1.

Surface se odnosi na nacin na koji se svjetlost integrira s
povrS§inom materijala. Ovo svojstvo omogucuije korisnicima da
odaberu kako ¢e se materijal ponaSati u odnosu na svjetlosne
izvore i kako Ce se stvarati sjene na povrsini. Nacin na koji ¢e se
materijal ponasati u odnosu na svjetlosne izvore je program ili set
instrukcija koji se zove shader. Shaderi su esencijalni alati za
postizanje razli€itih vizualnih efekata u 3D scenama. Medu
glavnim shaderima koji se mogu odabrati je Principled BSDF,
univerzalni shader koji kombinira viSe svojstava materijala u
jednom sucelju, $to uklju€uje boju, efekt metala, grubost
povrsine, prozirnost i druge. Shader Diffuse BSDF simulira
difuzno rasprsivanje svjetlosti na povrsini materijala. To znaci da
se svjetlost koja pada na povrSinu materijala reflektira
ravnomjerno u svim smjerovima stvaraju¢i matirani izgled. To se
Cesto koristi za materijale poput tekstila, papira ili neobradenog
drva. Glossy BSDF simulira refleksiju svjetlosti na glatkoj
povrsini. Proizvodi jasne i definirane refleksije, Sto ga Cini
idealnim za sjajne ili reflektirajuée materijale poput metala ili laka.
Emission omogucuje materijalu da emitira svjetlost, ime se
postize efekt da objekt svijetli. To se koristi za stvaranje
svjetle¢ih materijala poput svjetala, ekrana ili drugih izvora
svjetlosti unutar scene.

Zanimljivosti i napomene

Bidirectional scattering
distribution function
(BSDF) je matematicki
model koji se koristi za
opisivanje nacina na koji se
svjetlost rasprsuje na
povrsini materijala. BSDF
definira raspodjelu svjetlosti
koja dolazi na povrSinu i
kako se ta svjetlost
reflektira ili rasprduje u
razli¢itim smjerovima.
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2. Base color: jedna od postavki vezanih za shader Principled
BDSF; odreduje primarnu boju povrSine materijala. Ova boja
predstavlja dominantu boju koja ¢e biti vidljiva na povrSini objekta
kada se scena renderira.

Slika 51. Base color postavka

Metallic: svojstvo materijala koje odreduje koliko materijal djeluje
kao metal. Ovo svojstvo kontrolira hoce li materijal reflektirati
svjetlost kao metal ili Ce se ponasSati kao nemetalni materijal. Na
slici nize moze se vidjeti razlika. Obje kugle su istog sivog tona,
no desna kugla ima vecu vrijednost pod Metallic.

Slika 52. Postavka Metallic

Roughness se odnosi na hrapavost materijala, svojstvo
materijala koje kontrolira glatkocu ili grubost povrsine materijala.
UtjeCe na to kako materijal reflektira svjetlost i koliko je povrSina
reflektiraju¢a. Kada je postavka Roughness postavljeno na nizu
vrijednost, povrSina materijala djeluje glade i reflektirat ¢e
svjetlost na ujednaceniji nacin, Sto rezultira sjajnim izgledom.
Kod visih vrijednosti povrsina ¢e biti grublja i svjetlost e biti
rasprSena na razliCite naCine stvarajuci matirani ili difuzni izgled.
Na slici nize prikazana je razlika izmedu lijeve kugle, s
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Roughness na 1 (maksimalna vrijednost) i desne kugle, s
Roughness na 0.

Slika 53. Postavka Roughness

Transmission je svojstvo materijala koje kontrolira koliko
svjetlosti prolazi kroz povrSinu materijala. Ovo svojstvo koristi se
za simuliranje transparentnih materijala kao $to su staklo, voda,
ili plastika. Na slici nize obje kugle imaju Roughness na 0 da bi
se lakSe uocio efekt, no desna je kugla, za razliku od lijeve,
postavljena na najviSu vrijednost na Transmission Weight
simulirajuci staklo.

1.000

Slika 54. Postavka Transmission
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2.5. Vjezba: Rad s 3D objektima

1.  Otvorite novu datoteku i odaberite General.

2. Ostanite u Object Modeu te unutar prozora Transform postavite da
se kocku translatira za 10 m po x-osi te ponovite isto za y-os.
Objekt zarotirajte za 45° oko osi z.

3. Prebacite se u Edit Mode i odaberite Face selection model
4. Koristeéi Loop Cut, napravite 4 okomitih reza na objekt.

5. U Edit Modeu bo€na lica, koja nisu bila zahvaé¢ena Loop Cutom,
ekstrudirajte za 2 m koristeci Extrude Along Normals. U gornjem
lijievom kutu Ce biti prikazan broj za koji se ekstrudira lice.

6. Nakon ekstruzije desno lice maodificirajte koristeéi Bevel Tool te
postavite Width na 0.8, lociran unutar prozora Bevel s dodatnim
opcijama, koji se otvori lijevo nize u pregledniku. Ponovite isti
proces za lijevo lice, ali sa Width od 0,4. Potvrditi unos tipkom
[Enter].

7. Prebacite se u Object Mode, oznacite objekt, odaberite Material
Properties te pod Surface > Base Color postavite boju po izboru.
Da bi se boja vidjela, pod Viewport Shading potrebno je postaviti na
Material Preview B I

8. Podesite Transmission, vrijednost Weight postavite 1.0 i
Roughness pod Surface postavite na 0 da objekt djeluje kao da je
staklen.

9. Spremite dokument (File > Save as) pod nazivom
Druga_vjezba.blend. Slika nize je prikaz zavrSenog zadatka.

Slika 55. Izgled zavrsene vjeZbe 2.5.
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3. Modifikatori i fizika u Blenderu

Po zavrsetku ovoga poglavija moci cete:
e koristiti osnovne modifikatore u Blenderu
e primijeniti modifikatore na objekte u 3D prostoru
e dodavati teksture na objekte

e Koristiti osnovne funkcije vremenske trake kod animacija.

Modifikatori (Modifiers) su automatske operacije koje utjeCu na
geometriju objekta na nacin koji nije destruktivan. Pomoc¢u modifikatora
moZete automatski izvesti mnoge efekte koji bi inaCe bili prezahtjevni za
ruéno izvodenje i bez utjecaja na osnovnu geometriju vaseg objekta. Oni
djeluju mijenjajuci nacin prikaza i renderiranja objekta, ali ne i geometriju
koja se ureduje. Geometrija u Blenderu predstavlja strukturu i oblik 3D
objekta.

3.1. Tipovi modifikatora

Postoji vise kategorija ili vrsta modifikatora te svaka kategorija ima svoju
listu modifkatora koji su na izboru korisniku, no zbog velikog broja fokus
¢e biti primarno na najvaznijim i najprakti¢nijim modifkatorima. Kako bi
se odabrao modifikator, potrebno je prvo selektirati objekt na kojeg se
zeli primijeniti modifikator te pod prozorom Propeties, odabrati Modifiers.

Slika 56. Modifier Properties

Unutar prozora, pritiskom na Add Modifier, otvara se meni s
kategorijama i njihovim modifikatorima:

Slika 57. Kategorije modifikatora
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1. Edit: sli¢ni modifikatorima Deform (nize pod broj 3), no obi¢no ne
utjeCu izravno na geometriju objekta, ve¢ na neke druge podatke,
poput grupa vrhova (vertex grupes).

2. Generate: konstruktivni/destruktivni modifikatori koji ¢e utjecati
na cijelu topologiju mreze. Mogu promijeniti opci izgled objekta ili
dodati novu geometriju.Topologija pokazuje na koji nacin su
komponente mreze spojene jedne s drugima. Topologija nije ista
stvar kao i oblik, mogucée je imati viSe modela istog oblika s
potpuno drugacijom topologijom.

3. Deform: za razliku od Generiranih modifikatora navedenih gore,
ovi modifikatori samo mijenjaju oblik objekta, bez mijenjanja
njegove topologije.

4. Physics: modifikatori koji simuliraju fiziCke ili proceduralne
efekte, primjerice simuliranje tkanine, interakciju izmedu
objekata, simuliranje tekucina itd.

5. Hair: kategorija koja dolazi iz pridruzene knjiznice resursa koja
se distribuira s Blenderom. Hair modifikatori su alati koji se
koriste za manipulaciju i stiliziranje dlaka (vlasi) na modelima u
Blenderu.

Tijekom te€aja, uz neke iznimke, primarno ¢e se Koristiti modifikatori
unutar kategorija Generate i Physics buduci da su glavni modifikatori
locirani unutar tih kategorija te su odli¢ni primjeri za upoznavanje na koji
nacin razli¢iti modifikatori utje€u jedni na druge.

3.1.1. Generate modifikatori

Kao $to je ve¢ iznad objasnjeno, Generate modifikatori su
konstruktivni/destruktivni te ¢e utjecati na cijelu topologiju mreze.

Generate » 00 Array

Deform 7] Bevel

Physics =] Boolean

Bg Build

] Decimate

|C] Edge Split

(® Mask

{3 Mirror

EHl Multiresolution
(fb Remesh

S) Screw

) Skin

P solidify

Ol Subdivision Surface

Hair

[] Triangulate

&3 Volume to Mesh
Weld

) wireframe

Slika 58. Vrste Generate modifikatora
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Moze se dodati nekoliko modifikatora na jedan objekt kako bi se stvorio
niz modifikatora (Modifer Stack) koji se mogu primijeniti (Apply) ako se
Zeli trajno aplicirati njegove promjene. Modifikatori se izraCunavaju
odozgo prema dolje u nizu ili stogu. U nizu modifikatora, redoslijed
primjene modifikatora ima utjecaj na rezultat. Stoga se modifikatori
mogu preuredivati pritiskom na oznaku za pomicanje (::::) u desnom
kutu i pomicanjem odabranog modifikatora gore ili dolje. Na slici nize
moze se vidjeti primjer niza modifikatora. Svaki modifikator ima svoju
oznaku za pomicanje te, kada se spusti strelica padajuceg izbornika, vidi
se opcija Apply na samom vrhu koja sluzi da se potvrdi primjena
modifikatora na odgovarajuci objekt.

>0l Array Yilm@ v X
> 21 Boolean M"m@ v x
Apply

[ Duplicate

Move to First

Slika 59. Potvrda promjena modifikatora
Neki od primjera Generate modifikatora:

Array: omogucuje stvaranje vise kopija odabranog objekta i postavljanje
tih kopija duz odredene osi. To omogucuje brzo stvaranje niza objekata,
$to je korisno za stvaranje repetitivnih uzoraka, linearnih nizova,
spiralnih oblika i sli¢no. Modifikator Array moze se koristiti na razlicite
nacine, uklju€ujuci stvaranje nizova stuba, lanaca, spiralnih stepenica i
mnogo drugih stvari. Ova fleksibilnost €ini modifikator Array izuzetno
korisnim alatom za modeliranje u Blenderu.

Slika 60. Array modifikator primjer

Osnovne postavke modifikatora:
¢ Count: omogucuje odabir broja kopija objekta u nizu.

¢ Relative Offset: Definira relativni pomak izmedu svake kopije u
odnosu na prethodnu kopiju omogucujuci sloZenije uzorke.

@ srce .
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Constant Offset: postavlja pomak odnosno ofset izmedu svake
kopije objekta u nizu duz odabrane osi. MozZe se koristiti za
postizanje redovitih ili nepravilnih razmaka izmedu kopija.

Object Offset: omogucuje koriStenje drugog objekta kao pomak
za svaku kopiju originalnog objekta u nizu. To znaci da se svaka
kopija originalnog objekta moze pozicionirati ili transformirati na
temelju polozaja drugog objekta. Na slici nize je primjer ofseta s
Empty objektom Plain Axes. Objekti pod kategorijom Empty su
objekti bez informacija o mrezi te se ne pojavljuju u finalnom
renderu scene, §to je idealno za koristenje u ovom slucaju.
Empty objekti dodaju se kao i svi drugi: pre€ac [Shift] + [A] te se
izabere pod Empty. Dobra je praksa koristiti prazan objekt koji je
centriran ili blizu po¢etnog objekta. Primjerice, rotiranjem tog
praznog objekta moze se stvoriti krug, spirala objekata ili
stepenice kao u slu€aju na slici.

Slika 61. Primjer postavke Object Offset

Merge: kontrolira hoce li se kopije objekta spojiti u jedan objekt ili
Ce ostati zasebni objekti. Kada je opcija Merge aktivirana,
Blender ¢e automatski spojiti zajedniCke tocke izmedu susjednih
kopija objekta ako su dovoljno blizu jedna drugoj. Opcija First
and last copies, ako je aktivirana, omogucuje spajanje prve i
zadnje kopije objekata u nizu. Na slici nize prikazana je razlika
izmedu niza bez First and Last Copies s lijeve strane te niza s
aktiviranom opcijom s desne strane.

Slika 62. Primjer za postavku Merge

40
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Bevel: zaobljuje rubove mreZe na koje je primijenjen te daje dodatnu
geometriju s odredenom kontrolom kako i gdje se zaobljenje primjenjuje
na mrezu. To je nedestruktivna alternativa postupku zaobljavanja
koriste¢i Bevel u Edit Modeu. U postavkama se moze definirati hoée i
modifikator utjecati samo na tocke ili samo na bridove.

Slika 63. Primjer za modifikator Bevel

Osnovne postavke modifikatora Bevel.

o Width Type: Definira kako ¢e se Sirina tumaciti da bi se odredila
koli¢ina zaobljivanja.

¢ Amount: koli¢ina zaobljivanja odredena u metrima.

o Segments: Definira broj segmenata koji ¢ine zaobljenje. Vise
segmenata rezultira gladim zaobljenjem.

Boolean: modifikator koji omogucuje spajanje, oduzimanije ili
presijecanje geometrije izmedu dvaju ili vise objekata. Kada se primijeni
na objekt, Boolean modifikator izvodi Booleove operacije na tom objektu
koristeéi drugi objekt kao alat za manipulaciju geometrije. Postoje tri
osnhovne operacije Booleana koje se mogu primijeniti: Union (unija),
Difference (razlika) i Intersect (presjek). Ova vrsta modifikatora korisna
je za modeliranje kompleksnih oblika ili izradu detaljnih rezova i otvora u
objektima. Kao Sto je ve¢ navedeno, Boolean Modifikator ima tri
osnovne operacije:

o Intersect: operacija presjeka, stvara novi objekt koji sadrzi samo
dijelove koji se preklapaju izmedu dvaju ili viSe objekata. Drugim
rijeCima, samo dijelovi geometrije koji se zajedno preklapaju bit
Ce zadrzani u rezultirajucem objektu, dok ¢Ce svi drugi dijelovi biti
uklonjeni. Kako bi bilo preglednije i lakSe se uocio efekt
operacije, drugi objekt koji se koristi kao alat za manipulaciju
geometrije bit ¢e prikazan u mreznom prikazu. Iznad ikone
Modifers, unutar prozora Properties treba oti¢i na Object
Properties te izabrati Viewport Display - Display As - Wire kao
§to je prikazano niZe na slici.
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~ Viewport Display

(—]
[}

Show Mame
L A nr
Axes
Wireframe
All Edges
Texture Space
» Shadow

In Front

Display As  Wire v

Bounds

Slika 64. Postavka Wire

Kao primjer uzet ¢e se kocka kao prvi objekt na koji ¢e se
dodati Boolean modifikator varijante Intersect te ¢e se
odabrati kugla kao drugi objekt za manipulaciju geometrije
prvog objekta. Pod Object u postavkama modifikatora
potrebno je odabrati drugi objekt kako bi modifikator imao
efekta. Na lijevoj slici nize vide se prvi i drugi objekt u
originalnom stanju, prije nego $to se primijeni modifikator.
Kada se primijeni modifikator, samo je presjek dvaju objekata
vidljiv, kao $to je prikazano na desnoj slici nize, sto je i
funkcija ove varijante modifikatora. Takoder, u crvenom
okviru vidi se razlika izmedu lijeve i desne slike: na desnoj
slici je ukljuc¢en Realtime, ikona ekrana, koji omogucuje
prikaz efekta odredenog modifikatora. Ako je iskljuen, kao
na lijevoj slici, efekt modificiranja nije vidljiv.

=

Intersect

Slika 65. Primjer za postavku Intersect
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¢ Union: operacija koja kombinira geometriju dvaju ili viSe objekata
tako da stvara jedinstveni objekt koji obuhvacéa sve dijelove svih
objekata koji su uklju€eni u operaciju. Rezultat je spojeni objekt
koji obuhvaéa sve geometrije originalnih objekata. Postupak je
isti kao i kod varijante Intersect, samo je drugi efekt. Primjer unije
kocke i kugle na slici nize:

fr Add Modifier

- &I Boolean TEE v x

Intersect Union Difference
Operand Type  Object
Object M, Sphere

Solver Fast Exact

> Solver Options

Slika 66. Primjer postavke Union

e Difference: stvara novi objekt koji se formira oduzimanjem
geometrije jednog objekta od geometrije drugog objekta. Drugim
rije€ima, geometrija jednog objekta ,izrezuje” se ili ,izvladi“ iz
geometrije drugog objekta. Rezultat je objekt koji sadrzi
geometriju prvog objekta s geometrijom drugog objekta
uklonjenom iz nje. Primjer na slici nize:

Add Modifier

v Bl Boolean =@ v x
Intersect Union Difference
Operand Type Object

Object M, Sphere

Solver Fast Exact

» Solver Options

Slika 67. Primjer za postavku Difference
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Mirror: modifikator koji omogucuje stvaranje zrcalnog objekata duz
njezinih lokalnih x-, y- i/ili z-osi preko objektnog podrijetla. Objektno
podrijetlo ili Object Origin je referentna tocka koja se koristi za
pozicioniranje, rotaciju i skaliranje objekta te za definiranje njegovih
koordinata u prostoru. Sve promjene koje se naprave na jednoj strani
automatski ¢e biti replicirane na drugoj strani, $to je korisno za stvaranje
simetri¢nih objekata. Osim toga, ovaj modifikator moze biti koristan i za
modeliranje asimetri¢nih objekata jer omogucuje raditi na samo jednoj
strani, a Blender ¢e automatski replicirati promjene na drugu stranu.

Kako bismo stvorili zrcalni objekt koristeéi objektno podrijetlo, potrebno
je pomaknuti originalni objekt putem Edit Modea kako bi referentna
toCka ostala u centru koordinatnog sustava. Da se objekt pomaknuo
putem Object Modea, referentna to€ka pratila bi objekt, $to u ovom
slu€aju nije cilj. Referenta to¢ka objekta moze se vidjeti na slici nize,
unutar crvenog okvira.

Slika 68. Prikaz referentne tocke

Takoder, umjesto da se koristi Object Origin, postoji opcija Mirror
Object koja omogucuje da drugi objekt postane ,referentna tocka“ za
zrcaljenje duz njezinih lokalnih osi. Na slici nize referentni objekt je
kugla.

Slika 69. Objekt kao referentna tocka
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Takoder, jako korisna opcija kada se Zeli spojiti objekt sa zrcalnom
verzijom objekta je opcija Clipping. Kada je uklju€ena, pri ekstruziji
objekta prema sredini objekt i zrcalna verzija tog objekta ne prelaze
jedan preko drugog, odnosno ne ignoriraju se medusobno pri kontaktu,
nego se spoje pri doticaju kao &to je prikazano nize na slici.

Slika 70. Postavka Clipping

Subdivision Surface: modifikator koji se koristi za izgladivanje i
dodavanje detalja modelima pomoéu podjele povrsine. Kada primijenite
Subdivision Surface modifier na objekt, Blender ¢e automatski podijeliti
povrsinu objekta na viSe manjih segmenata stvarajuci izgladeniji izgled.
Ovaj modifikator povecava gusto¢u mreze dodajuci vise geometrijskih
detalja, ali istovremeno €uva osnovni oblik objekta. Moze se kontrolirati
razina podjele kako bi se postigao Zeljeni stupanj glatkoce i detalja.
Modifikator Subdivision Surface Cesto je koriSten u modeliranju glatkih
povrsina poput ljudskih likova, vozila ili arhitektonskih elemenata kako bi
se postigla realisti¢nija i estetski privlacnija finalna verzija modela. Od
postavki za Subadvision Surface bitne su Levels Viewport i Render.
Levels Viewport ili Levels omogucuje da se odredi koliko se razina
podijeljenosti zeli primijeniti na objekt. Veci broj razina rezultira glatkijim
objektom, ali moze povecéati broj poligona i utjecati na performanse, dok
Render ili Render Levels kontrolira broj razina podijeljenosti koji ¢e biti
primijenjeni tijekom faze renderiranja scene. Korisno je ako se zele
koristiti viSe razine podijeljenosti tijekom renderiranja kako bi se dobila
visoka kvaliteta rendera, dok je u isto vrijeme moguce Koristiti manje
razine u preglednom nacinu rada kako bi se odrzale performanse.

Slika 71. Primjer za modifikator Subdivision

Wireframe: modifikator koji pretvara mrezu u zi¢ani okvir prikupljajuci
sve bridove i pretvarajuci te bridove u Cetverokutne poligone. Bitno je da
mreZa ima lica da bi se mogla prikazati kao Zi¢ani okvir. Debljinu,
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materijal i druge parametre generiranog ziCanog okvira moze se
definirati putem opcija modifikatora. Thickness odreduje dubinu ili
veliinu Zi¢anog okvira, ako se omoguci Replace Original, originalna
mreza zamjenjuje se generiranim ziCanim okvirom. Ako nije ukljuceno,
ZiCani okvir se generira preko originalne mreze. Offset postavka, koja
ima vrijednosti izmedu -1 i 1, odlu€uje da se generira Zi€ani okvir unutar
ili izvan originalne mreze. Kada je postavljeno na nulu, pomak ce
centrirati ZiCani okvir oko originalnih bridova. Na slici nize s lijeve strane
vidi se kocka s postavljenim modifikatorom Wireframe.

Slika 72. Primjer modifikatora Wireframe

3.1.2. Physics modifikatori

U Blenderu Physics modifikatori omogucuju simulaciju razlicitih fizi€kih
efekata na objektima unutar scene. No, za razliku od Generate Modifier
grupe modifikatora pri dodavanju Physics tipa modifikatora postavke se
nalaze se unutar posebnog prozora pod Physics Properties. Physics
modifikatori ¢e biti vidljivi unutar Modifier Properties, ali ¢e biti prikazan
tekst ,Settings are inside the Physics tab® kao §to je prikazano nize na
slici:

= + Add Modifier

W |~ 7 clotn =@ e

]

Settings are inside the Physics tab

Slika 73. Physics modifikator prikazan u Modifier Properties

Physics modifikatori zbog svoje kompleksnosti i broja postavki koje su
dostupne za svaki od modifikatora pozicionirani su pod poseban prozor
radi lakSe preglednosti. Vazno je samo imati na umu, da ¢e, kada se
dodaju Physics Properties, taj odabir biti vidljiv na listi Physics
modifikatora i obratno, osim par iznimki.
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3.2. Physics properties

Physics properties u Blenderu su svojstva koja se primjenjuju na objekte
kako bi se simulirali razli€iti fizi€ki efekti unutar scene. Ova svojstva
omogucuju objektima da reagiraju na razliCite sile poput gravitacije,
trenja, sudara i drugih interakcija unutar 3D prostora. Takoder
omogucuju detaljnu kontrolu nad simulacijom fizi¢kih efekata i stvaranje
realistiCnih animacija. Kako bi se najlake objasnili neki od fizickih
svojstva i gdje se koriste, kao primjer ¢e se uzeti kocka koja pada na
komad tkanine. Interakcija izmedu tih dvaju objekata zahtijeva
dodavanje nekoliko vrsta svojstava fizike na svaki od tih objekata.
Svojstva koja Ce se koristi su Collision, Cloth i Soft Body.

Force Field ®  Soft Body [
Collision @ 6O

Cloth = 5 Rigid Body
il 'ITF
(]

e Dynamic Paint

Fluid

Rigid Body Constraint

» Cloth ==

» Soft Body

Slika 74. Prikaz ukljucenih svojstva fizike

Cloth (Tkanina) omogucuje simulaciju tkanine na objektima. Simulacija
tkanine jedan je od najtezih aspekata racunalne grafike. Naizgled
jednostavan predmet koji se u stvarnom svijetu uzima olako zapravo ima
vrlo slozene unutarnje i okoliSne interakcije. Tkanina se obi¢no modelira
kao 2D mreza kako bi se simulirali predmeti poput zastava ili
transparenta, ali takoder se moZe Koristiti za modeliranje 3D predmeta
kao Sto su pliSane Zivotnije, jastuci, baloni ili lopte.

Force Field 4 Soft Body
Collision 3} Fluid
Cloth v | Rigid Body

Dynamic Paint 'E" Rigid Body Constraint

Slika 75. Simluacija tkanine

Collision (kolizija) omogucuje simulaciju sudara izmedu objekata unutar
scene. Kada je primijenjen na objektu, ovaj modifikator omogucuje tom
objektu da reagira na sudar s drugim objektima u sceni, poput odbijanja
ili prolaska kroz njih.
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Force Field 4 Soft Body
s Collision Fluid

™ Cloth Rigid Body

I~ Dynamic Paint W Rigid Body Constraint
Slika 76. Simulacija kolizije

Soft body (Meko tijelo) koristi se za simuliranje mekih objekata koji se
deformiraju. Primarno je osmisljen za dodavanje sekundarnih pokreta
animaciji, poput treSnje koja simulira ponasanja Zelea. Takoder se koristi
za simuliranje opcenitijih mekih objekata koji se savijaju, deformiraju i
reagiraju na sile poput gravitacije i vjetra, ili se sudaraju s drugim
objektima. Za tkanine i slicne objekte nije idealan izbor, unato¢ tome 3to
ih moze simulirati. U tim slu€ajevima koristi se ve¢ spomenuti
modifikator Cloth koji je osmisljen upravo za tu svrhu. Meka tijela mogu
medudjelovati s drugim objektima putem kolizija. Mogu medudjelovati i
sami sa sobom, gdje se tocke istog objekta medusobno udaraju,
pomocu postavke Self Collision.

Force Field (7 Soft Body
P Collision 2 Fluid

™ Cloth = Rigid Body

N
Ui

g}' Dynamic Paint Rigid Body Constraint

Slika 77. Simulacija mekih objekata

Rigid Body (Kruto tijelo) simulira kruto tijelo te se moze koristiti za
simuliranje kretanja ¢vrstih objekata. UtjeCe na polozaj i orijentaciju
objekata i ne deformira ih. Za razliku od drugih simulacija u Blenderu,
simulacija krutog tijela radi blize s animacijskim sustavom. To znaci da
se kruta tijela mogu koristiti kao obicni objekti i s animacijskim
ograni¢enjima. Primjerice, postoji opcija koja omoguéuje da se objekt
moze iskljucivo kretati koristenjem animacijskog sustava. O tome viSe
kasnije. Postoje dva tipa krutih tijela: aktivna i pasivna. Aktivna tijela se
dinamicki simuliraju, dok pasivna tijela ostaju statiCna. Tip krutih tijela
moze se postavljati u opcijama.

Force Field (7 Soft Body
P Collision 2 Fluid

™ Cloth = Rigid Body

I Dynamic Paint

Er Rigid Body Constraint

Slika 78. Simulacija krutih tijela

Vazna napomena vezana za mekana tijela i kruta tijela: u Blenderu
interakcija izmedu objekta s modifikatorom Soft Body i objekta s Rigid
Body nije moguca. Svi objekti u interakciji moraju imati Rigid Body
aktivan da bi simulacija funkcionirala ili, u slu€aju objekata sa Soft Body,
meka tijela samo djeluju medusobno ili s objektima koji imaju modifikator
Collision. Ukratko, interakcija izmedu objekta s modifikatorom Cloth i
padajuéeg objekta s modifikatorom Rigid Body pokazao se kao losiji
izbor u ovom sluéaju, ne pridonosi dobre rezultate. Cini se da Blenderov

physics engine, ,pokretac” koji je zaduzen za fiziku, nije idealan za
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ovakve radnje te ga ne podrzava. Iz ovog razloga u sljede¢em primjeru
koristiti ce se modifikatori Soft Body i Collision koji bolje reagiraju sa
simulacijom tkanine.

3.2.1. Simulacija tkanine i kolizije

Vec¢ navedene fizicke modifikatore najbolje ¢e se objasniti primjerom,
gdje Ce biti interakcija dvaju objekata. Ravna ploha koja ¢e se prilagoditi
tkanini te kocka koja Ce pasti na tu tkaninu. Za pocCetak, nova datoteka,
kocka je ve¢ automatski dodana tako da je samo potrebno dodati ravnu
plohu koja ¢e se koristiti kao platno. [Shift] + [A] 2> Mesh - Plane za
dodavanje ravne ploha u scenu, koju je zatim potrebno povecati pet
puta. Kada je ploha selektirana, tipkom [S] skalira se ploha te se pritisne
brojka po izboru, u ovom slucaju tipka [5]. Sada su svi objekti u sceni i
potrebno ih je podesiti po osi z. Za brze podeSavanje koristit ¢e se
kratice gdje god je prakti¢no. Zatim treba oznaditi kocku lijevom tipkom
miSa [RMB], te ju namjestiti na visinu od 10 jedinica, odnosno tipka [G],
odabere se z-0s tipkom [Z] te se upiSe broj deset. Unutar prozora
Transform (tipka [N]) vidi se da je pod Location vrijednost Z = 10. Isto
nacelo je za platno, samo ¢e se platno podesiti na Z = 5. Pozicija
objekata mora biti kao na slici nize.

Slika 79. Postavljanje kocke i plohe

Svi su objekti na pozicijama, a sada je potrebno izraditi tkaninu koristeci
plohu. Da bi ploha adekvatno mogla simulirati tkaninu, potrebno ju je
podijeliti na manje cjeline koristeéi alat Subdivide. Provijerite je li odabran
»alat Select Box te zatim selektirajte plohu lijevom tipkom misa [LMB],
odaberite rad u Edit Modeu (kratica za prebacivanje iz Object Modea u
Edit Mode je tipka [Tab]) te desnom tipkom miSa [RMB] odaberite
Subdivide. Nakon §to je Subdivide primijenjen, potrebno je podesiti broj
podjela ili Number of Cuts u postavkama u donjem lijevom kutu sucelja, i
to na 32 podijele.

Pravilo je Sto je vedi broj podjela ploha ¢ée bolje simulirati pona$anje
tkanine, no vedi broj podjela dolazi s ve¢im zahtjevima na racunalo $to
se tie brzine procesuiranja. Nakon $to je postavljen adekvatan broj
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podjela, potrebno je oznaditi jednu kutnu toCku kako bi nestala selekcija
s ostalih toCaka plohe. Zatim se drzi tipka [Shift] i selektiraju se ostale
kutne toCke kako bi bile grupno oznacene. Na slici niZze prikazane su
toCke koje se trebaju oznaditi, unutar crvenih okvira. Te tocke ée sluZiti
kao ,kuke® te ¢e drzati tkaninu u zraku. U protivnom bi kocka i tkanina
samo padale bez da dodu u kontakt.

Slika 80. Postavljanje kuka za platno

Da bi se podesile ,kuke®, potrebno je stvoriti Vertex Group odnosno
grupu to€aka. Grupe toCaka stvaraju se pod Data unutar prozora
Properties. Kada su Zeljene toCke oznacene, pritiskom na ikonu plusa
odnosno na Add Vertex Group pojavi se ,Group* koji je u ovom slucaju
preimenovan u ,Pins“, kao sto je prikazano na slici nize. Ako se Zeli
preimenovati grupa, potreban je dvostruki pritisak na ime pa ¢e se
omoguciti upis novog naziva.

Kada je grupa stvorena, treba se prihvatiti toc¢ke dodijeljene toj grupi
pritiskom na Assign. Odabirom Remove tocke koje su dodijeljene
odredenoj grupi se briSu te grupa postaje ,prazna“, dok Select i
Deselect sluZe za selektiranje odnosno uklanjanje selekcije toaka koje
su dodijeljene odredenoj grupi. Kada su toc¢ke selektirane, imaju
naranéastu boju.
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v Vertex Groups

153 Pins

Assign Remove Deselect

Weight 1.000

> Shape Keys

> UV Maps

> Color Attributes
> Attributes

> Normals

> Texture Space
? Remesh

> Geometry Data

» Custom Properties

Slika 81. Dodjeljivanje tocaka grupi

Ploha je spremna te je sljedecéi korak dodjeljivanje modifikatora. Prvo ¢e
se krenuti s modifikatorom Cloth. Dodavanje ide putem Physics
properties te pritiskom na Cloth. Unutar kartice Cloth pojavljuju se tri
nove ikone. Na lijevoj strani pojavljuje se krizi¢, koji sluzi za micanje
modifikatora s aktivnog objekta te sa desne strane ikone ekrana i
kamere. lkona ekrana pod nazivom Realtime omogucuje da korisnik
ukljudi ili iskljuci efekt modifikator u sceni, u ovom slu€aju ploha ¢e ostati
ravna i nece se deformirati kao tkanina. Ikona kamere odnosno Render
sluzi za ukljuc€ivanije i isklju€ivanje modifikatora tijekom renderiranja
scene. Drugim rije€ima, tijekom renderiranja ploha se neée ponasati kao
tkanina.

Force Field Soft Body
Collision Fluid

Cloth Rigid Body

Dynamic Paint ] Rigid Body Constraint

Slika 82. Ukljuceni modifikator Cloth

Modifikator Cloth, kao i svi ostali modifikatori unutar Physics properties,
ima dosta postavki koje su dostupne za podeSavanje. Za ovaj zadatak u
primjeru potrebne su dvije. Prva postavka vezana je za ve¢ spomenute
.kuke® i kako ih namjestiti. Pod Cloth-> Shape—> Pin Group potrebno je
izabrati grupu to¢aka ,Pins®, koja je namijenjena da drzi tkaninu. Pin
Group sluzi za odabir grupe toCaka koje ¢e poput igli drzati objekt i na taj
nacin kontrolirati oblik. Ostale postavke unutar Shape ostavljaju se
kakve jesu. Postavka je prikazana na slici nize.
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Shrinking Factor 0.000

Dynamic Mesh

Slika 83. Odabir grupe tocaka

Sljedeca postavka nalazi se pod Cloth-> Collisions—> Self Collisions.
Ovu postavku potrebno je ukljuciti da tkanina ne krene probijati samu
sebe tijekom animacije, nego da se prepozna kao zaseban objekt koji ne
moze prolaziti kroz samog sebe, kao i pravi komad tkanine. Na slici nize
prikazan je test gdje tkanine padaju na kocke, s lijeve strane je tkanina s
isklju¢enim Self Collisons, a s desne s ukljuéenom postavkom. Na prvi
pogled ne vidi se neka znacajna razlika, ali ako se bolje pogleda na
lijevoj kocki, dio platna prolazi kroz samog sebe, kao $to je bilo za
ocekivati, jer je opcija isklju¢ena. Proboj se moze vidjeti unutar crvenog
okvira.

Slika 84. Primjer sa i bez ukljucene postavke Self Collisions

Sada je potrebno aktivirati modifikator Collision koji omogucuje
interakciju izmedu objekata, odnosno da dode do kolizije. U protivhom bi
kocka prosla kroz platno. Collision se moze iskljuciti ikonom oka s desne
strane kartice. Na slici nize oznac¢eno crvenim okvirom vidi se ikona
kada je Collision isklju¢en. Korisno za testiranje pri usporedivanju efekta
sa i bez uklju¢enog modifikatora.

Soft Body 5
Force Field
Fluid
S = O Collision
Dynamic Paint T Rigid Body C a

Cloth

Dynamic Paint

Slika 85. Iskljucivanje modifikatora Collision
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Od postavki za modifikator Collison pod Softbody & Cloth > Damping
potrebno je podesiti na 0.750. Damping ili priguSivanje je vrijednost koja
se moze namjestiti izmedu 0 i 1. Kada je namjeSteno na vrijednosti 0, to
predstavlja maksimalno odskakanje od objekta koji dode u kontakt s
platnom, dok vrijednost od 1 kompletno prigusi taj efekt i nema
odskakivanja pri kontaktu. Sto je veca vrijednost, to je manje
odskakivanje. Pokazalo se da vrijednost 0.75 donosi najbolji efekt,
najvjernije simulira kako bi to u realnosti izgledalo. Nize na slici je
prikazana postavka Damping.

? Cloth
™ Collision
Field Absorption

? Particle

v Softbody & Cloth

Damping

Thickness Outer
Inner
Friction

+ Single Sided

Override Normals

Slika 86. Postavljanje vrijednosti Damping

Posto su sve postavke za plohu namjestene, vrijeme je da se provijeri
funkcioniraju li modifikatori. Kako biste to provijerili, potrebno je koristiti
vremensku traku (Timeline) te pokrenuti animaciju. Za sada spomenut
¢e se samo osnove koristenja trake za svrhu pokretanja animacije,
kasnije ¢e se objasniti u viSe detalja. Na slici nize prikazan je Timeline,
na samom dnu Blenderova sucelja, gdje su unutar crvenog okvira
Transport Controls, naredbe za kontrolu toka animacije. Da bi se
pokrenula animacija, potrebno je pritisnuti Play Animation oznacen
brojem 3, a za pokretanje animacije unatrag ikonu oznac¢enu brojem 2.
Ikone oznacene brojkama 1 i 4 sluze za prebacivanje animacije na prvi
ili zadnji kadar. Prije pokretanja animacije potrebno je izaéi iz Edit
Modea i uéi u Object Mode. Animacija zavr§ava kada plava linija na
pocCetku trake dode na desnu stranu te pokazuje brojku 250, brojku koja
predstavlja standardnu postavku za duljinu vremenske trake, odnosno
250 kadrova ili Frames.

. Heid prénl & tart End 250

1« #4 4 P »ré »l

Slika 87. Dijelovi vremenske trake o 9 9 9

Kada pokrenemo animaciju i pustimo da se odigra do kraja, platno ¢e se
opustiti i ostat Ce visjeti na ,kukama®“. Prije nego 5to se krene s

Ako se bolje pogleda na platno, mogu se primijetiti kvadrati¢i na povrsini.
Njih se moze ukloniti, odnosno povrsina se moZe izgladiti tako da viSe
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nisu vidljivi. To je moguce primjenom alata Shade Smooth, kojim se
geometrija objekta ustvari ne mijenja, nego se mijenja nacin na koji
Blender kalkulira raspodjelu sjena po povrsini objekta dajuéi iluziju glatke
povrsine. Dok je platno selektirano, tipkom [RMB] otvara se prozor s
opcijama gdje se na vrhu nalazi Shade Smooth.

Slika 88. Ploha oponasa tkaninu

Prvi dio simulacije je spreman, ploha se pona$a poput tkanine kako je
odredeno, a sada je potrebno podesiti postavke za kocku koja bi trebala
pasti na povrsinu tkanine. Kocka, kao i tkanina, mora imati prisutan
modifikator Collision s istim postavkama, znac¢i Damping na 0.75.
Preostaje joS dodati modifikator Soft Body i podesiti njegove postavke.
Kao prvi korak potrebno je iskljuciti postavku Goal jer kada je Goal
ukljuen, objekt ostaje u zraku i ne reagira na fizicke modifikatore. Kocka
s trenutnim postavkama moze pasti na platno, no pri kontaktu primjetno
je da se ne pona$a kao stabilno tijelo jer Soft Body simulira promjenjive
objekte koji ima kretnje poput Zelea te se na kraju urusi, no to se moze
prilagoditi da simulira kruto tijelo.

Pod kategorijom Edges nalazi se postavka Pull koja odreduje koliko je
rubovima objekta dozvoljeno da se rastegnu. Niska vrijednost €ini objekt
vide elasti€énim, dok visoka vise krutim. Push odreduje koliko ¢e se Soft
Body odupirati skruéivanju. Niska vrijednost vu€e na ponasanje tkanine,
a visoka na kruto tijelo. Pull i Push se oba postavljaju na vrijednost 0.99.
Nakon pokretanja animacije na prvi pogled se €ini da sve radi kako je
predvideno, no nakon par sekundi kocka se urusi na povrsini tkanine,
$to znadi da je potrebno prilagoditi postavku Bedning . Sto je veéa
Bending vrijednost, to se objekt teZe spljosti, odnosno urusi, te je
potrebno staviti na vrijednost 1. Nakon odredivanja postavke Bending
treba skrenuti paznju na jedan detalj. Na slici nize Pull i Push su
namjesteni na 0.990, Sto je jako blizu maksimalnoj vrijednosti koja je
0.999. Razlog zasto je postavljeno na nesto niZu vrijednost je zbog
probijanja kocke kroz tkaninu pri maksimalnoj vrijednosti. Na samom
kraju animacije vidljivo je da dolazi do proreza na tkanini. Ovo je jedan
od primjera gdje je potrebno eksperimentirati vrijednostima kako bi se
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doslo do zadovoljavajuceg rezultata. Finalne postavke za Soft Body
trebaju biti kao na slici nize.

* Soft Body

Collision Collection
> Object
> Simulation
» Cache
7 & Goal
v o Edges
Springs
Pull

Push

Damp
Plasticity
Bending

Length

Collision Edge
Face
> Aerodynamics
Stiffness
Self Collision
2 Solver
? Field Weights

2> Collision

Slika 89. Postavke Soft Body

Physics properties su spremni te je sada potrebno ponovno pokrenuti
animaciju te provjeriti radi li kako je predvideno. Rezultat bi trebao biti
kao na slici nize.

Slika 90. Kocka pada na tkaninu

Kao zadniji korak mozZe se dodati malo detalja na te objekte. Za kocku
dodat ¢e se nesto osnovno poput drugacije boje. Da bi se boja
promijenila na selektiranoj kocki, treba se prebaciti na prozor Material
Properties te izabrati boju po Zelji na Base Color. Za ovaj primjer
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postavljeno je na tamnosivu podeSavajuci vrijednost Value na 0.033 kao
na slici nize.

> Preview

v Surface

Use Nodes

Surface e Principled BSDF

Base Color e
Metallic
Roughness

IOR
Saturation

Alpha Value

Normal Default Alpha

Slika 91. Postavljanje vrijednosti Value

Za tkaninu koristit ¢e se tekstura, a kako bi se to omogucilo, treba se
odabrati Image Texture, koji ¢e zamijeniti boju pod Base color u Material
Properties. Pritiskom na zutu toCku pored Base Color otvara se novi
prozor, a unutar novog prozora pod Texture treba odabrati Image
Texture.

Ambient Occlusion

r Attribute /i Combine Colo
Object Info Combine
RGB

Volume Info
Wavelength

v Surface

Use Nodes
White Noise Texture

Surface e Principled BSDF

Slika 92. Odabir teksture umjesto boje za platno

Ispod Base Color pojavit ¢e se nove opcije vezane za Image Texture, za
ovaj primjer nece se dirati te opcije i ostavit ce se preddefinirane
postavke i vrijednosti. Jedino $to je potrebno jest dodati teksturu
odnosno sliku s uzorcima koja se nalazi u materijalima. Pritiskom na
Open, vidljivo nize na slici, odabere se slika Fabric_texture_2K.jpg
(slika se nalazi u mapi Vjezbe).
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Use Nodes

Surface @ Principled BSDF

Base Color @ Image Texture

Wl + New ] Open

Linear
Open image.
Flat .
Repeat
Vector Default

Metallic

Roughness

Slika 93. Otvranje slike za teksturu

Trenutno promjene nisu vidljive jer je potrebno promijeniti postavke
unutar Viewport Shading, koji se nalazi u gornjem desnom kutu 3D
sucelja. Trenutno je postavljeno na Display in Solid Mode, osnovni
nacin prikaza namijenjen za modeliranje, a potrebno je postaviti na
Material Preview kako bi postavljeni materijali odnosno teksture i boje
bili vidljivi. Odabirom trece ikone sucelje je postavljeno na Material
Preview, kao §to je vidljivo nize na slici.

Slika 94. Material Preview je ukljucen

Nize je prikazan finalni produkt nakon dodavanja boje i teksture.

Slika 95. Izgled zavrsenog primjera
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3.3. Vjezba: Kocka pada na tkaninu

Nakon odradenog primjera s tkaninom iz prijasnjeg poglavlja potrebno je
ponoviti simulaciju:

1.

Ploha i kocka trebaju biti na istim pozicijama, u Object Modeu
kocku se treba podignuti na Z = 10 a plohu na Z = 5.

Ploha se poveéava za 5 puta. Scale se postavlja na 5.

Selektirajte plohu te se tipkom [Shift], prebacite u Edit Mode, a
zatim desnom tipkom miSa [RMB] izaberite naredbu Subdivide.
NiZe lijevo unutar prozora Subdived pod Number of Cuts upiSite
32. Drzec¢i [Shift], selektirajte tocke na kutovima plohe te pod
Data Properties 7] dodaijte Vertex Group pritiskom na plus, a
zatim, kada se pojavi grupa, pritisnite Assign. Grupu preimenujte
u ,lgle“duplim pritiskom na naziv.

Vratite se u Object Mode te pod Physics Properties ﬂ ukljucite
modifikatore Cloth i Collision. Pod Cloth > Shape ->Pin Group,
postavite grupu to¢aka nazvanu ,lgle“. Zatim pod Cloth >
Collisions - Self Collisions stavite kvacicu da se ukljuci opcija.
Na modifikatoru Collision pod Softbody & Cloth > Damping
postavite na vrijednost 0.75. Zadnji korak je [RMB] za plohu,
odabrati Shade Smooth za uredniji izgled.

Selektirajte kocku te pod Physics Properties ﬂ ukljucite
modifikatore Soft Body i Collision. Pod Soft Body-> Edges »>
Pull i Push postaviti na 0.99 i Bending na 1.0. Iskljucite opciju
Goal, uklonite kvacicu. Za Collision modifikator, iste postavke
kao za plohu.

Zatim, dok je kocka selektirana u Object Modeu, dodati boju,
Material Properties - Surface > Base Color i podesiti
vrijednosti: Hue (0.140), Saturation (0.860), Value (0.8).

Selektirati plohu te dodati teksturu Material Properties > Surface
- Base Color > B> Image Texture > Open image >
fabric_pattern_2_ 2k.png . Za lakSe pronalazenje teksture treba
spremiti sliku na radnu povrsinu.

Postavite na Material Preview[Ef_J2J@ te pokrenite animaciju na
Play Animation. Pustite da se animacija odigra do kraja (kadar
250) te bi scena trebala izgledati kao na slici nize:

Slika 96. Izgled zavrsene vjeZbe 3.3.

58



Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

4. Animiranje pomocu trake Timeline

Po zavrsetku ovoga poglavija moci Cete:

4.1.

koristiti traku Timeline
postavijati kljuéne to¢ke na traci Timeline
kontrolirati i pozicionirati kameru

izraditi animacije koristeci kljucne tocke.

Traka Timeline

Traka Timeline je editor koji se moze identificirati s ikonom sata te sluzi
za manipuliranje Keyframesom i pomicanje Playheada. Korisniku daje
Sirok pregled animacije scene prikazujuéi trenutni kadar, kljuéne kadrove
odnosno keyframes aktivhog objekta, po€etne i zavrSne kadrove
animacijske sekvence, kao i oznake postavljene od strane korisnika.
Timeline se sastoji od sljedecih komponenti:

1.

Playhead je plava vertikalna linija koja oznaCava na kojem je
kadru trenutno stala animacija, broj kadra je prikazan na vrhu
linije. Playhead se moze postaviti ili premjestiti na novu poziciju
pritiskom ili drzanjem [LMB] u podrudju brisanja na vrhu
vremenske crte. Playhead se moze premjestati u koracima od
jednog kadra pritiskom [Strelica lijevo] ili [Strelica Desno], ili
mozete skociti na pocetak ili kraj kadra pritiskom [Shift]+[Strelica
lijevo] ili [Shift] + [Strelica Desno].

Kljuéni kadar (engl. Keyframes) za aktivne i odabrane objekte,
keyframes se prikazuju u obliku dijamanta. Moze se pritisnuti
desnom tipkom misa [RMB] da bi se odabrao jedan po jedan, a
moze se odabrati i vise odjednom drzedi [Shift] ili povlacenjem
okvira oko klju¢nih kadrova koristeéi tipku [B]. Moguce je
premjestati pojedinacne klju¢ne kadrove ili viSe njih koristeéi
[RMB] ili pritiskom na tipku [G] i povlaéenjem miSa u zeljenom
smjeru.

Naredbe za kontrolu (engl. Transport Controls) tijeka animacije,
namijenjene za kontrolu nad plavom vertikalnom linijjom. Jump
to Start (I « ), kratica [Shift] + [Strelica Lijevo] vrac¢a plavu liniju
na pocetak raspona kadrova odnosno Frame Rangea. Jump to
Previous Keyframe (# < ) [Shift] + [Strelica Dolje] vraca plavu
liniju na na prijadnji keyframe. Rewind ([«]) [Shift] + [Ctrl] +
[Spacebar], vrac¢a animacijsku sekvencu unazad. Kada se
pritisne tipka za pokretanje, postaje tipka za pauzu ([11]). Play
([»]) [Spacebar], pokreée animacijsku sekvencu, isto kao kod
Rewind, kada se pokrene postaje tipka za pauzu. Jump to Next
Keyframe ( » @) [Shift] + [Strelica Gore] postavlja plavu liniju na
sljedeéi keyframe. Jump to End ( » I) [Shift] + [Strelica Desno]
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postavlja plavu liniju na sam kraj raspona kadrova. Pause ([11])

[Spacebar ] zaustavlja animaciju. Auto Keying ([®])dodaje i/ili
zamijeni postojece kljuéne kadrove za aktivni objekt kada ga se
transformira u 3D prikazu. Primjerice, kada je omogucen, prvo se
postavi plava linija na zeljeni kadar, a zatim se pomakne objekt u
3D prostoru ili se postave nove vrijednosti unutar prozora
Transform kako bi Auto Keying uspjeSno spremio promijene.

4. Frame Range je zadani raspon kadrova koji po€inje s kadrom 1 i
zavrSava s kadrom 250. Moze se promijeniti raspon okvira u
gornjem desnom kutu zaglavlja vremenske trake ili unutar
Output Properties prikazanih na slici nize.

*~ Frame Range

L=
N

Frame Start
End
Step

Slika 97. Zadani raspon kadrova

5. Frame control sluzi za promjenu raspona okvira odnosno Frame
range. Vrijednost Start predstavlja poc¢etak raspona, dok End
zadnji kadar raspona. Current Frame je trenutna lokacija
Playheada: kako se pomi€e plava linija tako se mijenja vrijednost
trenutnog kadra.

-~ Playback v Keying ~ View Marker Hedsq Prol ] End 250

Slika 98. Naredbe za kontrolu vremenske trake 9 6 6

4.1.1. Koristenje keyframeova

Keyframe ili klju¢ni kadar je oznaka vremena koja pohranjuje vrijednosti
odredenog objekta. Primjerice, klju¢ni kadar moze definirati da je
horizontalni polozaj kocke na 5 m u prvom kadru. Svrha kljuénog kadra
je omoguciti interpoliranu animaciju, $to znadi da korisnik moze dodati
drugi keyframe u kadru 10 navodeci horizontalni polozaj kocke na 20 m,
a Blender ¢e automatski odrediti ispravan polozaj kocke za sve kadrove
izmedu kadrova 1 10.

Dodavanije klju¢énih kadrova je jednostavno i ima nekoliko metoda:

o U 3D prostoru Blendera pritiskom tipke [I] postavljaju se klju¢ni
kadrovi na predefinirane vrijednosti kao sto su Location, Rotation
i Scale. Pritiskom i drzanjem tipke [I] otvorit ée se izbornik u
kojem se moze odrediti Sto se zeli dodati kljuénom kadru. Nize
na slici prikazane su opcije. Pie Menu, koji je prikazan nize, prvo
se mora ukljuciti u postavkama. Pod Edit-> Preferences—>
Keymap—> Preferences—> 3D View—> Pie Menu on Drag treba
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postaviti kvacicu. Location, Rotation, Scale odnose se na
lokaciju, rotaciju i skalu, dok Available zahvaéa automatski sve
te vrijednosti, ali prethodno mora postojati barem jedan Keyframe
na Timelineu da bi ta opcija imala efekta. Pri dodavanju prve
kljuéne to¢ke mis treba biti pozicioniran unutar 3D preglednika
(3D Viewport), a svi naknadni keyframeovi mogu se dodavati i
kada je mi$ pozicioniran iznad trake Timeline.

Rotation

BT

Location A ‘// \'\ Scale
>

Alternate access to 'Insert Keyframe' for keymaps to use.

|

k Available

Slika 99. Ukljucen Pie Menu on Drag

Prelaskom misa preko svojstva i pritiskom na tipku [I] ili desnim
pritiskom miSa [RMB] na svojstvo po izboru u Context Menu
(kontekstnom izborniku) odabere se Insert Single Keyframe.
Blender koristi razne tipove izbornika za pristup opcijama i
alatima. Sadrzaj kontekstnog izbornika ovisi o polozaju
pokaziva¢a misa. Primjerice, kada je mi$§ na objektu unutar 3D
prostora, statusna traka na dnu pokazuje drugacije opcije vezane
za tipke misa, uklju€ujuéi i desnu tipku misa koja trenutno sluzi
kao Select.

Slika 100. Statusna traka dok je mis na objektu

Dok kod slike nize sluzi za otvaranje kontekstnog izbornika
buducdi da je mi§ pozicioniran na prozoru Properties.

Slika 101. Statusna traka dok je mis na prozoru Properties

NizZe je prikazan jedan od kontekstnih izbornika gdje se dodaje
keyframe odabirom Insert Single Keyframe.
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Transform

Slika 102. Kontekstni izbornik za dodavanje keyframeova

e Unutar prozora Properties takoder se mogu dodati keyframes za
mijenjanje vrijednosti. S desne strane svake vrijednosti nalazi se
to¢ka na kojoj se prikaze tekst Animate Property kada se iznad
drzi mi$. Pritiskom na toCku promijeni se u ikonu dijamanta, a ta
ikona ima dva stanja, ispunjeno i prazno. Ispunjena ikona &
znaci da je omoguceno spremanje keyframea te da je odredena
vrijednost zabiljezena i spremljena na trenutni kadar, dok prazna
obavjestava da je omoguceno spremanje, ali da na trenutnom
kadru nista joS$ nije spremljeno. Dodavanje keyframeova putem
Properties prozora bit ¢e potrebno za mijenjanje vrijednosti kao
Sto su boja materijala i drugih postavki vezanih za materijale
poput transparentnosti i hrapavosti. Takoder, moguce je dodavati
keyframes na modifikatore. Na slici nize prikazani su Object
Propetrties s lijeve strane, gdje se mogu dodavati keyframes za
vrijednosti Transform, dok su s desne strane Material Properties
za vrijednosti vezane za materijal odnosno povrsinu objekta.

LY M Primjer_Kocka 4y W Primer, > & Material
~ Primjer. 8 (@) Materal
[
¥ Transform
'Y
Location X om
% o

z g Animate property.

Rotation X

XYZ Euler
1.000
1.000 ] . c 0.000
1.000 b e ou 0.500
(] 1.450

Alpha e 1.000

Normal Default

* Subsurface

Slika 103. Dodavanje keyframeova unutar prozora Properties

¢ Ukljucivanjem opcije Auto Keying dodaju se i/ili zamjenjuju
postojeci keyframes za aktivni objekt kada ga se transformira u
3D prikazu. Primjerice, kada je omoguceno, prvo se postavi
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plava linija na zeljeni kadar, a zatim se pomakne objekt u 3D
prostoru ili se objekt pomice mijenjanjem vrijednosti unutar
prozora Transform. Vazno je napomenuti da automatsko
postavljanje klju¢nih kadrova nec¢e poceti dok barem jedan kljucni
kadar nije dodan, koji je potrebno ruéno dodati. Program
provjerava prijasnje kljuéne kadrove i, ako postoji promjena,
vrijednosti, postavit ¢e novi klju€ni kadar. Ako nema promjene
vrijednosti, automatsko postavljanje klju¢nih kadrova nece raditi.

Kod postavljanja klju¢nih kadrova u vrijednostima koje se mijenjaju moze
se primijetiti promjena pozadinske boje iz sive u zelenu, naran¢astu ili
zutu. Promjena pozadinske boje ukazuje na razliita stanja, Sto se
odnosi na kljuéne kadrove na odredenoj lokaciji vremenske trake. Siva
boja upucuje da nema kljuénog kadra za taj odredeni objekt, zuta
pokazuje da je postavljen klju¢ni kadar u trenutnom kadru, zelena znaci
da nema klju¢nog kadra u trenutnom kadru te narancasta pokazuje da je
vrijednost promijenjena, ali da klju¢ni kadar jo$ nije postavljen. Nize na
slici su prikazani primjeri svih stanja sa svojim odgovaraju¢im bojama.

Slika 104. Prikaz razlicitih stanja kljucnih kadrova

Za lak$e snalazenje i organizaciju, kada je veci broj klju¢nih to¢aka na
vremenskoj traci, moze se odabrati drugaciji izgled ikone za lakse
diferenciranje izmedu klju¢nih to¢aka i tipova podataka $to ih spremaiju.
Primjerice, ako su na odredenoj klju¢noj to¢ci spremljeni samo Location
podaci, a na susjednoj toci samo Rotation podaci, moze se za svaku
vrstu podataka postaviti i posebna ikona.

Nize na slici prikazani su Key Frame Types odnosno razliciti izgledi
kljuénih to€aka koji su na izboru. Key Frame Types imaju imena po
naprednijim efektima u animaciji buduéi da je je njihova originalna
namjena za kompleksnije animiranje. No to ne znaci da se ikone ne
mogu koristiti za druge svrhe. Kako bi se koristio odredeni Keyframe
Type, prvo se odabere jedan od ponudenih na drop down listi te se prati
postupak ve¢ navedenih nacina za dodavanje klju¢nih kadrova. Kada se
sljededi put doda klju¢ni kadar, bit ¢e drugacije boje i veli€ine.

@ srce 2



Osnove rada u 3D grafiCkom alatu Blender (oznaka tecaja)
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Slika 105. Tipovi klju¢nih kadrova

4.2. Animiranje objekata

Kroz primjer Ce se objasniti cijeli postupak animiranja objekta dodavajuci
kljuCne kadrove te prijelaz iz jednog kljuénog kadra u drugi, mijenjajuci
lokaciju, rotaciju, skalu i boju objekta, boju pozadine 3D sucelja i
podeSavanje modifikatora. Kako bi se lakSe pratio postupak, promjene
vezane za kljuéne kadrove ¢e se raditi putem prozora Propetrties.

Prije nego 5to se po¢nu postavljati kljuéni kadrovi, potrebno je odrediti u
kojem prostoru ¢e se odvijati animacija. U ovom primjeru nece se
renderirati scena, ali je dobro se drzati okvira kamere kao orijentira kako
bismo sigurno obuhvatili sve pokrete objekta koji se animira. Kamera se
moze podesiti na samom kraju, nakon Sto su svi kljucni kadrovi
postavljeni za animaciju, a vazno je da su svi pokreti vidljivi unutar okvira
kamere. Za primjer ovog zadatka postavljanje kamere ¢e biti prvi korak.

4.2.1. Camera view

Uz kocku i rasvjetu, Camera je jedan od osnovnih objekata koji dolaze
sa scenom pri otvaranju nove datoteke. Kamera je bitna pri renderiranju
scene, daje pogled u dio scene koji ¢e se renderirati. Bilo radi stvaranja
slike ili snimke. Kamera u sceni izgleda kao $to je prikazano nize na
lijevoj strani slike, dok je s desne strane slike prikazana na listi objekata
(Outliner). Ikona oka s desne strane sluzi za skrivanje kamere u sceni,
dok ikona fotoaparata sluzi za skrivanje kamere da ne bude vidljiva
tijekom faze renderiranja, primjerice kada ima vise kamera unutar scene.
Kada je viSe kamera unutar scene, to automatski znaci da ima i vise
Camera Perspectives odnosno viSe perspektiva gledanja. Perspektive
se mogu mijenjati pomocu ikone zelene kamere. Kada se pritisne na
ikonu zelene kamere, pregled scene prebacuje se na tu odredenu
kameru.

Slika 106. Izgled kamere
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Prebacivanje u pregled kroz aktivhu kameru, View-> Cameras—> Active
Cameras, kratica [NumPad 0]. Pomicanje kamere, kao i drugih objekata
u sceni, moguce je preko prozora Transform ili jednostavnijim nacelom,
pomocu tipke [G] i pomicanjem miSa namjesta se perspektiva kamere.
DrZzanjem srednje tipke miSa ili koluta [MMB] te pomicanjem miSa
naprijed i nazad zumira se i odzumira, odnosno kontrolira se koliko ¢e
kamera biti udaljena od objekta koji je trenutno u fokusu. Nize na slici je
prikazana poc&etna pozicija kocke koja ¢e se koristiti u ovom primjeru.
MozZe se primijetiti narancasti okvir, koji predstavlja perspektivu kamere i
sve $to je vidljivo u sceni kroz tu kameru. Kamera je dovoljno udaljena
od objekta, tako da ima adekvatnog prostora da su sve kretnje i

transformacije kocke vidljive unutar naranastog okvira. Transform
vrijednosti kamere su sljedece: Location (X=0m, Y =-40m, Z=28 m) i Zanimljivosti i napomene

Rotation (X=62°, Y=0°, Z=0°).

Tipke numericke tipkovnice
(Numpad) &esto se koriste
u Blenderu i nemaju istu
funkciju kao obi¢ne
broj¢ane tipke. Ako imate
tipkovnicu bez numeri¢ke
tipkovnice, Blender moze
standardne broj€ane tipke
tretira kao Numpad tipke
tako da se ukljuci opcija
Emulate Numpad. Edit=>
Preferences—> Input >

Keyboard—> Emulate
Numpad.

Slika 107. Pozicioniranje kamere

Kako bi se krenulo sa slaganjem animacije, prvo se treba postaviti prvi
kljuéni kadar, koji sadrzi referentne vrijednosti. U tom kljuénom kadru,
koji se nalazi na kadru 1, nema promjena, spremaju se vrijednosti
vezane za pocetnu lokaciju kocke koje su identi¢ne vrijednostima kada
se otvori novi projekt. Treba selektirati kocku te tipkom [I] dodati prvi
klju€ni kadar koji ¢e sluziti kao referentna tocka za daljnje klju¢ne
kadrove. Na vremenskoj traci pojavila se Zuta ikona dijamantnog oblika
na kadru 1 te su vrijednosti unutar prozora Transform spremljene bududi
da Zuta boja pozadine ukazuje da je dodan kljuéni kadar koji sadrzi te
vrijednosti.
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Zanimljivosti i napomene

Viewport Display pod Color
prikazuje boju koja se vidi
unutar Solid Modea, dok
Base Color pod Surface
prikazuje boju za rendering.
Buduci da za sada
rendering proces nije
potreban, koristi se boja
pod Viewport Display.

Slika 108. Postavljen prvi kljucni kadar

Sljedeci korak je dodavanje kljuénog kadra na kadar 30. Za razliku od
prijasSnjeg klju¢nog kadra, tu ¢e biti novih informacija i te vrijednosti je
potrebno spremiti. Prvo, prije ikakvih promjena na objektu, mora se
postavi plava linija na kadar po Zelji, u ovom slu¢aju na kadar 30, te se
onda unesu nove vrijednosti. Kocka ¢e se pomaknuti po osi y za 30 m,
ostale vrijednosti ostaju iste. Zatim se pritisne tipka [I] i izabere se
Location za spremanje buduéi da se mijenjala samo vrijednost pod
Location, ostale vrijednosti ostaju iste kao na prijasnjoj klju¢noj to&ci.
Dalje se ide na kadar 60, u ovom slucaju bit ¢e viSe promjena, kocka se
pomice na lijevu stranu scene, pod Location se upisuje X =-15m, a pod
Rotation (X = -5°,Y = 35°, Z = 0°). Ostale vrijednosti ostaju iste te se
sprema tipkom [l]. Sljedeci klju¢ni kadar je na kadru 90, kocka se miCe
na desnu stranu scene i rotira se u prvobitno stanje. Pod Location X =
15 m, dok pod Rotation sve se vrijednosti vra¢aju na 0°. Isto kao i kod
prijasnjeg klju¢nog kadra, spremanje je tipkom [I]. Zatim je potrebno
pripremiti promjenu boje kocke i boje pozadine u sljede¢em kljuénom
kadru postavljanjem referentne vrijednosti. Pod Material PropertiesE&l
selektirane kocke, na Viewport Display trebaostaviti zadanu ili default
boju. Za spremanje je takoder potrebno pritisnuti tipku [I], no u ovom
slu¢aju mi§ mora biti pozicioniran iznad trake za boju da bi se naredba
prihvatila. Nize na slici vidi se traka sa zadanom bojom, a desno je
vidljiva ikona ispunjenog dijamanta koja informira da je vrijednost
spremljena.

~ Viewport Display

color (N ¢

Metallic 0.000 a
Roughness 0.400 .

» Custom Properties

Slika 109. Postavljanje kljucnog kadra za boju

Za promjenu pozadine je isti postupak kao kod postavljanja zadane boje
kocke za referentnu vrijednost. Pod World Properties [@ mora se
podesiti boja pod Viewport Display i pritisnuti tipka [I] kad je mis
pozicioniran iznad trake za boju.
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Kljuéni kadar postavljen na kadar 120 ¢e ukljuditi i nove informacije
vezane za boju kocke i pozadine te ¢e biti potrebno postavljati kljuéne
kadrove unutar prozora Properties. U ovom segmentu kocka ¢e se
rotirati i skalirati, a smjer kretanja je prema nazad, u donji desni kut
kadra. Prvo treba namijestiti Transform vrijednosti, Location (X =12 m,
Y=0m, Z=0m), Rotation (X=-5°, Y = -40°, Z = 20°) te pod Scale sve
postaviti na 2. Zadnji korak je promjena boja kocke i pozadine. Za
promjenu boje na kocki treba oti¢i ponovno pod Material Properties
selektirane kocke te pod Viewport Display izabrati zelenu boju,
Hue(0.33), Saturation (0.99), Value(1.0) i Alpha(1.0). Za spremanje
treba pritisnuti tipku [1], paziti da je mi§ pozicioniran iznad trake za boju
da bi se naredba prihvatila. Nize na slici vidi se traka s odabranom
bojom i desno je vidljiva ikona ispunjenog dijamanta te je vrijednost
spremljena.

~ Viewport Display

color (M ¢

Metallic 0.000 °
Roughness 0.400 .

> Custom Properties

Slika 110. Postavljanje kljucnog kadra za promjenu boje

Jos preostaje boja pozadine 3D prostora. Kako bismo nju promijenili,
potrebno je podesiti nekoliko stvari. Pod World Properties B, isto kao i
kod kocke, mora se podesiti boja pod Viewport Display. Postupak je isti
te je boja postavljena na bijelu. Informacije o boji su Hue(0.0)
Saturation(0.0) i Value(1.0). MoZe se primijetiti da se, unato€ tome $to je
boja pozadine drugacija, promjene trenutno ne vide. Nova boja kocke se
vidi, dok je pozadina i dalje nepromijenjena. Da bi se to podesilo, mora
se promijeniti jedna postavka pod Viewport Shading.

O REE

Slika 111. Otvaranje Viewport Shading prozora

Kada se otvori prozor, segment Background, postavljen je na Theme, a
da bi boja bila vidljiva, potrebno je promijeniti na World kao niZe na slici.

Theme World Viewport

Slika 112. Postavke Background

Nakon $to je klju¢ni kadar na kadru 120 postavljen, trenutno stanje
animacije trebalo bi izgledati kao na slici nize. Ako se pomi€e plava linija
prema nazad, sada se moze primijetiti postupno mijenjanje boje iz bijele
nazad u tamnosivu i obratno kada se vrati na kadar 120.
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Slika 113. Pozicija kocke na kadru 120

Nastavlja se dalje te se dodaje kljucni kadar na kadar 150. Buduci da se
kocka vraca na pocetnu poziciju, sve Location vrijednosti vracaju se na 0
m, Rotation (X =-130°, Y=15°,Z = -180°) te se Scale vraéa na 1. Sto se
tiCe boja, za sada se nista ne mijenja. Ostaju joS dva klju¢na kadra,
predzadnji na kadru 180 vraca vrijednosti rotacije na 0, te Location
vrijednosti ostaju iste kao na prijaSnjem, Scale takoder ostaje isti. Boja
kocke prebacuje se na tirkiznu: Hue(0.5), Saturation1.0) i Value(1.0) i
Alpha(1.0) te boja pozadine postaje crna Hue (0.0) Saturation (0.0) i
Value(0.0). Prije nego se krene sa zadnjim kljuénim kadrom, dodat ¢e se
jos i modifikator Array, koji se nalazi pod Generate. Unato€ tome §to ce
efekt modikatora biti vidljiv tek na sljede¢em kljuénom kadru, ista logika
vrijedi i za spremanije vrijednosti modifikatora. Moraju postojati
referentne vrijednosti vezane za taj modifikator. Na kadru 180 stanje
modifikatora treba izgledati kao na slici nize.

~ il Array YilmE@ v X
Fit Type Fixed Count

Count 4

“ o Relative Offset

Factor X
Y
Z

Slika 114. Stanje modifikatora na kadru 180

Za zadniji klju¢éni kadar, kadar 240, sve prijadnje navedene vrijednosti ¢e
se promijeniti, kocka se pomi€e prema sredini scene i pomocu
modifikatora Array formirat ¢e se stepenice.

Pod Location jedino se mijenja vrijednost Y, koja iznosi 35 m. Rotation
vrijednosti ostaju iste osim Z, koji iznosi -45° te se Scale vrac¢a na 2.
Boja kocke prebacuje se na ljubi¢astu Hue(0.7), Saturation(0.9) i
Value(1.0) i Apha(1.0) isto tako i boja pozadine se mijenja u limetu
Hue(0.25), Saturation(0.75) i Value(1.0). Sto se tiée Array vrijednosti,
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Count ostaje 4, no Relative Offset se mijenja, X=1,Y=0.3,Z=-1.
Scena na samom kraju animacije trebala bi izgledati kao na slici nize.

Slika 115. Izgled scene na kraju animacije
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4.3. Vjezba: animiranje kocke

Animirat ¢e se kocka koristeci klju¢ne toCke. Potrebno je otvoriti novu
datoteku te su klju¢ne tocke i njihove vrijednosti sljedece:

1.

Kadar 1: lokacija, rotacija i skala ostaju iste. Radi se o
referentnoj vrijednosti. Pritisnite tipku [I] da se spreme referentne
vrijednosti. Pod Viewport Shading - Background, postaviti na
World.

Kadar 50: lokacija se mijenja, vrijednostisu X =-10m, Y =10 m,
Z =5 m. Za promjenu boje kocke na sljedeé¢em klju¢nom kadru,
prvo postaviti referentnu to¢ku na Material Properties - Viewport
Display > Color drzec¢i mi$ na traci za boju, zatim pritisnite tipku
[1] da se spremi vrijednost.

Kadar 100: namjestiti vrijednosti Location (X=0m,Y =20m, Z
= 0 m) i postaviti boju kocke. Izbor boje je proizvoljan, vazno je
da se primijeti prijelaz iz jedne boje u drugu. Spremiti vrijednosti.

Kadar 150: Location (X=10m,Y =10 m, Z = 5 m), a za rotaciju,
sve vrijednosti su 45°. Spremiti vrijednosti.

Kadar 200: vrijednosti Location i Rotation vra¢aju se na poc¢etno
stanje, postavljaju se na 0. Boja kocke se mijenja, izbor boje je
proizvoljan. Za promjenu boje pozadine na sljede¢em klju¢nom
kadru potrebno je prvo postaviti referentnu to¢ku, na World
Properties > Viewport Display - Color drzeéi mi$ na traci za
boju, pritisnuti tipku [I] da se spremi vrijednost.

Kadar 250:, Location (X=0m, Y =10 m, Z= 0 m) Rotation (X =
0°,Y=0°2=0°te Scale (X=2,Y=2,Z=1.5). Uovom
kljuénom kadru potrebno je promijeniti boju kocke i pozadine.
Boju za kocku postavite na sljedeée vrijednosti: Hue(0.9),
Saturation(0.75), Value(0.8) i Alpha ostaje isti. Boju za pozadinu
postavite na sljedece vrijednosti: Hue(0.37), Saturation(0.5),
Value(0.7).

Namijestite kameru tako da je cijela animacija vidljiva kroz perspektivu
kamere. Izgled scene na zadnjem kljuénom kadru na slici nize:

Slika 116. Izgled scene na zadnjem kadru vjeZbe 4.3.
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5. Render pogoni i ¢vorovi

Po zavrSetku ovoga poglavija moci cete:
e razluciti vrste render enginea i njihove svrhe
e Koristiti osnovne ¢vorove (Nodes) i njihove editore
e Koristiti Geometry ¢vorove

e Koristiti Shader ¢vorove

Rendering je proces generiranja slike ili animacije putem racunalnog
softvera. Ovaj proces koristi informacije o geometriji, teksturama,
osvjetljenju i kamerama kako bi stvorio finalnu sliku koja se moze vidjeti
na ekranu. Rendering se koristi u raznim podrucjima, kao sto su 3D
racunalna grafika, web-dizajn, graficki dizajn i animacije kod stvaranja
2D i 3D grafi¢kih prikaza i animacija.

Rendering moze biti u stvarnom vremenu (engl. real-time) ili izvan mreze
(engl. offline). Real-time rendering koristi se u aplikacijama kao $to su
videoigre i simulacije, gdje je brzina klju¢na, dok se offline rendering
koristi u aplikacijama kao $to su filmska produkcija i visokokvalitetne
vizualizacije, gdje je kvaliteta slike prioritet. Nize su prikazane vrste
renderiranja u Blenderu, pod Render properties > Render Engine. Tri
su izbora: EEVEE, Workbench i Cylces te ¢e se u ovom poglaviju
objasniti njihove uloge.

Render Engine = EEVEE

EEVEE

~ Sampling
Workbench

Render cyeles

Slika 117. Izbor Render Engine-a

5.1. Render engine EEVEE

EEVEE (Enhanced Environment for Virtual Engine) je jedan od render
enginea u softveru Blender. EEVEE je razvijen kao real-time render
engine, §to znadi da je optimiziran za brze vizualizacije i interaktivne
prikaze, za razliku od tradicionalnih render enginea koji su usmjereni na
fiziCki toCne simulacije svjetla i materijala.

Glavne karakteristike EEVEE-a ukljucuju:

o Real-time rendering. EEVEE Koristi tehnike rasterizacije koje
omogucuju brzo renderiranje, $to ga Cini idealnim za
pregledavanje scena u stvarnom vremenu.

e PBR (Physically Based Rendering) Shading: podrzava PBR
materijale koji omogucuju realisticno osvjetljenje i sjenCanje.
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e Soft Shadows: podrZzava meke sjene koje mogu poboljSati
realisticnost scena.

e Subsurface Scattering (SSS): omogucuje realistiCan prikaz
materijala poput koze, voc¢a, i drugih objekata kroz koje svjetlo
moze prolaziti.

e Ray Tracing: omogucuje naprednije real-time osvjetljenje i sjene
povecavajuci brzinu i vizualnu preciznost scena renderiranih u
EEVEE. lako EEVEE Ray Tracing nije fizicki to¢an kao Cycles,
priblizava se realisti¢nijem renderiranju s boljim performansama,
osobito za korisnike s ja¢im GPU-om.

e Depth of Field i Motion Blur. podrzava efekte dubinske ostrine i
zamucenja u pokretu.

EEVEE posebno je koristan za izradu animacija, interaktivnih aplikacija i
pregleda scena dok se razvijaju jer pruza dobar balans izmedu brzine i
kvalitete renderiranja. lako ne nudi isti nivo fizicke to¢nosti kao Cycles,
drugi popularni render engine u Blenderu, EEVEE je vrlo efikasan za
mnoge kreativne procese gdje su brzina i povratne informacije u
stvarnom vremenu klju¢ne.

Takoder, ako se cilja na stilizirani ili nefotorealisti¢an izgled, EEVEE je
odli¢an izbor. No, buduéi da EEVEE proizvodi viSe stilizirane ili
nefotorealisticne rendere, nije na razini postizanja fotorealizma kao $to
je moguce kod rendera Cycles.

5.2. Render engine Cycles

Cycles je jedan od glavnih render enginea u Blenderu, poznat po svojoj
sposobnosti da generira visokokvalitetne, fotorealisti¢ne slike. Cycles je
baziran na tehnici Path Tracing, $to znaci da simulira stvarne fizicke
procese svjetla kako bi stvorio izuzetno realistiChe renderirane slike.

Glavne karakteristike enginea Cycles ukljucuju:

e Path Tracing: tehnika za simulaciju svjetla, $to omogucava
visoku razinu realizma. Path tracing prati putanje svjetlosnih
zraka kako se odbijaju i lome kroz scene, $to rezultira preciznim
osvjetlienjem i sjenama.

e Global lllumination: Podrzava globalno osvjetljenje, $to znaci da
racuna indirektno osvjetljenje koje dolazi od refleksija i refrakcija
svjetla unutar scene. Ovo je kljuéno za stvaranje realisti¢nih
svjetlosnih efekata.

e PBR Shading: Cycles koristi PBR (Physically Based Rendering)
materijale koji omogucuju realisti¢no prikazivanje materijala sa
svim njihovim fizi¢kim svojstvima, kao $to su difuzno, refleksivno,
i refraktivno ponasanje.

Zanimljivosti i napomene

Ray tracing je tehnika za
generiranje slika koja prati
put svjetlosnih zraka dok
prolaze kroz scenu,
simulirajuéi njihovu
interakciju s objektima na
temelju fizikalnih zakona
optike. Cilj je stvoriti
visokorealisti¢ne slike
modeliranjem efekata kao
Sto su refleksija, refrakcija,
sjene i globalno osvijetljenje.

@ srce 2




Osnove rada u 3D grafiCkom alatu Blender (oznaka tecaja)

e Adaptive Sampling: Cycles moze prilagoditi broj uzoraka po
pikselu na temelju slozenosti scene, $to moze smanijiti vrijeme
renderiranja, dok zadrzava kvalitetu slike.

e GPU i CPU Rendering: Cycles podrzava renderiranje pomocu
CPU-a (engl. Central processing unit) ili procesora i GPU-a (engl.
graphics processing unit) ili graficke kartice. GPU renderiranje
moze znatno ubrzati proces na odgovaraju¢em hardveru.

e Denoising: Integrirani denoising alati mogu smanijiti Sum u
renderiranim slikama, to je posebno korisno za smanjenje
vremena renderiranja, dok se odrzava kvaliteta slike.

e Subsurface Scattering (SSS): omogucuje simulaciju materijala
kroz koji svjetlo djelomi¢no prolazi, kao §to su koza, vocée, vosak i
sliéno, Sto je vazno za stvaranje realisti¢nih bioloSkih materijala.

e Volumetric Effects: podrzava volumetrijske efekte kao $to su
magla, dim, vatra i drugi atmosferski efekti.

e Caustics: omogucava prikaz sloZzenih efekata svjetla koje se lomi
i reflektira kroz prozirne ili reflektiraju¢e povrsine.

Cycles je izuzetno moc¢an alat za korisnike koji zele postici visok nivo
realizma u svojim renderima. Zbog svoje to¢nosti i kvalitete Cesto se
koristi u profesionalnim produkcijama za filmove, animacije,
arhitektonske vizualizacije i druge aplikacije gdje je fotorealisti¢ni prikaz
klju€an. Cycles je izvrstan za stvaranje fotorealisti¢nih rendera zgrada i
unutarnjih prostora kako bi se prikazalo kako ¢e 3D dizajn ili maketa
izgledati u stvarnom zivotu. Takoder je odli¢an za predstavljanje
proizvoda koji su jo$ u fazi razvoja ili za vidjeti kako se neka ideja realno
transformira.

Cycles koristi napredniju varijantu tehnike Ray Tracing, ve¢ spomenuti
Path Tracing, za razliku od EEVEE. Scene s kompleksnim osvjetljenjem
ili kompleksnim globalnim osvjetljenjem podrucje je gdje Cycles znatno
bolje izvrSava zadatak nego EEVEE. Kada su potrebni precizni efekti
globalnog osvjetlienja i pra¢enja zraka (Ray tracing) te za projekte gdje
vrijeme renderiranja nije presudno i gdje se moze priustiti dulje vrijeme
renderiranja za izvanredne rezultate Cycles je najbolji izbor.

5.3. Render engine Workbench

Workbench je jedan od render enginea u Blenderu, prvenstveno
dizajniran za pregled i vizualizaciju 3D scena tijekom procesa
modeliranja. Njegova glavna svrha nije stvaranje finalnih rendera, veé
pruzanje brzih i jednostavnih pregleda scene kako bi se olak$alo rad na
modelima. Workbench je renderni mehanizam koji prikazuje vasu scenu
u 3D prikazu kada ste u nacinu prikaza Solid [ELJXE®] . Pruza odredenu
koli€inu osvjetlienja s malom koli¢inom kontrole.

Glavne karakteristike enginea Workbench ukljucuju:
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e Brzina: Optimiziran je za brzinu omogucujuéi glatko i brzo
pregledavanje scena, ¢ak i kada su slozene.

¢ Jednostavno sjencéanje: Podrzava osnovne tehnike sjen¢anja,
kao $to su studio, matcap i flat, koje su korisne za pregledavanje
geometrije bez ometanja detaljnim teksturama i materijalima.
Nalaze se pod Viewport Shading—> Lighting.

¢ Vizualizacija zi€anog okvira (Wireframe): Omogucuje prikaz
Zi¢anog okvira modela, $to je korisno za pregled topologije.

e Pregledavanje tekstura: lako nije namijenjen za detaljno
renderiranje tekstura, omogucava osnovni pregled tekstura na
modelima.

o Osvjetljenje: Podrzava osnovno osvijetljenje koje je korisno za
pregledavanje oblika i volumena modela.

Workbench je posebno koristan za brz pregled modela bez dugih
perioda renderiranja, brzo sastavljanje i organiziranje scena prije
detaljnijeg renderiranja s Cycles ili EEVEE, pregledavanje topologije i
strukture modela kroz prikaz Wireframe. Workbench je prakti¢an alat za
svakodnevni rad u Blenderu, koji korisnicima omogucuje da se
usredotoCe na kreiranje i uredivanje modela bez brige o dugom vremenu
renderiranja i slozenim materijalima.

5.4. Cvorovi

Cvorovi (engl. Nodes) u Blenderu su osnovni gradivni blokovi za
razliCite vrste grafickog rada, uklju€ujuc¢i materijale, teksture,
kompoziciju, pa ¢ak i geometrijske obrade. Oni predstavljaju
pojedinacne operacije ili funkcije koje se mogu kombinirati i povezivati
kako bi se postigli sloZzeni efekti i rezultati. Nodes se vizualno prikazuju
kao blokovi u sucelju, s ulazima i izlazima koji omogucuju povezivanje s
drugim ¢vorovima. Pomocu nodes sustava, korisnici mogu fleksibilno i
precizno kontrolirati izgled i ponaSanje svojih scena i objekata.

Postoji nekoliko glavnih vrsta Node Editora u Blenderu:

e Shader Nodes Editor @: koriste se za izradu i prilagodavanje
materijala.

o Texture Nodes Editor & koriste se za stvaranje i manipulaciju
tekstura.

e Compositing Nodes Editor e omogucuju postprodukcijske
efekte i kombiniranje razli€itih render slojeva.

e Geometry Nodes Editor . omogucuju proceduralno stvaranje i
manipulaciju geometrije.

Svaki od navedenih node editora ima velik izbor raznih &vorova na
raspolaganiju, tako da ¢e se proc¢i par jednostavnijih primjera unutar
Shader Editora i Geometry Editora buduci da &e se tijekom teCaja

@ srce 7



Osnove rada u 3D grafiCkom alatu Blender (oznaka tecaja)

isklju€ivo raditi u njima. Generalno, najbolji pristup za uenje rada s
¢vorovima je kroz upute za odredeni efekt ili Zzelje korisnika, prolaziti kroz
sve vrste ¢vorova jedan po jedan €ini se dosta kontraproduktivno. S dva
navedena editora se mogu postiéi impresivni rezultati s relativno malo
truda. Za pocetak, krenut ¢e se s primjerom unutar Geometry Nodes
Editora.

5.4.1. Geometry Nodes

Geometry Nodes u Blenderu je moc¢an alat koji omoguc¢ava
proceduralno modeliranje koristeci Evorove. Ova funkcionalnost uvedena
je u Blenderovoj verziji 2.92 i zna€ajno je unaprijedena u kasnijim
verzijama. Kroz Geometry Nodes korisnici mogu kreirati kompleksne
geometrijske oblike i efekte bez potrebe za ruénim modeliranjem
koristeci vizualni jezik za programiranje. Svaki ¢vor obavlja odredenu
funkciju, kao Sto je modifikacija geometrije, generiranje novih objekata,
transformacije i sli¢no. Za postavljanje Geometry Node Editora treba
odabrati objekt u 3D viewportu, odabrati Editor Type > Geometry Node
Editor kao Sto je prikazano nize na slici. Zatim treba pritisnuti na Create
a new geometry node oznaeno nize crvenim okvirom.

=]
Bl
[i DO

de Editor ar Animation
Geometry Mode Editor Shift F3

wader Editor
Geometry nodes.

Slika 118. Otvaranje Geometry Node Editor-a

Drugi je nacin putem prozora Properties na sekciji Modifier. Pritisnite na
Add Modifier i izaberite Geometry Nodes te Create a new geometry
node, isto kao u prijasnjem nacinu. U oba slu¢aja bit ¢e vidljiva promjena
unutar sekcije Modifier objekta, sto je prikazano nize na slici.

Add Modifier

s Vg ce. FIImB

=1+~ Geometry Nodes.004 ) [Ci X

» Manage

Slika 119. Otvaranje Geometry Nodes putem Add Modifier

Unutar prozora Editor pojavit ¢e se dva ¢vora, Group Input i Group
Output. U Geometry Nodes u Blenderu, Group Input i Group Output
¢vorovi igraju klju€énu ulogu u stvaranju prilagodljivih i ponovo
upotrebljivih évornih stabala (engl. nodetree). Oni omogucéavaju
korisnicima da definiraju ulaze i izlaze ¢vornog stabla, §to je posebno
korisno za organizaciju sloZenih ¢vornih stabala.

b @ srce



Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

Slika 120. Group Input i Group Output

Cvorna stabla predstavljaju nadin vizualnog programiranja koji
korisnicima omogucava stvaranje sloZzenih efekata, materijala, tekstura,
kompozicija i drugih elemenata kroz povezivanje razli€itih ¢vorova. Svaki
¢vor predstavlja odredenu funkcionalnost, a povezivanjem ¢vorova
mogu se stvarati kompleksne mreze koje definiraju konacni izgled ili
efekt. Cvorovi su povezani Zicama (engl. links), koje prenose podatke
izmedu njih.

Zice povezuju ulaznu i izlaznu utiénicu (engl. socket) Nodeovi imaju
ulazne i izlazne prikljucke kroz koje prolaze podaci. Ulazni socket prima
podatke, dok izlazni socket Salju rezultate obrade.

Oblici uti¢nica koriste se za prikazivanje koje su uti€nice polja, a koje su
obi¢ni podaci. Postoje tri moguca oblika uti¢nica, od kojih svaki
vizualizira svoj ,status polja”:

¢ Krug: zahtijeva jednu stvarnu vrijednost, ne moze prihvatiti unos
polja. Za izlazne uti¢nice to znaci da ¢vor uvijek daje jednu
vrijednost.

¢ Dijamant: moZe prihvatiti unos polja ili daje polje. Konstantna
pojedinacna vrijednost moze se povezati s ovim uti€nicama, ali
tada izlaz ¢esto nece varirati po elementu.

¢ Dijamant s tockom: moze biti polje, ali trenutno je pojedinacna
vrijednost. Ovo je korisno jer omogucuje praéenje gdje se
izraCunavaju pojedinacne vrijednosti, umjesto polja s mnogo
razliCitih rezultata. Takoder znaci da ¢e Inspekcija uti¢nica
pokazati vrijednost umjesto imena ulaza polja.

Nize na slici su prikazane sve vrste oblika utiCnica u razli¢itim bojama.
Boje nize predstavljaju razliCite vrste podataka koji se prenose, Sto je
prakti¢no radi lakSeg prepoznavanja razli€itih vrsta podataka i da se
izbjegne povezivanje nespojivih tipova podataka.
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v Set Position

Geometry @

® Geometry

© Selection
Position

Offset:

Slika 121. Set Position ¢vor
Osnovne boje uti¢nica i $to predstavljaju:

e Zuta: Predstavlja boju (Color). Ovi socketi prenose informacije o
boji i obi€no su koriSteni za teksture i boje materijala.

e Siva: Predstavlja skalarnu vrijednost (Value). Ovi socketi
prenose pojedinacne numericke vrijednosti, kao $to su faktori ili
intenziteti.

o Zelena: Predstavlja vektorsku vrijednost (Vector). Ovi socketi
prenose trodimenzionalne vektorske vrijednosti kao $to su
pozicije, normalni vektori ili UV koordinate.

e Plava: Predstavlja shadere (Shader). Ovi socketi prenose shader
informacije, koje se koriste za definiranje izgleda povrsine
materijala.

e Ljubicasta: Predstavlja teksture (Texture). Ovi socketi koriste se
za povezivanje tekstura i proceduralnih tekstura.

Ima i drugih boja koje predstavljaju druge vrste informacija, kao
primjerice roza na slici iznad koja predstavlja Boolean vrijednost,
odnosno frue ili false za to¢ne ili neto¢ne vrijednosti. No vec¢ina ¢vorova
Ce koristiti osnovne uti¢nice koje su gore navedene.

Kao primjer za Geometry ¢vorove uzet ¢e se ¢vor Duplicate Elements,
koji sluzi za dupliciranje objekata. Uz njega uzet ¢e se Cvor Set postion
koji ce omoguciti da se objekt ponavlja po odredenoj osi.

Kao $to je ve¢ objasnjeno, za postavljanje Geometry Node Editora treba
otvoriti novi projekt te selektirati objekt u 3D sucelju (koristit ¢e se
standardna kocka) odabrati Editor Type > Geometry Node Editor kao
§to je prikazano nize na slici. Zatim pritisnuti na Create a new geometry
node oznaceno nize crvenim okvirom. Unutar prozora Editor pojavit ¢e
se ¢vorovi Group Input i Group Output.
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Slika 122. Dodavanje novog ¢vora

Kako bi se dodali novi &vorovi, treba pritisnuti Add na slici iznad ili
postaviti pokaziva¢ mi$a unutar prozora Geometry Node Editor te,
koristeci pre€ac [Shift] + [A], odabrati Evor po Zelji koriste¢i Search te
ruéno upisati ime &vora ili pod kategorijama potraZziti &vor koji je
potreban. U ovom slu€aju, buduci da se to¢no zna koji ¢e se ¢vor
koristiti, potrebno je upisati Duplicate elements u trazilicu kao na slici
nize te odabrati ponudeno. Geometry-> Operations—> Duplicate
Elements ako se traZi ruéno.

,O duplicate elementsl

Duplicate Elements

Slika 123. Upisivanje imena ¢vora u traZilicu

Pritiskom na ponuden izbor &vora pojavit ¢e se Duplicate Elements Evor
koji je potrebno spustiti izmedu Group Input i Group Output, to¢no iznad
linije koja ih spaja te ¢e se automatski spojiti Geometry prikljucci kao na
slici nize.

~ Duplicate Elements
~ Group Input Geometry ®—

Geometry ®@—_ Duplicate Index ~ ~ Group Output

Point v “—~—@ Geometry

T~——@ Geometry
© Selection

Amount

Slika 124. Duplicate Elements postavke

Duplicate Elements ima nekoliko postavki koje se mogu mijenjati.
Padajuci izbornik, oznagen crvenim okvirom, ima viSe opcija na odabir.
Point, koji predefinirana postavka, stvara kopije vrhova objekta, dok
Edge i Face stvaraju kopije objekta koristeci linije odnosno lica. Opcija
Instance stvara kopije cijelog objekta, u ovom sluéaju, potrebno je
dodati ¢vor Geometry to Instances, izmedu Group Input i Duplicate
Elements ¢vorova. Razlika na prvi pogled nije zna€ajna buduci da odabir
Face u sustini radi istu stvar. No Instances se pokazao kao znatno brZi
izbor, a to je zato Sto render moze bolje upravljati istim geometrijskim
podacima na mnogim razli¢itim lokacijama nego kada su podaci
duplicirani. Drugim rijeCima, efikasniji nacin rada koji je idealan kada se
ukljuCuje puno vise geometrije u rezultat, bez dupliciranja stvarnih
podataka. To nece biti potrebno jer ¢e primjer koristiti jedan objekt.
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Postoji jo$ jedna opcija, Spline, no ona je rezervirana za krivulje, tako
da ju u ovom primjeru mozemo ignorirati.

Odabrat ¢e se Face, postavka Amount, koja sluzi za definiranje broja
kopija. Za sada postavljamo vrijednost na 3. Kao $to se moze primijetiti
u 3D pregledniku, ne vidi se kopija tog objekta. Razlog je §to je pozicija
kopije jednaka poziciji originalnog objekta. Potrebno je ubaciti dodatne
¢vorove da se definira smjer i udaljenost ili ofset gdje ¢e se generirati
kopije. Prvo se dodaje Set Position, ¢vor koji kontrolira lokaciju svake
kopije, a koristi se za postavljanije ili premjestanje pozicije vrhova u
mrezi odnosno meshu objekta. PreCac [Shift] + [A] upiSite u trazilicu Set
postion ili trazite po kategorijama Geometry> Write-> Set Postion.
Treba spustiti Evor izmedu Duplicate Elements i Group Output, kao na
slici nize.

v Set Position

~ Group Input

Geometry @~ Geometry ®

Slika 125. Postavljanje cvorova Duplicate Elements i Set Position

Nakon dodavanja novog ¢vora i dalje nema vidljivih promjena na kocki,
no ako se spoje uti¢nice Duplicate Index i Offset, pojavit ¢e se kopije
objekta rasporedene prema vrijednosti upisanoj unutar postavke
Amount. PoCevsi od 0 povecava se za svaku sljedecu kopiju za 1 m,
primjerice ako se postavi vrijednost 3, ofset ¢e biti 2 m po svakoj osi.
Ako se stavi vrijednost 4, ofset ¢e biti 3 m i tako dalje, referentno na
originalni objekt. Offset vrijednosti X, Y i Z ¢e se mijenjati ovisno o
vrijednosti unutar postavke Amount. Primjerice, ako je Amount
postavljen na 3, Offset vrijednosti ¢e biti postavljene na 2 m unato€ tome
Sto vrijednosti vise nisu vidljive unutar €vora Set Postion nakon spajanja.
Nize na slici vidi se kako se kopije slazu dok su Duplicate Indeks i Offset
spojeni.

Slika 126. Stvaranje kopija objekta pomocu Duplicate Index

Za vecu kontrolu nad pozicioniranjem kopija bit ¢e potrebni dodatni
Cvorovi. Sljedeci ¢vorovi koji ¢e se dodati su Math i Combine XYZ. Kao i
do sada, dodavanje se izvodi prec€icom [Shift] + [A] te se odabere
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Utilities~> Math->Math i Utilities—> Vector-> Combine XYZ pa ih postavite
izmedu Duplicate Elements i Set Postion ¢vorova. Math ¢vor, kao §to mu
ime sugerira, sluzi za izvodenje matematickih operacija, u ovom slucaju
Zelimo postaviti na Multiply umjesto Add. Cvor Combine XYZ ¢e
omoguciti da se odabere po kojoj ¢e se osi kopirati objekt. Prikljucci
Duplicate Index i Value spajaju se na ¢voru Math. Bududéi da je &vor
Math postavljen na Multiply, te dvije vrijednosti ¢e se mnoziti. Vrijednost
Duplicate Index prati postavljenu vrijednost Amount. Ako je Amount
vrijednost 4, Duplicate Index vrijednosti kre¢u se od 0 do 3 (nacelo polja
i indeksa u programiranju) te se mnoze s Value koji je 3. Znaci, prvo
mnozenje je 0 x 3, znaci da nema pomaka, a sljedece je 1 x 3, sto
pomice prvu kopiju kocke za 3 m, zatim 2 x 3, $to pomice sljede¢u kopiju
za 6 m i zadniji je 3 x 3, 8to pomice trecu kopiju za 9 m. Zadniji korak je
spajanje izlaznog prikljucka Value na ¢voru Math s &vorom Combine
XYZ izabiranjem jednog od triju priklju€aka, od kojih svaki predstavlja
jednu od triju osi. Kao primjer uzet Ce se x-0s, jer se zeli postiCi
pomicanje po x-osi. Jo§ je potrebno u potpunosti zatvoriti krug tako da
se spoje priklju€ci Vector i Offset na ¢voru Set Position. Nize na slici vide
se vrijednosti unutar ¢vorova i nacin kako su medusobno spojeni te
Zeljeni rezultat u 3D sucelju.

Slika 127. Ubaceni Math i Combine XYZ ¢vorovi

Primjer je gotov, no ako se zeli postici isti rezultat po svim osima
istovremeno, to je jako lako izvedivo. Potrebno je kopirati iste cvorove
dva puta te samo podesiti pod Combine XYZ na odgovarajucu os. Nize
na slici vide se tri grupe dodanih ¢vorova, po jedna grupa za svaku os. U
crvenom okviru su postavke za x-0s, u zelenom za y-os te u plavom za
z-0s. Spajanje je jednostavno: Geometry izlaz Evora Set Position unutar
crvenog okvira spaja se s Geometry ulazom Duplicate Elements unutar
zelenog okvira, nacelo je isto kao sa spajanjem ¢vorova unutar zelenog i
plavog okvira. Od postavki je samo potrebno podesiti Combine XYZ
Cvorove. Za zeleni okvir Value priklju¢ak od ¢vora Multiply spaja se s Y-
prikljuckom &vora Combine XYZ buduci da je rije¢ o raspodjeli kopija po
y-0si, dok se za plavi okvir, umjesto na Y-priklju€ak, spaja na Z-
priklju¢ak buduci da je rije€ o raspodijeli po z-osi. Rezultat spajanja tih
grupa je kocka koja se sastoji od manjih kocki kao &to je prikazano nize
na slici.
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{1) Collection | Cube

Slika 128. Postavljanje cvorova u grupe za svaku os

Unutar Geometry Node Editora moguce je dodati okvir oko ¢vorova radi
lakSeg prepoznavanja i bolje organizacije. Kao na prijadnjoj slici, okviri
mogu biti u raznim bojama i imati naslov. DijaloSki okvir, lociran na
desnoj strani unutar Geometry Node Editora, sadrzi nekoliko korisnih
postavki za doradivanje dodanih okvira. Za pocetak, kako bi se dodao
okvir, potrebno je prvo zaokruZiti vorove koji bi bili unutar odredenog
okvira te, kada su oznaceni, koristiti naredbu Join predicom [Ctrl] + [J].
Kada se pojavi okvir, selektirajte ga te pogledajte ponudene postavke
unutar dijaloskog okvira.

Name sluZi za preimenovanje okvira, dok Label omogucuje da se
prikaze tekst na okviru radi lakSe preglednosti. Kvacica pod Color
omogucuje da se mijenja boja okvira, Label Size podeSava veli€inu
teksta, a Shrink, kada je postavljena kvacica, automatski prilagodava
veli€inu pozadine ovisno o sadrZaju unutar okvira. Kada je uklonjena
kvacica, korisniku je omoguceno mijenjanje veliine okvira. Na slici nize
prikazana je grupa ¢vorova s pozadinom i nadesno njezine postavke.

~ & Color

« Multiply

v Properties

Multiply
Label Size
« Shrink

Text: B

Slika 129. Grupa cvorova Z-os s postavkama

Od ostalih osnovnih Geometry Nodes, korisnih za daljnje u¢enje, mogu
se izdvoijiti sliedeci:

Transform Geometry: mijenja poziciju, rotaciju i skaliranje geometrije.

Primitives: sluZi za dodavanje osnovnih oblika poput kocke, cilindra,
konusa, kugle i drugih.
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Dual Mesh: koristi se za generiranje dualne mreZe od postoje¢e mreze
(mesh). Dualna mreza zamjenjuje vrhove i plohe izvorne mreze. Ovo je
korisno za razne zadatke u modeliranju, uklju€ujuc¢i geometrijske
transformacije i manipulaciju mrezom.

Slika 130. Prije i poslije upotrebe ¢vora Dual Mesh

Distribute Points on Faces: koristi se za distribuciju to¢aka na
povrSinama (faces) geometrije. Ovaj ¢vor posebno je koristan za
generiranje rasporeda toCaka koje mogu biti koristene za razli¢ite svrhe,
kao Sto su stvaranje Cestica ili definiranje uzoraka na mrezama.

Slika 131. Prije i poslije upotrebe Distiribute Points cvora

Join Geometry: Kombinira viSe geometrija u jednu, $to je jako korisno
kada se zeli sloziti kompleksniji oblik. Drugim rijeCima, dva ili vise
objekata postaju jedan.

5.4.2. Shader Nodes

Shader Nodes su alati u Blenderu za stvaranje slozenih materijala. Oni
korisnicima omogucuju da kombiniraju razli€ite teksture, boje i efekte
kako bi postigli realisti¢ne ili stilizirane rezultate. U ranijem poglavlju
govorilo se da je shader set instrukcija ili program koji diktira na koji ¢e
se nacin materijal pona$ati u odnosu na svjetlosne izvore. Proslo se kroz
par osnovnih shadera kao $to su Diffuse BSDF, Glass BSDF, Glossy
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BSDF, Principled BSDF, Emission i druge koji su takoder dostupni
putem Shader Editora. Za postavljanje Shader Editora treba odabrati
objekt u 3D viewportu, odabrati Editor Type - Shader Editor kao Sto je
prikazano nize na slici. Cvor Principled BDSF je automatski dodan
buduci da je defaultni Evor kada se otvori Shader Editor.

Slika 132. Otvaranje Shader Editora

Takoder, Shader Editor automatski se pojavi promjenom radnog
prostora, odabirom kartice Shading. Odabirom tog radnog prostora sve
postavke koje su potrebne za rad u Shader Editoru su ukljucene.
Takoder, moze se Geometry Node Editor otvoriti putem kartice
Geometry Nodes na traci za radne prostore. Nize je prikazan radni
prostor Shading u kojem ¢e se raditi sa Shader ¢vorovima.

Slika 133. Radni prostor Shading

Za upoznavanje s osnovnim Shader ¢vorovima koristit ¢e se defaultni
¢vor Principled BSDF kojim ¢e se postici da objekt svijetli, odnosno
isijava poput svjetlosnog izvora kao &to je Zarulja. Nakon $to se postigne
zeljeni efekt, dodat ¢e se i Geometry Evorovi koji su bili koriSteni u
prijaSnjem primjeru i pokazati kako se mogu kombinirati Geometry i
Shader €vorovi. Prvi korak je prouciti $to je sve dostupno unutar ¢vora
Principled BSDF i koje opcije su potrebne da se postigne Zeljeni efekt.

Moze se primijetiti da Principled BSDF kao ¢vor ima iste opcije kao pod
Material Properties - Surface buduci da se radi o istom shaderu na
drugadijoj lokaciji unutar sucelja. Kako se mijenjaju postavke unutar
¢vora, slika niZe s lijeve strane, tako se mijenjaju postavke unutar
Material Properties s desne strane i obratno. Postavke koje treba
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mijenjati su Base Color i pod Emission, promijeniti vrijednosti Color i
Strength. Emission se Koristi za stvaranje objekata koji emitiraju vlastitu
svjetlost umjesto da reflektiraju svjetlost iz drugih izvora. Vrijednosti
Base Color i Emmision Color ¢&e biti iste, Hue(0.5), Saturation(1.0) i
Value(1.0). Vrijednost Strength pod Emission treba postaviti na 10. Nize
na slici podesene su postavke.

v Surface

Vv Principled BSDF
Surface e Principled BSDF

Base Color
Base Color

_ Metallic
Metallic

Roughness
Roughness

IOR

IOR
Alpha
Alpha Normal Default
Normal > Subsurface
> Subsurface > Specular
> Specular Transmission
> Transmission Coat
> Coat Sheen
> Sheen Emission

e Color
v Emission

Strength

®
Color Thin Film

®  Strength

> Thin Film

Slika 134. Principled BSDF kao ¢vor i unutar Material Properties

Kada se promotri kocka nakon postavljenih postavki, i dalje se ne
primjecuje isijavanje, kocka je bijele boje i bez primjetnog sjaja. Da bi
efekt isijavanja bio vidljiv, potrebno je ukljuiti postavku Bloom putem
Compositing Nodes. Bloom je opticki efekt koji simulira rasprSivanje
svjetlosti u sceni stvarajuéi dojam jacCe svjetlosti koja se prelijeva i
djelomi¢no zamagljuje okolne objekte. Ovaj efekt Cesto se Kkoristi u
renderiranju kako bi se dodao osjecaj realizma ili stilski izgled scenama
s visokim nivoima svjetlosti, kao s$to su sunceve zrake ili svjetla u noénim
scenama. Pocevsi od Blenderove verzije 4.2.0, efekt Bloom vise nije pod
postavkama Render Properties, nego je sada ukomponiran unutar Glare
¢vora kojeg ¢e se dodati putem Compositora, koji sluzi za
postprodukcijske efekte i kombiniranje razli€itih render slojeva. Za
poCetak mora se otvoriti Compositor, idealno u donjem lijevom prozoru,
umjesto Image Editora, koiji je predefinirana (default) postavka na toj
poziciji kada se otvori Shading Workspace.

Nize na slici prikazano je kako se postavlja Compositor. Svojevoljno se
moze podesiti veli€ina prozora koji ¢e sadrzati Compositor. PodeSavanje
je jednostavno: potrebno je postaviti pokaziva¢ miSa iznad crte izmedu
liievog i desnog dijela dok se pokaziva¢ miSa ne promijeni u bijelu ikonu
koja prikazuje dvosmijernu strelicu. Zatim treba pritisnuti i povuéi lijevo ili
desno pa postaviti kvacicu na Use Nodes unutar prozora Compositor,
da bi €vorovi bili vidljivi.
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= v+ New {iOpen

[ Image Editor
(B}

Slika 135. Otvaranje prozora Compositor

Unutar prozora Compositor potrebno je pritisnuti [Shift] + [A] te dodati
¢vor Glare, pod Filter > Glare koji se koristi za dodavanje svjetlosnih
blijeskova, magle i sjaja oko svijetlih dijelova slike. Cvor Glare treba
postaviti izmedu Evorova Render Layers i Composite te pod Glare Type,
koji je prvi padajuci izbornik, odabrati Bloom. Nize na slici vide se
spomenuti ¢vorovi.

Image ®-
Glare ®

 Render Layers Ao Highlights @

Image @
Alpha ® . ¥ Use Alpha
e ® Image

5 ®  Alpha 1.000
v

> Glare

Slika 136. Dodani ¢vor Glare s postavkom na Bloom

Za zadniji korak, buduci da jo$ nije vidljiv efekt Evora, potrebno je
postaviti pod Viewport Shading - Compositor - opciju Always kako bi
efekti u prozoru Compositor bili vidljivi. Nize na slici postavljeno je prema
uputama i moZe se vidjeti u lijevom donjem kutu kako je kocka pocela
svijetliti, Sto znaci da sve radi kako je zami$ljeno.

Rotation

Strength

Werld Opacity
Blur

Random

Combined

Disabled Camera Always

Slika 137. Postavke Viewport Shading

Nize na slici vidi se rezultat postavki na kocki, no u ovom primjeru
pokazat ¢e se kako postici isti efekt na kugli ili za bilo koji drugi osnovni
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oblik putem Geometry Nodes Editora. Prakti¢no je $to se oblici mogu
izmjenjivati, a postavke ostaju iste. Ime materijala treba promijeniti s
Material na Mat_Svjetlo unutar prozora Material Properties.

Slika 138. Rezultat postavki na kocki

Prebacite se u Geometry Nodes Editor BM, treba dodati novu grupu
évorova te dodati Mesh—> Primitives—> UV Sphere pa
otkaditi liniju s utinice Geometry na &voru Group Output kako bi se
mogli spoijiti vorovi UV Sphere i Group Output. UtiCnica Mesh spaja se
s utiénicom Geometry kao $to je prikazano nize na slici. Postavke na
Cvoru UV Sphere ostaju iste, osim Radius koja ¢e se postavitina 1.3 m.

v UV Sphere
Mesh
UV Map
Segments 32 ~~— v Group Output
Rings 16 @ Geometry
Radius 1.3m

v Group Input

Geometry @

Slika 139. Dodavanje ¢vora UV Sphere

Da bi se isti efekt pojavio na sferi koja je upravo dodana, potrebno ju je
spojiti s istim materijalom koji koristi kocka. To je lako izvedivo pomocu
Cvora Set Material, lociranog pod Material > Set Material. Taj ¢vor
omogucuje poveznicu s ve¢ koristenim materijalom i svim efektima koji
su vezani za njega. Treba ga spustiti izmedu ¢vorova UV Sphere i
Group Output, a oni ¢e se automatski spojiti s njim. Potom je potrebno
izabrati Mat_Svjetlo u popisu materijala kao na slici nize.
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v UV Sphere

Mesh @
UV Map v Set Material

Segments 32 Geometry \ v Group Output
Rings 16 ® Geometry ® Geometry

|
Radius 1.3 m ¢ Selection

0|

@® Mat Svjetlo

Slika 140. Odabir materijala unutar ¢vora Set Material

Nakon odabira Mat_Svjetlo sfera je poprimila materijal i efekte koji su bili
ranije videni na kocki. Ovaj pristup radi za svaki od objekata koji se
mogu odabrati medu Mesh—> Primitives osim odabira koji nemaiju lica
poput Mesh Line i Mesh Circle.

L8 B e -

Slika 141. Sfera je poprimila vizualne efekte od kocke

Ista kombinacija ¢vorova kao u primjeru u poglavlju s Geometry Nodes,
gdje se koristio ¢vor Duplicate Elements, ubacit ¢e se u ovom primjeru
kako bi se postigla grupacija svijetle¢ih objekata. Nacelo je identi¢no i
postavke su iste, samo se u ovom primjeru primjenjuju efekti i boje na
materijalu uz drugaciji odabir objekta te su vrijednosti Amount pod
Duplicate Elements i Value pod Math postavljene na vrijednost 5. Treba
dodati Geometry—> Operations—> Duplicate Elements, Geometry->
Write> Set Position, Utilities—> Math-> Math i Utilities—> Vector>
Combine XYZ &vorove. Multiply Evor treba biti spojen na X-uti€nicu
¢vora Combine XYZ. Na slici niZze prikazani su spojeni ¢vorovi.
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Slika 142. Spojeni ¢vorovi za sferu

Sljedeci korak, potrebno je dodati istu grupu Evorova za preostale osi, za
y-0s i z-0s. Kao i prije, treba kopirati grupe ¢vorova za osi y i z i podesiti
postavke. Za y-os grupu, koja poc€inje s Duplicate Elements, spaja se sa
Set Position prve grupe koja predstavlja x-os. Uz to potrebno je podesiti
po kojoj se osi nizu kopije, znadi priklju¢ak Value se spaja sa y-
priklju¢kom. Ponoviti isto za z-o0s te se na samom kraju slijeda spaja Set
Material na ¢vor Set Position kako bi se zahvatile sve osi i njihove kopije
objekta. Kako se sada ve¢ radi o malo veéem broju ¢vorova, ovo je
odli¢na prilika da se pokaZe kako se ¢vorovi mogu podesiti da zauzimaju
manju povrSinu te da prostor djeluje malo urednije. Pomo¢u Node
Groups moguce je grupirati Evorove: potrebno je zaokruziti odredene
Cvorove te desnom tipkom miSa odabrati Make Group kako bi se
postavila grupa, a moze se i oti¢i na meni Node -> Make Group.

M Cube > &g GeometryMNodes > ,!E:I Geometry

~ Duplicate Elements » Set Position

P Geometry
Geometry

Duplicate Index ! Geometry

€ Selection
Face v

||~ Multiply < z

i Position
Geometry
Vectar Offset

4 Selection

Amount Multiply
\ Clamp
@ Value

¢  Value

Rename..

Slika 143. Grupiranje zaokruZenih ¢vorova

Naredba Make Group, koja ima prec¢ac [Ctrl]+[G], omoguéava grupiranje
nekoliko pojedinacnih €vorova u jedan kompaktni ¢vor. Nakon $to se

stvori grupa, prikaze se sadrzaj grupe kao na slici nize. Svaka od grupa
dobije svoje Evorove Group Input i Group Output kao $to se vidi na slici.
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~ Set Position

Slika 144. Group Input i Group Output dodani za grupu

Dok je grupa otvorena, ostatak ¢vornog stabla nije vidljiv. Za vra¢anje na
pocetni pregled, odnosno da bi se izaslo iz pregleda ¢vorne grupe, mora
se pritisnuti tipka [Tab]. Kada se izade iz pregleda grupe, pojavi se
poseban ¢vor na mjestu grupiranih ¢vorova koji predstavlja tu grupu
¢vorova. Ako se Zeli pristupiti toj €vornoj grupi, potrebno je selektirati
jedan od tih posebnih &vorova i pritisnuti tipku [Tab] kako bi se dobio
pristup sadrZaju unutar grupe. Na slici niZze prikazan je jedan od tih
posebnih ¢vorova. Moze se promijeniti naziv te grupe pritiskom na tekst i
upisivanjem Zeljenog naziva.

v Node_X-os =4

Geometry
=il Node_X—os| O

Geometry

Slika 145. Cvor predstavlja odredenu grupu

Isto nacelo grupiranja Cvorova koristit e se s ostatkom ¢vornog stabla,
odnosno ¢vorovi koji su potrebni za formiranje kopija objekta po y-osii z-
osi Ce se takoder grupirati te ¢e se dobiti rezultat kao na slici niZe.
Pomocu ovog nacela dobije se puno urednija i preglednija situacija
unutar Geometry Node Editora.

~ UV Sphere

Segments
Rings

Radius

up Output

® Geometry

Slika 146. Medusobno spojene grupe

Kada su svi ¢vorovi adekvatno postavljeni i njihove postavke
namjestene, unutar 3D preglednika Ce se pojaviti grupacija kugla koje su
postavljene da €ine oblik kocke.
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Slika 147. Izgled sucelja nakon finalnih postavki
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5.5. Vjezba: Cvorovi

U ovoj vjezbi ponovit ¢e se postupak prijasnjeg zadatka, slaganje kocke,
koriste¢i ponavljanje osnovnih oblika u Blenderu pomoéu ¢vorova, s
manjim promjenama u postavkama.

1.

Otvorite novu datoteku File> New-> General te odaberite
Shading workspace. Selektirajte objekt te unutar Shading
Editora na ¢voru Principled BDSF promijenite vrijednosti Base
Color i Emmision Color na Hue(0.750), Saturation(0.950) i
Value(1.0). Pod Emission, postavite vrijednost Strength na 10.

Otvorite Compositor, u donjem lijevom prozoru, umjesto Image
Editora. Postavite kvacCicu na Use Nodes unutar prozora
Compositor da bi Evorovi bili vidljivi. Unutar prozora
Compositor pritisnite [Shift] + [A] te dodajte ¢vor Glare, pod
Filter> Glare. Cvor Glare postavite izmedu &vorova Render
Layers i Composite, a pod Glare Type, koji je prvi padajuci
izbornik, odaberite Bloom. Za vidljivost efekta ¢vora potrebno
je postaviti pod Viewport Shading—> Compositor-> opciju
Always, za vidljivost efekta rada u prozoru Compositor.

Prebacite se u Geometry Nodes Editor na mjestu prozora
Shader Editor, dodajte novu grupu ¢vorova te
dodati Mesh—> Primitives—> Cone te otkaciti liniju s Geometry
uti¢nice na ¢voru Group Output kako bi se mogli spojiti Evorovi
Cone i Group Output. Uti€nica Mesh spaja se s utiCnicom
Geometry. Postavke na Cone €voru ostaju iste.

StoZac spojite s istim materijalom koji koristi kocka. Ubacite
¢vor Set Material pod Material> Set Material te ga spustite
izmedu &vorova Cone i Group Output i automatski ¢e se spojiti
s njim. Na ¢voru Set Material izaberite ve¢ izradeni Material.

Dodajte Evorove Geometry-> Operations—> Duplicate
Elements, Geometry—> Write> Set Position, Utilities>
Math-> Math i Utilities—> Vector-> Combine XYZ. Postauviti
¢vorove prema poretku na slici nize. Na ¢voru Duplicate
Elements Amount postavite na vrijednost 5 i postavku Point
zamijenite postavkom Face. Zatim na ¢voru Math (piSe Add)
postavite na Multiply te pod Value na vrijednost 5. Cvor mijenja
ime prema odabranoj matematickoj funkciji. Cvor Multiply treba
biti spojen na x-uti€nicu &vora Combine XYZ. Provjerite da li su
¢vorovi i njihove postavke postavljene prema slici nize.

Slika 148. Pravilan redoslijed spojenih ¢vorova
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6. Ponovite postupak iz prijasnjeg koraka za osi y i z te podesiti
postavke. Za y-os grupu, koja poc€inje sa Duplicate Elements,
se spaja sa Set Position prve grupe koja predstavlja x-o0s, uz to
potrebno je podesiti po kojoj se osi nizu kopije, znaci Value
prikljuCak se spaja sa y prikljuckom. Ponoviti isto za z-0s, te na
samom kraju slijeda, se spaja Set Material na Set Position Evor
kako bi se zahvatile sve osi i njihove kopije objekta. Grupirati
¢vorova koji predstavljaju odredenu os, tako da ih se zaokruZi
te desnom tipkom mi$a odabrati Make Group kako bi se
postavila grupa ili kratica [Ctrl]+[G]. Nazvati grupe po osobnom
izboru. Tipkom [Shift] se izlazi ili ulazi u Evornu grupu.

7. Provjeriti postupak i postavke tako da scena izgleda kao na
slici nize.

Slika 1489. Izgled scene kada je vjeZba 5.5. gotova
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6. Renderiranje u Blenderu

Po zavrsetku ovoga poglavija moci Cete:
¢ razlikovati render engine
e Kkoristiti osnove enginea EEVEE
e razumijeti interakciju svjetlosnih zraka s objektima na sceni

e renderirati slike.

Na pocetku poglavlja spominjale su se opcije render enginea i njihove
uloge te je sada vrijeme za renderiranje kratke animaciju koristeci jednu
od tih opcija. Cycles i EEVEE renderiranje su dvije opcije koje dolaze u
obzir kod stvaranja animacija odnosno finalnih rendera. Cycles je
Blenderov fizi¢ki baziran path tracer za produkcijsko renderiranje, sto
znaci da se temelji na stvarnim zakonima fizike o ponasanju svjetla te
koristi fiziCki bazirane modele osvjetljenja i materijala kako bi simulirao
stvarni svijet $to je moguce realnije. Kako bi bilo jasnije 8to je Path
Tracing, potrebno je objasniti Ray Tracing.

Ukratko, Ray Tracing je tehnika koja prati zrake svjetlosti koje su
emitirane iz kamere. Za svaki piksel koji €ini kadar jedna ili viSe zraka
emitira se iz kamere prema sceni. Naravno, ne doslovno, generira se
vektorska jednadzba s parametrima postavljenim na temelju polozaja
kamere i piksela. Svaka zraka predstavlja jedan piksel te, kada zraka
pogodi povrSinu, ta zraka nastavi putovati prema izvorima svjetlosti te se
na taj nacin odreduje boja tog piksela. Ray Tracing uklju€uje
izraCunavanje putanje refleksije ili loma svake zrake te njihovo pracenje
sve do jednog ili vise izvora svjetlosti.

Osim §to prati znatno vecéi broj odbijanja zraka po pikselu, Path Tracing
razlikuje se od Ray Tracinga i po tome §to, umjesto da se fokusira na
sve zrake kroz cijelu scenu, algoritam prati samo najvjerojatnije putanje
svjetlosti te simulira indirektno osvjetljenje i globalno osvjetljenje puno
preciznije od standardne tehnike Ray Tracing. 1z ovog razloga tehnika
se zove Path Tracing jer ne prati samo jednu zraku s nekoliko odbijanja,
ve¢ simulira slozene i razgranate putanje svjetlosti kroz cijelu scenu.
Ova metoda preciznije modelira nacin na koji svjetlost djeluje u stvarnom
svijetu. Cycles iz toga razloga moze proizvesti rezultate visoke kvalitete i
realistiCnosti. Nize na primjeru vide se tri metode renderiranja:
rasterizacija, tehnika koja proizvodi sliku kako se vidi iz jedne toCke
gledista, standardni je izbor koji se koristi u videoigrama, te primjeri za
Ray Tracing i Path Tracing koji prikazuju glediSte iz viSe toCaka. Vidi se
znacajna razlika izmedu rasterizacije i tehnike Ray Tracing, dok je Path
Tracing kategorija za sebe sudeci po detaljima, razini odsjaja i svjetlosti
koja je uhvacena.
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RAY TRACED RASTERIZATION

Slika 150. Usporedba rendering tehnika

Jo§ jedna prednost kod Cycles je §to podrzava renderiranje pomocu
CPU-a i GPU-a. GPU renderiranje moze znatno ubrzati proces na
odgovarajué¢em hardveru, dok EEVEE nema opciju renderiranja pomoéu
GPU-a. Nize se vidi opcija postavljanja na renderiranje pomocu graficke
kartice odnosno opcija GPU Compute, kada je Cycles odrabran kao
Render Engine.

Render Engine  Cycles
Feature Set  Supported
Device = CPU
CPU

GPU Compute
> Sampling

> Light Paths Use GPU compute device for rendering, configured in the system tab in the
user preferences.

Slika 151. Postavka GPU Compute

Kada se postavi na opciju GPU Compute, moze se primijetiti da su
postavka Device i opcija koja je odabrana tamnosive boje umjesto bijele,
Sto signalizira da opcija nije aktivna iz nekog razloga. Potrebno je u
Preferences podesiti dodatne opcije da bi sve proradilo. Pod Edit>
Preferences> System-> Cycles Render Devices—> CUDA u slucaju da
se koristi graficka kartica NVIDIA, dok je za AMD-ovu grafi¢ku kraticu
potrebno postaviti na opciju HIP. CUDA (engl. Compute Unified Device
Architecture) je platforma za paralelnu obradu i API (engl. Application
programming interface) razvijena od strane tvrtke NVIDIA, &iji se graficki
procesori sastoje od nekoliko stotina ili tisu¢a (za novije kartice) CUDA
procesorskih jezgri koje su specijalizirane za renderiranje slika. Osim
obrade slika, ova tehnologija vrlo je korisna u podrucjima poput umjetne
inteligencije, strojnog u€enja, simulacija, znanstvenih istrazivanja i
mnogih drugih gdje je potrebno obraditi velike koli¢ine podataka. To
znaci da se zadaci, koji bi inace bili izvrSavani na srediSnjem procesoru
(CPU), mogu podijeliti na viSe manijih dijelova i izvrSavati paralelno na
velikom broju jezgara unutar GPU-a. Kada se izabere CUDA kao
Render Device, renderiranje je znatno ubrzano za razliku od
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renderiranja na klasi¢an nacin, pomoc¢u CPU-a. CUDA je samo
dostupna kao opcija kada je prisutna Nvidijina grafi¢ka kartica. U slu€aju
nize gdje se koristi standardni laptop ta opcija nazalost nije dostupna,
buduci da vecina laptopa ima integriranu grafi¢ku karticu koja je znatno
slabija od odvojene ili dedicated grafiCke kartice.

« Cycles Render De

None CuDa Optix HIP oneAPL

B no compatible GPUs found for Cycles
Requires NWVIDIA GPU with compute capability 3.0

Slika 152. Nije pronadena Nvidijina graficka kartica

Nasuprot tome, na slici nize, gdje se koristilo stolno racunalo s opremom
koja je viSe namijenjena za renderiranje te ima ugradenu Nvidijinu
grafi¢ku karticu, pokazuju se kompatibilni procesori kao opcije. Moguce
je koristiti grafiCku karticu i procesor simultano za renderiranje te je
potrebno je oznaditi obje opcije. U odredenim situacijama koristenje
oboje moze ubrzati proces renderiranja, naj¢es¢e ako se radi o sporijoj
grafi¢koj kartici i brzem procesoru, U tom scenariju isplati se koristiti
oboje. Generalno, GPU je znatno brzi od CPU-a za ovaj tip zadataka te
se pokazalo da je kontraproduktivno kada rade zajedno jer CPU zna
usporiti proces.

Kada je GPU brzi od CPU-a kod kombiniranog renderiranja, moze dodi
do CPU bottlenecka. To se dogada kada CPU ne moze dovoljno brzo
obraditi i poslati podatke GPU-u, zbog ¢ega GPU mora ¢ekati da CPU
zavrsi svoje zadatke prije nego $to moze nastaviti s renderiranjem. Mora
se napomenut da u slu¢aju kada se renderira samo GPU-om, CPU i
dalje ima kljuénu ulogu, ali je ta uloga ograni¢ena.

~ Cycles Render Devices
None CUDA oneAPI

+ NVIDIA GeForce RTX 3060

AMD Ryzen 5 3600 6-Core Processor

Slika 153. Cycles Render Devices postavljeno na CUDA

Za joS brzu i efikasniju obradu moze se odabrati i APl OptiX. Buduci da
je API poput ,mosta“ koji dozvoljava softveru pristup odredenim
funkcijama hardvera, tako OptiX dozvoljava Blenderu pristup RT
jezgrama grafi¢ke kartice, koje su specijalizirane za Ray-Tracing
kalkulacije. Pomoc¢u ovog API-ja moze se znatno ubrzati rendering u
slu¢aju da kartica ima taj tip jezgri.

v Cycles Render Devices
None CUDA oneAPI

+ NVIDIA GeForce RTX 3060

AMD Ryzen 5 3600 6 -Core Processor

Slika 154. Cycles Render Devices postavljeno na OptiX

Unato€ prednostima Cycles renderiranja, jedna od vecih prednosti
renderiranja putem EEVEE je fleksibilnost i mogucnost solidnih rezultata
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koristeci slabije opremljena raCunala, bila rije€ o laptopu ili stolnom
raCunalu. lako ne nudi isti nivo fizicke to¢nosti kao Cycles, EEVEE se
pokazao kao vrlo efikasan za mnoge kreativne procese gdje su brzina i
povratne informacije u stvarnom vremenu klju¢ni. Kao §to se ve¢
spomenulo na poCetku poglavlja, treci render engine odnosno
Workbench engine nije namijenjen za stvaranje finalnih rendera, vec¢ za
pruzanje brzih i jednostavnih pregleda scena kako bi se olak8ao rad na
modelima, tako da ¢e se za daljnja renderiranja koristiti EEVEE
animacija.

6.1. Razlike izmedu EEVEE i Cycles renderiranja

Kako bi se bolje doCarala razlika izmedu EEVEE i Cycles renderiranja,
kratko ¢e se proci kroz postavke koje se koriste za Cycles i EEVEE
rendering te usporediti vrijeme renderiranja ovim dvjema opcijama.
Generalno pravilo je da Cycles namijenjen za detaljnije rendere koji bi
predstavljali izgled finalnog produkta, s viSsom kvalitetom, ali i s duzim
vremenom generiranja slika u usporedbi s EEVEE renderima.
Promatrajuéi opcije i postavke dvaju render enginea, na prvi pogled se
mozZe zakljuciti da su jako sli¢ni. Veéina opcija prisutna je u oba primjera,
no razlika je u postavkama unutar odredenih opcija. Svega par opcija su
identiéne u oba primjera, ostale opcije se podosta razlikuju jedna od
druge. Proéi ¢ée se kroz opcije i postavke za EEVEE render engine u
primjeru kasnije.

&5 Scene

Curves

Simplify

1 Filmic
k  High Contrast

0.200 < sz
Sequencer
1.000
Display
Sequencer  SRGB
Use Curves
Display

Use Curves

Slika 155. Postavke Cyles i EEVEE

Vazna distinkcija izmedu dvaju render enginea je 5to je EEVEE real-time
engine (procesuira scenu u stvarnom vremenu) sliCan onima koji se
koriste u videoigrama. Drugim rije¢ima, EEVEE omogucuje renderiranje
scene u pravom vremenu Koristeci rasterizaciju za prikaz scene.
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Rasterizacija je nacin na koji se veéina videoigara prikazuje. To je
proces u kojem grafiCka kartica ,slaze” scenu u tri dimenzije. Poligoni u
sceni pretvaraju se u 2D tocCke a, zatim se podeSavaju sjen€anjem,
osvjetljenjem, bojama i teksturama. Mana ovog nacela su pogres$ni
svjetlosni efekti. Ova tehnika ne moze pratiti zrake svjetlosti i prikazati
realisti¢nu simulaciju odbijanja svjetlost o razne objekte. Medutim,
EEVEE moze koristiti rasterizaciju zajedno s jednostavnijom verzijom
Ray Tracinga, sli¢no kao Sto videoigre koriste Ray Tracing. Dok je, s
druge strane, Cycles Path Tracing engine koji u potpunosti renderira
scenu koristeéi napredniju verziju Ray Tracinga. Cesto dolazi do
pomutnje vezano za Ray Tracing buduéi da se ve¢inom koristi jedan
izraz za dvije sli€ne, ali razliCite metode renderiranja svjetlosti i sjene.
NiZe su prikazane dvije slike iste scene renderirane koristeci razliCite
render engine. Na prvi pogled razlike nisu velike, no kada se promotri
prva slika, koja predstavlja primjer Cycles renderiranja, vidi se da
svjetlost koja isijava iz objekta ne baca sjenu jer objekt isijava iz svih
smjerova, odnosno sve stranice kocke bacaju svjetlo.

Slika 156. Primjer Cycles rendera

Kod drugog primjera sa EEVEE renderiranjem, unato€ Sto sve plohe
objekta svijetle kao i u primjeru s Cycles, moze se vidjeti da objekt baca
sjene osim kod prednjih stranica kocke, a to je iz razloga Sto EEVEE
koristi ograni¢enu varijantu Ray Tracinga te generira sjene koje nemaju
smisla u stvarnom svijetu. Tu se mogu primijetiti prvi limiti EEVEE
renderiranja. No zato ima prednost brzine generiranja slika i manje
zahtjeve za raCunalo. Bilo je potrebno 35 sekundi da se generira slika
nize, dok je za varijantu Cyles trebalo priblizno 10 min. Odredene
postavke znaju znacajno usporiti proces, tako da su se u primjeru
koristile standardne postavke. O njima viSe u sljedecem dijelu.

Slika 157. Primjer EEVEE rendera
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6.2. EEVEE rendering

Krenut ¢e se s rekreiranjem scene koja je bila koriStena za
demonstraciju razlike izmedu EEVEE i Cycles renderiranja. Kroz
postavljanje i pripremanje scene objasnit ¢e se osnovne postavke za
EEVEE. Zatim, koristeéi tu istu scenu, renderirat ¢e se jednostavna
animacija, gdje ¢e se proci kroz postavke za Outuput Propeties, Cija je
uloga podeSavanje formata i kvalitete animacije ili slike koja se generira.
Otvorit ¢e se jednostavna scena na kojoj su ve¢ postavljeni osnovni
oblici, ali bez aktivnih efekata. 1z mape Vjezbe treba izabrati datoteku
EEVEE_scena.blend na koju ¢e se dodavati efekti i podeSavati opcije i
postavke za EEVEE rendering. Otvaranjem EEVEE_scena.blend
prikazat ée se sljedeéa scena, s kojom e se dalje raditi.

Slika 158. Izgled scene EEVEE_scena.blend

U ovom primjeru, osim $to ¢e se fokusirati na postavke za EEVEE
rendering, prije renderiranja slika ¢e se finalizirati koriste¢i Compositing.
Compositing u Blenderu, kao §to je ranije ve¢ objasnjeno, odnosi se na
proces kombiniranja razli€itih vizualnih elemenata kako bi se stvorila
konacna slika ili animacija. U ovom kontekstu razli€iti slojevi slike (koji
mogu ukljuCivati 3D objekte, pozadine, efekte i druge elemente) spajaju
se u jedan finalni vizual. U Blenderu to se postiZe koristenjem Node
Editora, gdje korisnici mogu povezivati razlicite ¢vorove kako bi
primijenili efekte poput osvjetljenja, boje, zamucenja te kreirali slojevite
kompozicije. Compositing se Cesto koristi u postprodukciji za dodavanje
efekata kao 3to su boje, sjene, svjetlosni efekti, pa ¢ak i specijalni efekti
poput eksplozija, dimnih efekata ili prilagodavanja kontrasta i svjetline,
¢ime se poboljSava vizualni izgled projekta. ViSe o toj fazi kasnije, nakon
Sto se podesi i renderira osnovna slika. Nakon otvaranja datoteke fokus
se prebacuje na kocku u sredini kadra. Potrebno je pritisnuti tipku [0] na
Num Padu na stolnim ra¢unalima ili tipku [0] u retku s brojkama na
prijenosnim racunalima da se prebaci u Camera View. Kada se prebaci
u Camera View, potrebno je selektirati kocku pomoéu [LMS], kojoj ¢e se
dodavati efekti i podeSavati osvjetljenje. Ona predstavlja svijetleci objekt
u sceni. Kada je kocka selektirana, treba oti¢i na Add a new material i
nastaviti dalje prema Material Properties B unutar prozora Propetties,
te pod Surface izabrati Emmision umjesto predefinirane postavke
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Principled BSDF. Zatim se valja prebaciti na Shading workspace tako da
je nize prikazan Shader Editor@. Sada kada je postavljeno sve za

pocetnu fazu, treba prebaciti na Rendered pod Viewport
Shading te bi sucelje trebalo izgledati kao na slici nize:

Slika 159. Izgled otvorene scene kroz Viewport Shading

Kako je postavljeno na Emission, primijeti se ,emisija“, vidi se da kocka
lagano emitira vlastitu svijetlost. Sada je potrebno promijeniti boju, no
prije toga ¢e se dodati jo$ jedan &vor. Efekt ovog ¢vora je donedavno bio
EEVEE opcija, no sada je uklonjena te je dostupna kao &vor, a to je
Ambient Occlusion. Kratica [Shift] + [A] te zatim pod Input > Ambient
Occlusion spojite s uti¢nicom Color &vora Emission. Uti¢nice Color
¢vorova se spajaju. Ambient Occlusion je tehnika koja simulira
ponasanije svjetlosti u stvarnom svijetu, posebno kada se nalazi u
zatvorenim prostorima ili blizu objekata. Dodaje suptilne sjene tamo gdje
se svjetlost tesko probija, primjerice u kutovima, ispod objekata ili na
mjestima gdje se objekti nalaze jedan blizu drugoga. Kada je spojen
¢vor Ambient Occlusion, potrebno je promijeniti postavku Color na
njemu. Hue treba postaviti na vrijednost 0.5 te Saturation na 0.95 kako
bi se dobila tirkizna boja. Treba postaviti Strength vrijednost ¢vora
Emission na 4. Ambient Occlusion ima postavku Samples, koja odreduje
broj uzoraka koji ¢e biti koristeni za Ray Tracing. Sto je veéa vrijednost,
to su vedi zahtjevi za raCunalo. Preporucuje se drzati nizih vrijednosti. U
primjeru ¢e biti postavljeno na 6. Nize je prikazano kako bi trebalo
trenutno izgledati.
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Slika 160. Ambient Occlusion postavke

Sljedeci korak je prikaz postavki za EEVEE rendering. Nize su prikazane
unaprijed podeSene postavke koje ¢e biti koristene u ovom primjeru. Prvi
crveni okvir prikazuje Sampling postavke. Odreduje koliki broj uzoraka
odnosno svjetlosnih zraka ¢e biti koristeno po pikselu. Ray Tracing
funkcionira tako Sto simulira putanje svjetlosnih zraka koje krecu iz
kamere, prolaze kroz svaki piksel i sudaraju se s objektima u sceni.
Kada zraka udari u objekt, algoritam izraCunava kako se svjetlost
reflektira, lomi ili apsorbira na toj povrsini. Ovaj proces omogucava
generiranje realisti¢nih sjena, refleksija i refrakcija. Sto je veéi broj
uzoraka, to je viSa kvaliteta renderirane slike.

Sampling ima postavku za broj uzoraka za preglednik dok se priprema
scena pod Viewport > Samples i za renderiranje kada je scena
spremna pod Render > Samples, tako da to treba imati na umu prije
nego Sto se krene generirati slika. Do 300 uzoraka sasvim je dovoljno za
kvalitetnu sliku, vece vrijednosti znatno povecavaju vrijeme renderiranja
s minimalnim pobolj$anjima, pogotovo kod jednostavnijih scena. Pod
Viewport ukljuena je i postavka Temporal Reprojection, koja smanjuje
Sum pri kretanju kroz scenu i tijekom pokretanja animacija. U sliede¢em
crvenom okviru postavka Shadows omogucuje generiranje sjena. Treéi
crveni okvir obuhvaca postavke za Ray Tracing. Kada je ukljucen,
omogucuje dodatne postavke. Method omogucuje biranje Ray Tracing
metoda, postavljen je na Screen-Trace kao postavku. To je metoda koja
se Koristi za izraCunavanje odredenih efekata kao Sto su refleksije i
sjene koristec¢i informacije koje su ve¢ prikazane na ekranu. Ova metoda
analizira piksele. Svaki piksel ima odredenu vrijednost dubine koja
predstavlja udaljenost tog piksela od kamere, koja je vidljiva u trenutnom
okviru i koristi te informacije kako bi generirala refleksije, sjene ili druge
efekte bez potrebe za dodatnim sloZenim izraunima u cijeloj sceni.
Resolution se odnosi na prostornu rezoluciju na kojoj se izvode Ray
Tracing izraCuni tijekom renderiranja. Ako je, primjerice, kona¢na
rezolucija rendera 1920 x 1080 piksela, s postavkom 1:2 ¢e se izraCuni
raditi na 960 x 540 piksela. Svrha je brze renderiranje sa §to manjim
gubicima na kvaliteti. Kada je uklju¢ena postavka Denoising, pridonosi
smanjenju Sum kod Ray Tracing efekata.
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Render Engine EEVEE

~ Sampling

~ Viewport
Samples 300
« Temporal Reprojection
Jittered Shadows
~ Render
Samples
> & Shadows
> Advanced
2 Clamping
“|o Raytracing
Method  Screen-Trace
Resolution  1:2
> Screen Tracing

> ¥ Denoising

> | Fast GI Approximation

Slika 161. Render Properties

Postavke su spremne te se prelazi na Compositing Nodes Editor ()
Ponovno ¢e se Koristiti efekt Bloom, koji je dostupan putem Compositing
Cvora Glare. Compositor ¢e se otvoriti umjesto File Browser prozora u
lijevom kutu sucelja. File Browser sluzi za brzi pristup datotekama, no
sada nije potreban, pa ¢e se umjesto njega postaviti Compositor.

B View Select

pting

*3* Dope Sheet i TextEditor
0 Timeline Python Console

>/ Graph Editor B Info

A~ A
¢ Drivers

-I2 Nonlinear Animation

Slika 162. Postavljanje na Compositor umjesto na File Browser

U prozor Compositor ¢e se prvo dodati Evor Glare kraticom [Shift] + [A]
te se izabere Filter > Glare, ¢vor koji se koristi za dodavanje odsjaja
le¢a, magle i sjajeva oko svijetlih dijelova slike. Zatim se dodaju ostali
¢vorovi koji su potrebni u stablu &vorova, Output > Composite Cvor je
mjesto gdje se stvarni izlaz iz kompozitora povezuje s rendererom. Ovaj
¢vor azurira se nakon svakog renderiranja, ali takoder odraZava
promjene u stablu ¢vorova (pod uvjetom da je povezan barem jedan
zavrSeni ulazni ¢vor). Output > Viewer, omogucuje priviemeni prikaz
podataka ¢vorova. MozZe se prikljuciti bilo gdje kako bi se pregledala
slika u stablu ¢vorova. Input - Scene - ¢vor Render Layers Cita
slojeve renderiranja i prolaze iz scene u graf ¢vorova za kompoziciju.
NiZe na slici prikazano je stablo ¢vorova i pravilan nacin spajanja za
Zeljeni efekt. Cilj je pojacat bljestavilo renderirane kocke. Cvor Glare ima
nekoliko tipova bljestavila odnosno Glare Type od kojih ¢e se odabrati
opcija Bloom koja rasprsuje vrlo svijetle piksele opona$ajuci artefakte
le¢a pravih kamera. Unato€ postavkama za sada se ne vidi efekt. Da bi
se to omogudilo, ovaj put ée se upotrijebiti Render Active Scene na
¢voru Render Layers i pritisnuti na Backdrop kako bi se u pozadini
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prozora Compositor pojavilo trenutno stanje renderirane slike nakon
primjene postprodukcijskih efekata. Obe opcije prikazane su nize na slici
unutar crvenih okvira.

pha

/- Image
®  Alpha

Highlights ®

 Render Layers
ender Layers @ Bloom 2 ¥ Use Alpha

Image 0\ % ® Image
Alpha ® -
p o ® Alpha

Slika 163. Postavljanje pozadine u prozoru Compositor

Nakon aktivacije navedenih opcija iznad ¢vora Render Layers Ce se
pojaviti slika renderirane scene koja ¢Ce se koristiti kao osnova na kojoj
se primjenjuju daljnje promjene, dok se u pozadini prikazuje trenutno
stanje dorade slike nakon $to su se promjene primijenile. Cvor Viewer
omogucuije tu opciju, da se moze u pravom vremenu pratiti promjene na
renderirangj slici prikazanoj iznad &vora Render Layers.

|[d. = & UseNodes Backdrop v 9 @ -

&5 Scene > 2 Compositing Nodetree

v Composite

[ v Glare | ¥ Use Alpha
Image @——® Image
Glare ® ® Alpha 1.000

1
Highlights @
|

~ Render Layers L0 Bloom v Viewer
0ol v

Image @==N Medium 5 + Use Alpha
< ® Image

~ Highlights ® Alpha 1.000

Threshold 0.600
Smoathn... 1.000
Maximum 0.000
> Adjust
> Glare

Slika 164. Prikaz pozadine u prozoru Compositor

Glare postavke Ce se ostaviti kakve jesu. postavka Quality ima opcije od
Low do High. Ako je postavljeno na Low ili Medium, efekt ¢vora
primjenjuje se na kopiju originalne sliku nize rezolucije za razliku od
postavke High. Medium se pokazao kao dovoljno dobar, iako nije
problem ni postaviti na High. Razlika u renderiranju nije znacajna jer se
radi o jednostavnijem primjeru. Na kompleksnijim scenama razlika bi
mogla biti znac€ajnija. postavka Mix je dosta korisna jer daje fleksibilnost
kombiniranja izmedu originalne slike, koju predstavlja vrijednost -1, te
vrijednost 1, koja predstavlja samo dio slike na kojoj je primijenjen efekt
Bloom. Vrijednost 0 je ravhomjerna kombinacija tih dviju varijanti slika.
Mix ostaje na vrijednosti 0. Postavka Threshold je poput filtera, nize
vrijednosti Cine bljeStavilo jacim, dok viSe vrijednosti priguSe to
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bljeStavilo. Postavlja se na vrijednost 1. Size odreduje koli¢inu
bljeStavila. Moguce je postaviti vrijednosti od 1 do 9. Ostavit ¢e se
zadana vrijednost 8.

Zadnji efekt u ovom primjeru ¢ée simulirati izobli¢enje koje proizvode
kamere dodavanjem &vora Lens Distortion. Lociran je pod Transform
- Lens Distortion, a postavlja se izmedu ¢vorova Render Layers i
Glare. Od postavki za taj ¢vor podesit ¢e se Distortion i Dispersion.
Podesavanjem Distortion ili distorzije stvara se efekt ispup&enja ako je
vrijednost veca od nule ili stiskanja iz sredista slike ako je vrijednost
manja od nule. Dispersion ili disperzija simulira kromatske aberacije
(efekt optiCke le¢e kada ne moze fokusirati svjetlost razli¢itih boja) gdje
se razli¢ite valne duljine svjetlosti lome malo drugacije stvarajuéi rub u
duginim bojama. Postavit ¢e se Distortion na -0.3., primjerice, da bi se
prikazalo ,stiskanje” slike iz srediSta slike, te Dispersion na 1 da bi se
postigla kromatska aberacija stvaranje ruba u duginim bojama. NiZe na
slici prikazani su svi ¢vorovi sa svojim postavkama.

~ Lens Distortion A (3 1.000

Image ©N
w Render Layers \
Projector
Jitter
age

® Alpha 1.000

Slika 165. Ubacen cvor Lens Distortion sa svojim postavkama

Kao zadniji korak prije renderiranja finalne verzije slike treba se proéi
kroz postavke unutar Output Properties Hunutar prozora Propetties,
gdje se nalaze postavke za format i kvalitetu slike. Pod Resolution
treba ostaviti zadanu rezoluciju od 1920 x 1080px uklju€ujuéi ostale
postavke pod Format. Pod Output linija gdje piSe /tmp\ predstavlja
Output Path te sluzi za odredivanje putanje prema mapi za spremanje
renderiranih materijala. File Format sluzi za odabir formata datoteke za
spremanije. Ovisno o tome koji format koristite dostupne su i druge
opcije poput modela boja, dubine boje (engl. color depth ili bit depth) i
razine kompresije. Pod format ¢e se ostaviti PNG. Color Depth ostaviti
na 8 bita te vrijednost pod Compression ostaje na 15 %. Kada je
postavljeno na 0 %, najveca je kvaliteta slike, ali tako zauzima najvise
memorije.
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~ Format
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Slika 166. Postavke Format i Output

Postavke su spremne te je samo potrebno pokrenuti renderiranje slike.
Provjerite jo$ jednom jesu li sve postavke unesene kao prema primjeru.

Za renderiranje aktivne scene treba odabrati Render > Render Image
prikazano niZe na slici.
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View Render

View Animation
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Slika 167. Render Image
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Osnove rada u 3D grafickom alatu Blender (oznaka tecaja)

Sada treba pri¢ekati da se pojavi rezultat renderiranja, prosjek je ispod
60 sekundi, ovisno o racunalu. Finalni produkt nakon renderiranja trebao
bi izgledati kao na slici niZe.

Slika 168. Finalni render
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6.3. Vjezba: SvijetleCi objekt s efektom

Zadatak &e se bazirati prema prijaSnjem primjeru, no ovaj put ¢e se
koristiti drugacije postavke:

1.

Ponovno otvorite datoteku EEVEE_scena.blend te odaberite
Shading workspace i prebacite na Rendered EL I

Selektirajte kocku koja je u sredini kadra. Zatim na Material
Properties ] dodajte novi materijal, odnosno Add a new
material te pod Surface odaberite Emission. U prozoru nize, gdje
je otvoren Shader Editor © , pojavit ¢e se ¢vorovi Emission i
Material Output. Dodajte Evor Ambient Occlusion kraticom [Shift]
+ [A], lociran pod Input > Ambient Occlusion. Cvorove Ambient
Occlusion i Emission spojite preko Color uti¢nica.

Na ¢&voru Ambient Occlusion, pod Color, postavite Hue na
vrijednost 0.75 i Saturation na vrijednost 0.95. Ostale postavke
nije potrebno mijenjati. Na &voru Emission postavite Strength na
vrijednost 4.

U lijevom prozoru, gdje je trenutno File Browser, prebacite na
Compositor. Unutar prozora Compositor dodajte ¢vorove u
sljedecem redoslijedu: Input > Scene > Render Layers, Filter
- Glare, Output > Composite, Output > Viewer. Cvorove
Render Layers i Glare spojite putem Image utiCnica te s druge
strane ¢vora Glare, spojite Cvorove Viewer i Composite koristedi
utiCnicu Image. Na ¢voru Glare pod Glare Type postavite Bloom
umjesto zadanog Streaks. Pod &vor Render Layers pritisnite
Render active scene [E] i nakon kratkog ¢ekanja trebala bi se
pojaviti mala slika rendera scene iznad ¢vora. Zatim pritisnite
Backdrop, lociran na traci Compositora, kako bi se u pozadini
prozora pojavila slika trenutnog stanja scene sa dodanim
efektima.

Potrebno je dodati zadnji &vor, Transform - Lens Distortion, te
ga postaviti izmedu Render Layers i Glare ¢vorova, koristeci
Image utiCnice. Na Lens Distortion, postaviti Distortion na 0.3 da
se postigne efekt laganog ispupcenja slike i Dispersion na 0.6, te
staviti kvacicu na Fit tako da se skalira slika na nacin da nisu
vidljivi crni rubovi.

Pod Render properties na Sampling - Viewport > Samples
i Sampling > Render »> Samples postavite vrijednost 250, a
pod Ray Tracing—> Resolution stavite na 1:1. Ostale postavke
ostaju iste.
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7. Provjerite sve postavke te pritisnite Render > Render Image.
NiZe je prikazana slika finalnog rendera.

Slika 169. Finalni render vjezbe 6.3.
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/.Renderiranje animacija

Po zavrsetku ovoga poglavija moci Cete:
¢ renderirati animacije
e izradivati animacije s tekstom
o koristiti Evorove Noise Texture i Color Ramp

e koristiti Svorove Mesh Line i Instance on Points.

Renderiranje animacija u Blenderu moZe biti zahtjevan proces, ali
Blender nudi veliku fleksibilnost zahvaljuju¢i ve¢ spomenutim razli€itim
rendererskim pogonima kao $to su Cycles i EEVEE, ovisno o potrebama
odredenog korisnika i vrsti zadatka. Za sada je bilo rijeCi samo o
renderiranju slika scene, a za animacije postoje dodatne postavke koje
se trebaju uzeti u obzir. Na slici nize prikazan je prozor Output
Properties te se unutar prvog okvira pod File Format vide dvije
kategorije, Image i Movie. Image, kao $to rije¢ sugerira, predstavlja
formate za renderiranje slika, no pod Movie se nalazi samo FFmpeg
Video, format koji Ce se koristiti za renderiranje animacija. Unutar
drugog okvira pod Encoding - Container je datotecni format koji
“pakira” i pohranjuje video, audio i ostale elemente (kao §to su titlovi i
metapodaci) u jednu datoteku. U ovom slu¢aju samo video. Svaki od
formata pod Container ima specificne karakteristike i koristi se u razli€ite
svrhe. Par primjera i njihove karakteristike:

e Matroska (MKV) je fleksibilan i svestran format koji podrzava
visoku kvalitetu slike i zvuka te moze pohraniti razliite vrste
podataka u jednoj datoteci. MoZe drzati viSe audio- i videozapisa,
titlove i metapodatke, sve u jednoj datoteci. Cesto se koristi za
streaming, arhiviranje i projekte u kojima je Zelja zadrzati razliCite
verzije audio- ili titlovanih zapisa zajedno s videom.

o MPEG-4 (MP4) jedan je od naj¢esc¢e koristenih formata u
digitalnim medijima zbog Siroke kompatibilnosti i efikasne
kompresije. Zadrzava dobru kvalitetu uz malu veli€inu datoteke,
§to ga Cini popularnim izborom za online distribuciju (npr.
YouTube). Najbolji izbor za dijeljenje videozapisa na internetu ili
za projekte gdje je potrebna manja datoteka bez prevelikog
gubitka kvalitete.

o AVI (engl. Audio Video Interleave) je stariji format koji se koristi
veé dugo u videoindustriji. Omogucava visoku kvalitetu slike, ali
datoteke mogu biti ve¢e zbog manje efikasne kompresije. Koristi
se za projekte gdje je kvaliteta vaznija od veli€ine datoteke, ili za
rad s formatima koji su kompatibilni sa starijim uredajima i
softverima.

¢ QuickTime (MOV) je format koji je razvio Apple, primarno za rad
s njihovim uredajima i softverom. Visoke je kvalitete te se Cesto
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koristi u profesionalnim filmskim i TV projektima, kao i na
Appleovim platformama.

Za najSiru kompatibilnost i uobi¢ajenu upotrebu MPEG-4 je najbolji izbor
jer se moze reproducirati na gotovo svim uredajima i platformama. Ako
je cilj kvaliteta, primjerice u profesionalnoj industriji, QuickTime (MOV) je
mozda bolji izbor, dok je MKV najbolji za projekte s viSe audiozapisa ili
zapisa s titlovima.

Unutar zadnjeg okvira pod Video - Video Codec postoji nekoliko
razliCitih videokodeka za renderiranje animacija, sa svojim specifi¢nim
namjenama i prednostima. Kodek je algoritam koji se koristi za
kompresiju i dekompresiju audio- i videopodataka te odreduju nacin na
koji su video- i audiopodaci komprimirani unutar datoteke. Nize su
najCesce koristenih kodeci i njihova svrha:

o H.264 je najpopularniji i najéesce koristen videokodek za opcu
upotrebu. Omogucéava visokokvalitetnu kompresiju koja zadrzava
dobru sliku uz relativno malu veli€inu datoteke, Sto je idealno za
dijeljenje videozapisa online. Koristi se za stvaranje videozapisa
koji Ce se gledati na uredajima ili objavljivati na platformama
poput YouTubea. Dobar izbor za manju veliinu datoteke bez
Zrtvovanja previSe kvalitete.

e MPEG-4 (divx) je standard koji koristi H.264 kao primarni kodek,
ali Cesto se odnosi na stariju verziju H.263, koja nije toliko
ucinkovita. Manja kompatibilnost s modernim uredajima u
usporedbi s H.264, ali ipak solidna kvaliteta za osnovne projekte.
PreporuCuje se za starije sustave ili projekte gdje nije klju€na
visoka kvaliteta slike, nego je vaznija Siroka podrSka uredaja.

¢ QuickTime Animation je nekomprimirani (engl. lossless) ili
gotovo nekomprimirani kodek unutar containera QuickTime
MOV, dizajniran za zadrzavanje §to vece koli€ine informacija u
videu, bez uobicajenih gubitaka koje donosi kompresija.
Pogodan je za profesionalnu postprodukciju, kada je potrebna
visoka kvaliteta slike i kada su boje i detalji presudni, kao u
animacijama, 2D i 3D vizualima, grafickom dizajnu i radu s
efektima.

¢ AV1 je videokodek otvorenog koda razvijen od strane Alliance for
Open Media, organizacije u kojoj su sudjelovali Google, Netflix,
Amazon i drugi tehnolo$ki giganti. Dizajniran je da bude
besplatan za koriStenje bez licencijskih troskova, s naglaskom na
vrlo u€inkovitu kompresiju i visoku kvalitetu slike. Pruza bolju
kompresiju od H.264 i H.265/HEVC, Sto znaci da stvara manje
datoteke uz zadrzavanje visoke kvalitete. AV1 je sve popularniji
za online streaming i distribuciju visokokvalitetnog sadrzaja jer
omogucava prijenos HD, 4K, pa ¢ak i 8K videa uz manju
potrosSnju podataka. YouTube i Netflix ve¢ koriste AV1 za
streaming na odredenim uredajima i preglednicima.
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Za animacije za online distribuciju ili op¢u upotrebu H.264 obic¢no je
najbolji izbor zbog balansa kvalitete i veli€ine datoteke. Za profesionalne
projekte ili dodatnu post produkciju, QuickTime Animation moze biti bolji
zbog kvalitete koju nudi. Za potrebe ovoga teCaja H.264 bit ¢e idealan
izbor, te ¢e se koristiti kod daljnjih zadataka. Ispod Video Codec
postavke, joS se moZe dodatno podesiti omjer brzine i kvalitete,
odabirom drugadijih razina kvalitete pod Output Quality. Izbor ide od
Lowest Quality, Sto predstavlja najnizu kvalitetu, ali s malom veli¢inom
datoteke. Opcija Lossless je najkvalitetnija i sa znacajnom razlikom u
veliini datoteke. Razlika u vremenu renderiranja je zanemariva $to se
tice razli¢itih odabira kvalitete, tako da je fokus na kompromisu izmedu
kvalitete slike i veliCine datoteke. High Quality se pokazao kao najbolji
izbor jer zna€ajno smanjuje veli€inu datoteke uz minimalan gubitak u
kvaliteti slike u usporedbi s opcijom Lossless.

Output

C:Atmp\
Saving & File Extensions
Cache Result
File Format @ FFmpeg Video
Coleor BW
» Color Management

+ Encoding

Container Matroska

Autosplit Output

Videc Codec  H.264
Output Quality Medium Quality

Encoding Speed Good

Keyframe Interval

Max B-frames

Slika 170. Postavke za File Format, Encoding i Video

Za renderiranje animacija, kao i za renderiranje slika, nastavit ¢e se
koristiti EEVEE kako bi se dobio solidan rezultat u to kracem vremenu.

7.1. Animiranje teksta i dodavanje efekata

Osim osnovnih oblika koji su dostupni u Blenderu, moguce je
manipulirati tekstom, koji dopusta razne zanimljive efekte koristeci
¢vorove. Uz veC poznate Cvorove koji su se koristili u prijasnjim
primjerima, u ovom primjeru ¢e se ukomponirati dodatni &vorovi koji su
idealni za viSe kreativne i apstraktne efekte. Prije nego $to se krene s
primjerom, ukratko ¢e se objasniti novi ¢vorovi koji Ce se Koristiti,
pocevsi od najzanimljivijeg ¢vora — Noise Texture.

Noise Texture u Blenderu je &vor koji generira uzorak buke, koji se moze
koristiti za stvaranje tekstura koje izgledaju nepravilno i prirodno. Vrlo je
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koristan za dodavanje varijacija i realistiCnih detalja materijalima kao Sto
su kamen, drvo, oblaci, koza i sli¢no.

Klju€ne postavke Cvora Noise Texture:
Dimenzije (2D, 3D, 4D):
o 2D: Koristi samo x- i y-0s, §to je dovoljno za ploSne teksture.

e 3D: Koristi x-, y- i z-0s omogucujuci viSe dubine i
trodimenzionalan izgled.

o 4D: Dodaje vrijednost W koja mijenja varijacije buke. Promjenom
vrijednosti W zapravo se ,putuje“ kroz beskonaéne varijacije
uzorka buke, Sto omogucuje da se uzorak dinamicki mijenja.

Scale: Kontrolira veli€inu uzorka buke. Veca vrijednost smanjuje Sare i
¢ini ih manjima, dok manja vrijednost stvara vece oblike u uzorku buke.

Detail: Kontrolira koli€inu finih detalja u teksturi. ViSa vrijednost dodaje
sitnije varijacije, dok niza stvara glatkiji izgled.

Distortion: Ova postavka stvara efekt savijanja ili pomicanja uzorka
buke dajuéi mu organski i nepravilan izgled. Koristi se za prirodne
materijale kao $to su voda i oblaci.

Roughness : Ova postavka utje€e na glatkocu ili hrapavost prijelaza u
teksturi. Manja hrapavost daje mekSe prijelaze, dok vec¢a hrapavost
stvara ostrije granice izmedu tamnijih i svjetlijih dijelova.

Normalize: Kontrolira kontrast buke i utjeCe na izlazne vrijednosti. Moze
ga se iskljuciti tako da se ukloni kvacica.

Cvor se moze izabrati pod Texture> Noise Texture. NiZe na slici je
prikazan izgled ¢vora Noise Texture:

~ Noise Texture

3D
TEM

»f Mormalize

le 5.000
Detail 2.000

Roughn... 0.500

Lacunarity 2.000
Distortion 0.000

Slika 171. Noise Texture cvor

Noise Texture moze se koristiti u kombinaciji s drugim ¢vorovima kako bi
se dodatno prilagodio izgled, primjerice s Converter-> Color Ramp koji
moze promijeniti boje unutar uzorka buke stvarajuci sloZenije materijale.
Cvor Color Ramp sluzi za prilagodbu i manipulaciju boja teksture ili
uzorka omogucujuci stvaranje prijelaza izmedu razli€itih boja ili
podeSavanije kontrasta i nijansi. Ovaj ¢vor vrlo je koristan kod kontrole
kako se boje ili tonovi prikazuju na nekoj povrSini. Na slici nize vide se
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kliza€i koji predstavljaju toCku na rampi s odabranom bojom. Moguce je
dodavati nove klizaCe, mijenjati boje i postavljati njihovu poziciju kako bi
se stvorio prijelaz po Zelji. Povlacenjem klizac¢a lijevo i desno mijenja se
poloZaj boje u prijelazu. To omogucéuje preciznu kontrolu nad tim gdje i
kako se boje mijeSaju. Nacini na koje se boje mijeSaju mogu biti Linear
(linearno mijeSanje boja), Ease (ublazeno mijeSanje), Constant (nagla
promjena izmedu boja bez prijelaza).

~ Color Ramp

Color @

Alpha ®

. ¥ L | near
a2
0.000

0.500

Slika 172. Color Ramp c¢vor

Cvorovi Noise Texture i Color Ramp zajedno mogu stvarati jako
zanimljive uzorke na teksturama i izbor varijacija je realno neogranicen.
Na slici nize je primjer uzorka koji se moze posti¢i ovom kombinacijom
¢vorova.

Slika 173. Primjer uzorka stvorenog s ¢vorovima Noise Texture i Color Ramp

Za primjer s tekstom treba prvo otvoriti novu scenu pod File> New->
General te obrisati default kocku jer necée biti potrebna kada se ubaci
tekst. Dodavanije teksta u scenu radi se na istom nacelu kao i s ostalim
osnovnim objektima, [Shift] + [A] te se odabere Text. Za bolji pregled
potrebno se prebaciti u Top View pritiskom na tipku [7] na Num Padu te
prebaciti u Shading workspace. Treba provjeriti da je tekstualni objekt
selektiran te ¢e se s desne strane preglednika unutar Properties
prozora, pojaviti Object Data Properties [l ikona s postavkama za
doradu i pozicioniranje teksta. Na slici nize vidi se dodani tekst te
postavke koje ¢e se podeSavati s desne strane, podijelijene na dva
crvena okvira. U prvom okviru su postavke Font, koje omogucéuju odabir
fonta za osnovne varijante ili stilove fonta. Baza fontova je ograni¢ena
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na izbor koji je na racunalu. Moguce je odabrati font po Zelji pritiskom na
ikonu Open Font, koja otvara listu dostupnih fontova. U ovom primjeru
koristit e se zadani font.

Sljedeci okvir sadrzi postavke Paragraph koje omogucuju kontrolu nad
nacinom poravnanja i raspored teksta u odlomku. Opcija Alignment,
omogucava poravnavanje teksta unutar objekta pomocu dviju postavki,
Horizontal Alignment i Vertical Alignment. Ove postavke odreduju
poravnavanje teksta u horizontalnom i vertikalnom smjeru. Pod
Horizontal Alignment postoje sljedece opcije:

e Left: Poravnava tekst uz lijevu stranu okvira.

e Center: Centrira tekst unutar okvira.

¢ Right: Poravnava tekst uz desnu stranu okvira.

e Justify: Razvlaci tekst tako da popuni cijeli redak.

¢ Flush: Tekst se prilagodava tako da se svaka linija u okviru
popuni ravhomjerno, osim zadnije linije, s efektom sli¢nim justify
opciji, ali s dodatnom prilagodbom.

Pod Vertical Alignment izbor je sljedeci:
e Top: Poravnava tekst uz gornji rub okvira.

e Top Baseline: Poravnava tekst prema bazic¢noj liniji pri vrhu
okvira.

e Middle: Centrira tekst vertikalno unutar okvira.
¢ Bottom: Poravnava tekst uz donji rub okvira.

o Bottom Baseline: Poravnava tekst prema bazi¢noj liniji pri dnu
okvira.

Horizontal Alignment treba postaviti na Center, a Vertical Alignment na
Middle da se centrira tekst radi preglednosti i lakSeg rada s tekstom.

Nakon podesSavanja Alignment postavki, joS preostaju Spacing postavke
koje sluZze za namjeStanje razmaka. Character Spacing postavlja
horizontalni razmak medu slovima, Word Spacing postavlja horizontalni
razmak medu rije€ima, dok Line Spacing odreduje vertikalni razmak
medu linijama teksta unutar tekstualnog objekta. Offset X i Y sluze za
vertikalni i horizontalni pomak teksta upisujuci vrijednost. Za sada ove
postavke ostaju po zadanim vrijednostima. Tekst je moguce uredivati
tako da se selektira i pritisne tipka [Tab].
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Slika 174. Postavke za tekst

Tekst je pozicioniran i postavke su podesene te je cilj ovog primjera
prikazati kako se moze sloziti animacija s tekstom u kojoj se tekst podize
prema kameri, koristeci kopije koje se slazu poput slojeva te se penju
pod odredenim kutom i simultano se razmak medu slovima povecéava.
Tekst ¢e takoder imati teksturu s uzorkom koji ¢e se sastojati od dviju
boja te ¢e se taj uzorak mijenjati kroz kadrove koristeci Evor Noise
Texture.

U Shader Editoru treba dodati novi materijal te ubaciti cvorove Noise
Texture i Color Ramp te spajiti utiCnicu Color, lociranu na ¢voru Noise
Texture s utiCnicom Fac na ¢voru Color Ramp. Zadani ¢vor Principled
BSDF treba ukloniti te spojiti Material Output s dvama dodanim
¢vorovima. Zatim treba podesiti postavke Noise Texture tako da se
ukloni kvacica s Normalize koji kontrolira kontrast buke i utjeCe na
izlazne vrijednosti generirane razli¢itim tipovima buke, primjerice fBM
(engl. Fractal Brownian Motion) koiji je postavljen kao zadani tip. U ovom
primjeru koristit ce se fBM tip buke. Broj dimenzija treba postaviti na 4D
umjesto 3D, vrijednost Scale postaviti na 2 i Detail na vrijednost 1.
Ostale postavke ostaviti kakve jesu.

Zatim na ¢voru Color Ramp treba podesiti dvije boje. Potrebno je
selektirati prvi klizag, koji je trenutno crne boje, te pritisnuti na crnu liniju,
koja predstavlja trenutni odabir boje tog kliza¢a. Potrebno je podesiti na
Hue (0.7), Saturation (0.95), Value (1.0), a Alpha ostaviti kako jest da bi
se dobila ljubi¢asta boja. Drugi kliza&, koji je bijele boje, podesiti na Hue
(0.40), Saturation (0.99), Value (1.0) i vrijednost Alpha takoder ostaje
ista da bi se dobila nijansa zelene boje. Ljubi€asti kliza€ ostaje na istom
mjestu, dok ¢e zeleni kliza€ mijenjati poziciju. Pozicija se moze mijenjati
manualno koristeci drag and drop po rampi ili tako da se selektira klizac i
upiSe vrijednost unutar Set Position. Potrebno je upisati vrijednost 0.4.
Na slici nize su postavke za ¢vorove Shader.
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Text > @ Material.003

v Noise Texture
+ GolorRamp

Alpha @

fBM G + Linear «

Nomalize E Displacement
Vector 0400 @ Thickness
W 0.000
Scale 2.000
Detail 1.000
Rovghn.. 0.500
Lacunarity 2.000
Distortion 0.000

Slika 175. Postavke za cvorove Noise Texture i Color Ramp

Umjesto File Browsera na lijevoj strani treba otvoriti Geometry Node
Editor i dodati novu grupu ¢vorovaEEESIIEEE- U Geometry Editor
Ce se dodati novi Evorovi koji ¢e omoguciti instanciranje, odnosno
stvaranje kopija objekta, u ovom slucaju teksta, i to po odredenoj liniji.
Prvo ¢e se dodati Mesh—> Primitives—> ¢vor Mesh Line koji je zaduZen
za stvaranje imaginarne linije koja se sastoji od to¢aka. Svaka toCka
predstavlja poziciju jedne kopije objekta. Broj to¢aka odreduje se
postavkom Count te ¢e se podesiti, primjerice, na vrijednost 80 buduci
da je potreban vedéi broj da bi se postigao Zeljeni efekt. Start Location
ostaje nepromijenjen, on predstavlja poziciju prve tocke. Offset
vrijednosti trenutno ostaju kakve jesu, one kontroliraju u kojem ce se
smjeru formirati linija i kolika je udaljenost izmedu to€aka. Sada se moze
dodati Instances—> ¢vor Instance on Points, koji se spaja putem svojeg
Points prikljucka s prikljuckom Mesh &vora Mesh Line tako definirajuci
toCke na kojima Ce se instance odabranog objekta pozicionirati. Na
priklju¢ak Instance ¢vora Instance on Points spaja se objekt koji se Zeli
kopirati. Spojit ¢e se &vor Group Input jer on predstavlja objekte na
sceni, odnosno tekst. Da bi sve radilo i rezultat bio vidljiv, jos je potrebno
spojiti izlazni priklju¢ak Instances s ¢vorom Group Output. Postavke za
¢vor Instance on Points nije potrebno mijenjati. Nize na slici prikazan je
poredak ¢vorova i njihove postavke.

~ Mesh Line
~ Instance on Points

Instances

1.000
1.000
1.000

Slika 176. Poredak ¢vorova Mesh Line i Instance on Points

Svi su ¢vorovi postavljeni i podeseni, jo$ je potrebno podesiti kameru da
bi animacija teksta bila u potpunosti uhvaéena. Treba selektirati kameru,
podesiti vrijednosti pod Location, X=0.5m,Y=04m,Z=6.5te
vrijednosti Rotation sve postaviti da iznose 0. Na slici nize prikazan je
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pregled scene kroz kameru kada se pritisne tipka [0] buduéi da se treba
gledati odozgo.

Slika 177. Pozicioniranje kamere

Uzorci u bojama vidljivi su na povrsini teksta, znaci da sve radi kako je
namijenjeno. Jos preostaje animirati tekst koriste¢i Keyframes, odnosno
kljuéne kadrove. Radi preglednosti treba otvoriti prozor Timeline umjesto
Image Editora u donjem lijevom kutu, prilagoditi Sirinu prozora po volji i
odrediti da je End, koji predstavlja finalni kadar, postavljen na 125, da se
broj kadrova smaniji za pola jer toliki broj neée biti potreban sa ovu
animaciju i Zeli se ustediti na vremenu renderiranja. PocCet Ce se s
postavljanjem klju¢nih kadrova za ¢vor Noise Texture, kao i u prijasnjim
primjerima treba definirati referentni kljuéni kadar, tako da se pozicionira
Playhead ili plava vertikalna linija na kadar 0 te se pritisne tipka [l] iznad
vrijednosti W, Scale i Distortion. Zatim pod Object Data Properties pod
Spacing—> Character Spacing treba takoder ubaciti keyframe. Na &voru
Mesh Line, pod Offset potrebno je ubaciti kljuéni kadar za svaku
vrijednost. NiZe na slici prikazane su sve lokacije na kojima su potrebni
referentni klju€ni kadrovi.

v MeshLine NG Tl Spacing

Character Spacing

Word Spacing

Line Spacing

Offset X
Y

W 0.000
Scale 5.000
Detai 2.000
Roughn... 0.500
Lacunari... 2.000
Distortion 0.000

Slika 178. Prikaz vrijednosti gdje su dodane referentni kljucni kadrovi

Kada su referentne tocke postavljene, moze se krenuti s postavljanjem
ostalih klju¢nih kadrova. Potrebno je prebaciti Playhead na kadar 120 i
podesiti postavke na ¢voru Mesh Line da su vrijednosti za Offset sve na
0.01. Na ¢&voru Noise Texture treba promijeniti postavku W na vrijednost
1, Scale na vrijednost 2 te Distortion na vrijednost 6 kako bi se vidjela
promjena uzoraka po kadrovima. | za kraj valja promijeniti Character
Spacing na vrijednost 2 da se primijeti Sirenje razmaka medu slovima.
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Provjeriti da se za svaku vrijednost pritisnula tipka [I]. Nize na slici su
prikazane izmijenjene vrijednosti.

Spacing

¥ Noise Texture

v Mesh Line

Character Spacing

Word Spacing

Line Spacing

Offset X

1.000 Y
2.000

Detail 2.000

Roughn.. 0.500

Lacunari... 2.000

Distortion 6.000

Slika 179. Prikaz vrijednosti kljucnih kadrova na 120. kadru

Ako su svi klju€ni kadrovi to€no pozicionirani, moze se provijeriti tijek
animacije pomicanjem plave vertikalne linije po traci Timeline i njenim
pozicioniranjem na kadar 125 ili pritiskom na Play Animation i pustiti do
kadra 125. Ako je sve dobro, tekst bi trebalo izgledati kao na slici nize.

Slika 180. Prikaz scene na kraju animacije

JosS preostaje renderirati animaciju, no prije toga treba jo$ podesiti
postavke za Output Properties kao §to su prikazane unutar crvenih
okvira na slici nize.
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Output

ftmp\

Saving W File Extensions

File Format

Color

olor Management

Encoding
Container

Autosplit Output

Video Codec

Keyframe Int

Max B

Slika 181. Output Properties

Kada je sve spremno, moze se pokrenuti renderiranje animacije
odabirom Render-> Render Animation ili kraticom [Ctrl] + [F12].
Pricekati nekoliko minuta i pratiti pomak vertikalne plave linije na traci
Timeline. Kad linija dosegne zadniji,125. kadar, proces je zavrsen.
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7.2. Vjezba: Animiranje teksta

Zadatak ¢e se bazirati na prijaSnjem primjeru, no ovaj put ¢e se Koristiti
drugacije postavke:

1.

Otvorite novu datoteku File> New-> General te odaberite
Shading workspace. Selektiratirajte defaultnu kocku te ju obriSite
i dodajte tekstualni objekt, kratica [Shift] + [A] i odaberite Text.
Prebacite se u Top View pritiskom na tipku [7]. Selektirajte
kameru, podesite vrijednosti pod Locationna X=0.5m, Y =0.4
m, Z = 6.5 te sve vrijednosti Rotation postavite da iznose 0.
Prebacite selekciju na tekst.

Promijenite font unutar Object Data Properties El pod Font>
Regular pritisnite na ikonu Open Font te odaberite font Agency
FB Regular iz baze fontova. Zatim postavite Paragraph—>
Alignment-> Horizontal na Centar i Paragraph—> Alignment->
Vertical na postavku Middle.

U Shader Editoru dodajte novi materijal te ubacite ¢vorove Noise
Texture i Color Ramp. Spojite uti¢nicu Color, lociranu na ¢voru
Noise Texture, s uticnicom Fac na ¢voru Color Ramp. Cvor
Principled BSDF uklonite te spojite Material Output dvama
dodanim &vorovima. Na ¢voru Noise Texture uklonite kvacicu s
postavke Normalize, ostavite fBM tip buke, broj dimenzija
postavite na 4D. Vrijednosti Wi Distortion postavite na 1, ostale
postavke ostaju iste. Na ¢voru Color Ramp, selektirajte kliza¢
bijele boje i postavite ga na poziciju 0.5.

Umijesto File Browsera na lijevoj strani otvorite Geometry Node
Editor i dodajte novu grupu &vorova GEEIELI. Ubacite
¢vorove Mesh—> Primitives—> Mesh Line i Instances—> Instance
on Points. Postavku &vora Count Mesh Line postavite na
vrijednost 80. Spojite Evorove Geometry prema slici nize.

~ Mesh Line
~ Instance on Points

Offset A Instances @

1000

1.000
1.000

Slika 182. Postupak spajanja cvorova Geometry

Otvorite prozor Timeline umjesto Image Editora u donjem lijevom
kutu te pozicionirajte playhead na kadar 0. Postavite prve
odnosno referentne kljuéne tocke na:

o Wi Distortion za Cvor Noise Texture
e Offset za Cvor Mesh Line
o Character Spacing za Object Data Properties pod Spacing.

120
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6. Tekst se treba duplicirati tako da zavrSi u lijevom donjem kutu
kadra a da se istovremeno mijenjaju uzorci. Pozicionirajte
playhead na kadar 120 te dodajte klju¢ne to¢ke na postavke iz
prijaSnjeg koraka sa sljedecim vrijednostima:

e W =2 i Distortion =5 za ¢vor Noise Texture
e Offset (X=-0.001, Y=0, Z= 0.035) za ¢vor Mesh Line

e Character Spacing = 1.3 za Object Data Properties pod
Spacing

7. Provjerite mijenja li se tekst kako je bilo navedeno u proslom
koraku pritiskom na Play Animation ili pomicuci playhead od
kadra 0 do kadra 120. End, koji predstavlja finalni kadar, postaviti
na 125. Kada je sve podeSeno, mozZe se krenuti s renderiranjem
animacije.

8. Za snimanje animacije unutar prozora Output Properties pod
Output trebaju se podesiti sliede¢e postavke:

o File Format namjestite na FFmpeg Video
e Zatim pod Encoding postavite Container na MPEG-4

e Pod Video promijenite Video Codec na H.264, a Output
Quality postaviti na High Quality

9. Pokrenuti snimanje animacije odabirom Render-> Render
Animation ili kraticom [Ctrl]+[F12]. Zadniji kadar trebao bi
izgledati kao na slici nize.

Slika 183. Izgled zadnjeg kadra vjeZbe 7.2.
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8. Uvod u 3D ispisivanje

Po zavrsetku ovoga poglavija moci Cete:
o razlikovati tipove 3D pisaca
e razumijeti osnovno nacelo rada standardnih 3D pisaca
o SVG datoteku pretvoriti u Blender objekt
o pripremiti STL datoteku za 3D ispis.

Trodimenzionalno ispisivanje (engl. 3D printing) ili aditivna proizvodnja
proces je u kojem se trodimenzionalni objekti stvaraju sloj po sloj
koristeci razliCite materijale. Umjesto tradicionalnog odstranjivanja
materijala, kao kod klesanja ili rezanja, 3D printanje dodaje materijal,
obi¢no plastiku, metal, smolu ili Eak beton kako bi stvorilo zeljeni oblik
prema digitalnom modelu. Ovaj digitalni model, najéesce izraden u
softverima poput Blendera, prenosi se u format koji pisa¢ moze
interpretirati (najceS¢e formate STL ili OBJ).

Proces funkcionira tako da 3D pisac €ita slojeve digitalnog modela i,
pomocu mlaznica ili lasera, nanosi materijal u preciznim linijama dok se
slojevi ne spoje u trodimenzionalni oblik. To omogucava izradu
kompleksnih struktura koje bi bilo tedko ili skupo posti¢i drugim
tehnikama proizvodnje.

Prvi 3D pisac izumio je Charles ,Chuck" Hull 1984. godine koristeci
proces koji je nazvao stereolitografija (SLA). Ova tehnologija koristi
ultraljubiasto svjetlo kako bi o&vrsnula tekuci fotopolimer sloj po sloj, Sto
omogucava kreiranje trodimenzionalnih objekata. Hull je ideju dobio dok
je radio s UV svjetlom na ocvrscivanju premaza za stolne povrsine, a
ubrzo nakon toga razvio je i prvi funkcionalni prototip. Njegova
tehnologija postala je temelj suvremenih 3D pisaca i dovela do osnivanja
tvrtke 3D Systems, koja je pionir u industriji 3D ispisa. Hull je takoder
jedan od ljudi koji su zasluzni za stvaranje formata STL, standardnog
formata datoteka za 3D ispis. Format STL (engl. Standard Tessellation
Language) omogucava pretvaranje CAD (engl. Computer-Aided Design)
modela u podatke koje 3D pisa¢ moze koristiti za izradu slojeva objekta.

Ubrzo nakon SLA tipa pisaCa poceli su se razvijati drugi tipovi 3D
pisaca. Godine 1988. Carl Deckard, student na Sveucilistu u Teksasu,
licencirao je tehnologiju selektivhog laserskog sinteriranja (SLS) — vrstu
3D ispisa koja koristi laser za sinteriranje, odnosno okrupnjivanje
prasSkastog materijala u ¢vrste strukture. Nedugo zatim, 1989., Scott
Crump patentirao je tehnologiju modeliranja taloZenjem rastaljenog
materijala (FDM), poznatu i kao izrada s fuzijskim filamentom (FFF) te
osnovao tvrtku Stratasys, koja je i danas jedan od glavnih igraca u
industriji 3D ispisa. Te iste godine Hullova tvrtka, 3D Systems
Corporation, predstavila je SLA-1 3D pisac.
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8.1. Vrste 3D pisaca

Mnogi patenti podneseni 1980-ih za tehnologiju FDM usli su u javnu
domenu 2006. godine, §to je dodatno potaknulo rast trzista proizvodaca
3D pisaca. Jedan od zapazenih primjera je Makerbot, tvrtka osnovana
2009. godine. Makerbot je zna€ajno doprinio popularizaciji 3D ispisa i
otvorio ih profesionalcima i amaterima. Tvrtka je prodavala DIY (uradi-
sam) setove otvorenog koda omogucujuci kupcima da sastave vlastite
3D pisace. Makerbotova online baza podataka, Thingiverse, sadrzZi
stotine tisu¢a besplatnih i placenih datoteka za 3D ispis koje se mogu
preuzeti. Stranica je ubrzo postala najveéa online zajednica za 3D ispis
na svijetu. Osnovni tipovi 3D pisaca i najviSe dostupni Siroj javnosti u
danas$nje vrijeme su sljedeci:

e FDM (engl. Fused Deposition Modeling) — najpristupacnija i
najrasprostranjenija tehnologija. Koristi se za ispis slojeva
termoplasti¢nog filamenta, pa je idealna za hobiste i izradu
prototipova.

o SLA (engl. Stereolithography) — stereolitografija koristi UV
svjetlost za o€vrSéivanje tekucée fotopolimerne smole (engl.
resin), Cime se postize velika preciznost i glatka zavrSna obrada,
Sto je idealno za nakit, detaljnije figurice i dentalne aplikacije.

e SLS (engl. Selective Laser Sintering) — Koristi laser za
sinteriranje praha, najceSce plastike ili metala i nudi Cvrste,
funkcionalne dijelove pogodne za primjenu gdje su potrebne
sloZzene geometrije i izdrzljive komponente kao Sto su
automobilska i aeronauti¢ka industrija.

Fokus ¢e biti isklju€ivo na FDM i SLA pisa€ima jer su cjenovno
pristupacniji Siroj javnosti od SLS pisaca. Unato¢ najavama o jeftinijim
varijantama SLS pisaca, cijena im je i dalje do deset puta veéa od
prosjeénog FDM i SLA pisa¢a, ne raCunajuci materijale koji idu uz pisac.
SLS pisaci jos su u prijelaznoj fazi gdje je cijena poprilicno visoka, ali se
¢ini da bi u skoroj buduénosti bi mogli doc¢i do prihvatljive cijene.

8.1.1. FDM 3D pisaci

Tehnologija Fused Filament Fabrication (FFF), poznata i kao Fused
Deposition Modeling (FDM), funkcionira tako da koristi termoplastic¢ni
filament koji se zagrijava i taloZi sloj po sloj kako bi se izradio
trodimenzionalni objekt. Filament se dovodi s velike role kroz pomicni,
zagrijani ekstruder pisacCa i talozi na rastu¢em radu. Ekstuder je
mehanizam koji pritis¢e filament prema glavi za ispis. Postoje dvije vrste
ekstrudera: direktni ekstruder, koji je integriran s glavom pisaca, i
Bowden ekstruder, gdje su ekstruder i glava pisaca smjesteni odvojeno i
povezani s cijevi. Glava za ispis kreé¢e se pod racunalnom kontrolom
kako bi se definirao oblik ispisa. Obi¢no se glava krece u dvije dimenzije
kako bi polozila jedan horizontalni sloj odjednom. Zatim se radna
platforma ili glava za ispis pomi€e vertikalno za malu koli¢inu kako bi
zapocela novi sloj. Brzina glave ekstrudera takoder se moze kontrolirati
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kako bi se zaustavilo i ponovno pokrenulo talozenje te stvorila prekinuta
povrSina bez stvaranja ili kapanja izmedu dijelova.

NiZe na slici prikazan je FDM pisac kako talozi rastaljeni filament [1] od
plasti€nog materijala koji prolazi kroz zagrijanu pomicnu glavu (engl.
hotend) [2] koji ga tali i ekstrudira talozeci ga sloj po sloj i stvarajuci
zeljeni oblik [3]. Pomi¢na platforma [5] spusta se nakon svakog novog
sloja. Ovo je jedno od nacela rada FDM pisaca, a postoji i druga
varijanta u kojoj se podloga pomice naprijed i nazad po y-osi, dok se
pomicna glava koristi za kretanje po x- i z-osi, odnosno lijevo/desno i
gore/dolje. Kod ovog tipa 3D pisac¢a potrebne su dodatne vertikalne
potporne strukture (engl. supports) [4] kako bi se podrzao prevjes.
Potporne strukture manje su gustoé¢e od samog objekta radi ustede na
materijalu i lak8eg uklanjanja nakon ispisivanja.

1

LG
ey, —

Slika 184. Osnovni dijelovi FDM pisaca

Kada ekstruder nanese materijal, on se hladi i stvrdnjava, ¢ime se sloj
stabilizira. Neki FDM pisaci koriste dodatne ventilatore za brzo hladenje i
pobolj$anje preciznosti. Objekti ispisani ovim tipom pisa¢a mogu biti vrlo
Cvrsti, ovisno o tipu materijala. PLA (polilakti¢na kiselina) najrasireniji je
filament materijala za FDM 3D ispis jer se najéeSce koristi za prototipove
i dekorativne objekte. Niske je cijene i vrlo je ekoloSki prihvatljiv bududi
da se dobiva iz biorazgradivih elemenata. No nije podlozan visokim
temperaturama ili jaCim optereéenjem jer je krut i relativho lomljiv pod
stresom i krene se meksati na temperaturama vec¢im od 60 °C. Nize je
prikazan primjer FDM 3D pisaca.
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Slika 185. Primjer FDM pisaca

8.1.2. SLA 3D pisaci

SLA (stereolitografija) je tip 3D pisaca koji koristi tekucu fotopolimernu
smolu i lasersku tehnologiju za izradu preciznih modela sloj po sloj. Ova
tehnologija je poznata po visokoj razlu€ivosti i detaljima, zbog €ega je
popularna u industrijama gdje je potrebna visoka preciznost, kao $to su
dentalna medicina, prototipiranje i izrada nakita. Resin printovi, unato¢
svojim prednostima, ve¢inom su krhki. Postoji vise vrsta fotopolimernih
smola i neke od njih su izdrZljive, ali dolaze s ve¢om cijenom. SLA pisaci
imaju nekoliko varijanti:

¢ Kilasi¢ni SLA koristi lasersko izlaganje za o€vrS¢ivanje smole.

o DLP (engl. Digital Light Processing) koristi projektor za izlaganje
cijelih slojeva odjednom, $to omoguéava brze ispisivanje.

o MSLA (engl. Masked Stereolithography) koristi LCD ekran za
izlaganje slojeva smole pruzajuci slicne prednosti kao DLP, ali s
viSom razluCivosti. Trenutno naj¢eSce koriStena varijanta.

e PolyJet - koristi inkjet tehnologiju za ispis viSe vrsta smola u
jednom procesu omogucavajuci mijeSanje boja i materijala.

Buduci da je MSLA trenutno je najces¢ée koristena varijanta SLA
tehnologije za 3D ispisivanje, fokusirat ¢emo se na rad ovog tipa. MSLA
pisaci koriste LCD ekrane za prikazivanje maski svjetlosti na slojevima
smole omogucujuéi brzu izradu s visokom precizno$cu. Ekran je
podijeljen u piksele, pri Cemu svaki piksel moze biti aktiviran ili
deaktiviran kako bi propustao UV svjetlo na odredenim podrucjima
smole.

Standardni LCD ekran koiji se koristio za SLA bio je RGB LCD ekran.
Ovi ekrani koriste crvene, zelene i plave filtere za prikaz boja, sto ih €ini
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pogodnima za opc¢u upotrebu u uredajima poput televizora ili monitora. U
kontekstu 3D ispisivanja njihova upotreba nije optimalna jer filteri
smanjuju prozracnost i time oteZavaju prolazak UV svjetlosti potrebne za
ocvrscivanje smole. To rezultira duljim vremenom otvrdnjavanja, nizom
kvalitetom ispisa i kraéim vijekom trajanja ekrana, obi¢no od 200 do 700
sati ovisno o modelu i upotrebi.

Monokromatski LCDovi, s druge strane, nemaju boje, vec rade s
jednom valnom duljinom svjetlosti, obi¢no oko 405 nm, §to je optimalno
za vecinu smola. Njihova prednost lezi u vec¢oj prozraénosti, sto
omogucava brze otvrdnjavanje smole. Monokromatski LCD-ovi imaju
duzi vijek trajanja, ¢esto do 2000 sati, i brze ispisivanje, sto ih €ini
popularnim izborom medu korisnicima 3D pisaca.

Ovi uredaji su popularni i zbog nizih cijena u usporedbi s tradicionalnim
SLA pisacima koji koriste lasere za polimerizaciju smole. Zahvaljujuci
ovim prednostima, MSLA je postao Siroko prisutan u hobistickim i
profesionalnim zajednicama 3D ispisivanja, ukljuCujuci podrucja kao sto
su zubna medicina i izrada preciznih modela.

MSLA 3D pisaéi sastoje se od sljedecih komponenti:

e LCD ekran: MSLA koristi LCD ekran koji prikazuje cijeli sloj kao
sliku. Ekran selektivno propusta UV svjetlo kroz podrucja gdje je
smola potrebna.

e lzvor UV svjetla: Smjesten ispod LCD ekrana i projicira UV
svjetlost kroz njega o¢vrséujuéi smolu u obliku sloja odjednom.

e Spremnik za smolu: Kao i kod SLA pisaca, posuda za smolu
gdje se smola ocvrséuje.

¢ Platforma za ispis (Z-0s): pomiCe se prema gore nakon svakog
sloja omogucujuéi stvaranje trodimenzionalnog objekta.

o Kontrolni sustav: Upravljanje zaslonom, UV izvorom i
platformom kako bi slojevi bili precizno postavljeni.

NiZe na slici prikazano je nacelo rada MSLA pisaca. Platforma drzi na
svojoj povrsini 3D strukturu koja je uronjena u smolu i, podizuéi se
prema gore, stvara nove slojeve.

Platforma za ispis

Oc¢vricéena 3D
struktura

———— UV svijetlo

Slika 186. Osnovni dijelovi SLA pisaca
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Kada je ispisivanje gotovo, platforma ¢e se podici do vrha vodilice koja
kontrolira kretnje platforme. Kao i kod FDM pisaca, 3D struktura je
podrZana potporama, koje se lagano mogu ukloniti. NiZe na slici
prikazan je gotov ispis s potporama.

Slika 187. Gotov print s potporama

Kao zadniji korak potrebno je procéi kroz proces CiS¢enja kako bi se
uklonili ostaci smole i dobio gotov i ¢vrst model. Prvo, model se odvaja
od platforme i zatim ispire u izopropilnom alkoholu (IPA) ili drugom
otapalu kako bi se uklonila teku¢a smola koja je ostala na povrSini.
Aceton isto nije oS jer se moze Kkoristiti viSe puta. Ovaj korak je
krucijalan buduéi da moze utjecati na pravilno o€vrséivanje modela.
Nakon ispiranja u otapalu treba pro¢i vodom da se uklone ostaci smole i
otapala. Zadnja faza je Post-Curing ili dodatno oc¢vr§¢ivanje, kad se
model stavlja pod UV svjetlo kako bi ga se dodatno ovrsnulo. Taj
proces dodatnog o¢vricivanja osigurava da model postigne Zeljenu
Cvrstocu i stabilnost. Preporuka je ukloniti potpore s modela prije zadnje
faze ocvrSc¢ivanja. NiZe na slici prikazana je naprava Curing Station u
kojoj se postavlja model za finalnu fazu o¢vrs¢ivanja. Ima i opciju
Cid¢enja koja obavlja prijasnji korak.

Slika 188. Primjer Curing station naprave
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8.2. Spremanje objekta u formatu STL u Blenderu

Kao zadniji primjer uvest ¢e se Blenderov logo koji je SVG datoteka te ¢e
se konvertirati u mesh objekt, pripremiti za 3D ispisivane i spremiti kao
STL datoteku. Prvo treba otvoriti novu datoteku te uvesti datoteku
blender-logo-vector.svg iz mape Vjezbe tako da se odabere File>
Import-> Scalable Vector Graphics (.svg), selektirati SVG datoteku i
pritisnuti Import SVG. Trebao bi se pojaviti logo kao na slici nize. Moze
se selekirati tri segmenta u tom objektu, vanjski naranc€asti krug i dva
unutarnja kruga bijele i plave boje.

Slika 189. Ubacena STRL datoteka

Buduci da je trenutno bez dubine, potrebno ga je prvo prosiriti po z-osi,
ali svaki sloj se treba zasebno prosiriti. Potrebno je selektirati naranCasti
sloj te oti¢i na Object Data Properties> Geometry—> Extrude i upisati
vrijednost 0.04. Ponoviti postupak za preostala dva sloja, samo kod
bijelog sloja, umjesto 0.04, postaviti vrijednost na 0.02.

Geometry

Taper Radius = Override

Slika 190. Extrude postavka

Kada su slojevi podeSeni, potrebno ih je sve zaokruZiti i konvertirati u
drugaciji tip objekta. Logo je trenutno Curve tip objekta, Sto ukazuje da
je taj objekt krivulja. Kako bi se omogucilo daljnje uredivanje i priprema
za konverziju u STL datoteku, treba ga konvertirati u mesh objekt.
Nakon $to su svi selektirani, treba pritisnuti [RMB] i odabrati Convert
to> Mesh. | usput, kada su selektirani, opet pritisnuti desnu tipku misa i
odabrati naredbu Join kako bi ih se spojilo u jedan objekt. Nakon

spajanja objekt bi trebao izgledati kao na slici niZe.
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Slika 191. Konverzija u mesh tip objekta

Jos preostaje zadnji korak, a to je eksportiranje u format STL odabirom
File=> Export-> STL (.stl), a zatim treba odabrati mapu gdje ¢e se
spremiti pod nazivom Blender_logo.stl i pritisnuti Export STL. Datoteka
je spremna i sad treba provjeriti prepoznaje li ga uistinu jedan od
softvera za pripremanje 3D modela. Ti softveri se zovu slicer iz razloga
8to je njihova uloga da pripreme 3D modele za ispisivanje tako &to ih
,rezu” na tanke slojeve (engl. slice). Ovi slojevi sadrze informacije koje
3D pisac koristi za postupno gradenje fiziclkog modela sloj po sloj. Slicer
softver pretvara 3D model (najéesce u formatu STL ili OBJ) u G-kod,
specificnu vrstu datoteke s uputama koje 3D razumije i koristi kao upute
za ispisivanje. Medu popularnijim Slicer softverima su Ultimaker Cura,
PrusasSlicer, Lychee Slicer i ChituBox. Kao primjer koristit ce se
ChituBox za otvaranje STL datoteke za provjeru i niZe na slici se moze
vidjeti da ga je softver prepoznao i da ga se moze podesiti za
ispisivanje. Ovisno o softveru, postupak je sli¢an, treba se odabrati
model 3D pisaCa unutar tog softvera da bi se ,rezanje” objekta uspjesno
zavrsilo.

Slika 192. Sucelje softvera ChituBox
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8.3. Vjezba: Spremanje objekta u formatu STL

Zadatak &e se bazirati prema prijasnjem primjeru koriste¢i drugadiji logo:

1.

Otvorite novi file te ucitaje datoteku City 17 logo.svg iz mape
Vjezbe tako da odaberete File> Import-> Scalable Vector
Graphics (.svg), selektirate SVG datoteku i pritisnete Import
SVG.

Selektirajte logo te otidite na Object Data Properties>
Geometry~> Extrude i upiSite vrijednost 0.01.

Selektirajte objekt te pritisnite [RMB] i odaberite Convert to>
Mesh. Objekt ima samo jedan sloj, tako da naredba Join nije
potrebna. NiZe je prikazan logo nakon konverzije u mesh tip
objekta.

Slika 193. Objekt nakon konverzije u mesh tip objekta

. Zadnji korak je eksportirati u format STL odabirom File->

Export-> STL (.stl), zatim odabrati mapu gdje ¢e se spremiti pod
nazivom City 17 logo.stl i pritisnuti Export STL.
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Prilog 1. - Repeat Zone

Po zavrsetku ovoga poglavija moci Cete:
e izraditi workspace po svojim potrebama
o Koristiti Repeat Zone
o Koristiti Evorove Extrude Mesh i Scale Elements

e koristiti Svor Random Value

Repeat Zone u Blenderu je nacin za ponavljanje skupa ¢vorova u petlji.
Omoguc¢ava ponavljanje odredenih operacija unutar definiranog
podrucja (engl. zone) odreden broj puta, bez ru¢nog dupliciranja
Cvorova. Koristi posebne ¢vorove Repeat Input i Repeat Output za
upravljanje ponavljanjima unutar definirane zone. Ulazi povezani na ¢vor
Repeat Input uCitavaju se na pocetku, prije nego $to se pokrene
ponavljanje. Zatim se prosljeduju unutar zone gdje se mogu mijenjati i
prenose se u sljedecu iteraciju. Taj se proces ponavlja odreden broj
puta, ovisno o broju iteracija pod Iterations. Drugi ¢vorovi izvan te zone
mogu biti povezani kao ulazi unutar Repeat Zonea. Oni su konstantni
kroz svaku iteraciju i temeljeni na svojoj vrijednosti u trenuthnom okviru.
Izlazi iz zone moraju biti povezani kroz &vor Repeat Output.

~ Repeat ~ Repeat

Iterations __—=9 Geometry

® Geometry

Slika 194. Cvor Repeat zone

Kao primjer uzet ¢e se Mesh—> Operations—> Cvor Extrude Mesh unutar
Repeat Zonea kako bi se generirale ekstruzije svakog lica na default
kocki. Cvor Extrude Mesh omoguéava izduZivanje postojeée geometrije
modela kako bi se stvorile nove povrsine. Koristan je kod modeliranja
slozenih objekata jer omoguéava dodavanije detalja bez potrebe za
ruénim stvaranjem novih elemenata. U sredini Evora moze se izabrati
Mode, on odlucuje hoce li &vor utjecati na Faces (lica), Edges (bridove)
ili Vertices (vrhove). Faces je default postavka te ¢e se ona koristiti. S
lijeve strane ¢vora dostupno je nekoliko ulaza ili priklju¢aka. Mesh je
osnovni ulazni priklju€ak za objekte koje ¢e ¢vor ekstrudirati. Selection
se koristiti za kontrolu dijelova objekta koje ¢e &vor ekstrudirati. Offset i
Offset Scale odreduju za koliko ¢e se ekstrudirati selektirani dijelovi
objekta. Opcija Individual samo je dostupna sa selekcijom Faces te
odreduje hoce li se lica ekstrudirati zasebno, svaka po svojoj normali ili
zajedno kao regija. S desne strane ¢vora je izlazni priklju¢ak Mesh te
prikljucci Top i Side. Top se odnosi na vrhove novostvorene geometrije
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objekta, dok Side za novostvorenu bo¢nu geometriju. Na slici nize je
prikazan &vor Extrude Mesh.

~ Extrude Mesh

Offset
¢  Offset5.. 1000

@ o Individual

Slika 195. Cvor Extrude Mesh

Na jednostavnom primjeru ¢e se prikazati utjecaj Repeat Zonea na
Extrude Mesh. Da bi zona radila, za poCetak trebaju se spojiti Evorovi
Group Input i Repeat Input te Evorovi Group Output i Repeat Output
kako bi se zatvorio krug i rad na objektu bio vidljiv. Sada se moze ubaciti
¢vor Extrude Mesh unutar zone. On ¢e se automatski spojiti s Repeat
Zone ¢vorovima koristeci svoje Mesh prikljucke. Kao primjer izabrat ¢e
se ekstradiranje vrhova novostvorene geometrije, odnosno koristit ¢e se
priklju€ak Top. Repeat Zone Cvorovi mogu stvarati nove prikljucke, a
buduci da moraju biti upareni radi prijenosa podataka kroz sve iteracije,
oni medusobno utje€u jedan na drugog. Drugim rijeCima, ako jedan évor
dobije novi priklju¢ak, dobit ¢e ga i drugi. Znajuci to, mozZe se spojiti Top
priklju€ak na prazan priklju¢ak ¢vora Repeat Input te Ce se tako pojaviti
priklju¢ak Top na oba Repeat Zone ¢vora. Oba ¢vora imaju izlaznu i
ulaznu varijantu priklju¢ka, a na évoru Repeat Input, pokraj ulaznog
prikljuCka Top pojavilo se prazna polje za stavljanje kvacice. Sada je
moguce selekciju ograniCiti na vrhove buduci da je Repeat Input dobio
izlazni priklju¢ak Top koji je sada moguce spojiti s ulaznim priklju¢kom
Selection Evora Extrude Mesh. Nakon to€nog spajanja Cini se da zona i
dalje ne radi jer se kocka nije promijenila. Razlog za to je Sto priklju¢ak
roza boje, Sto znaci da radi s Boolean podacima True (istina) ili False
(laz) te je potrebno na &voru Repeat Input staviti kvacicu na Top. Sada
kada prijedete miSem na priklju¢ku pored kvacice piSe True i rezultat je
postao vidljiv. NiZe na slici prikazani su ¢vorovi i njihove postavke te
desno rezultat ekstruzije vrhova na kocki.

Nodes [0 IESIE
~ Extrude Mesh v Repeat
Mesh ®—@ Geometry
Top #—¢ Top
v Repeat Side 4
Tterations
-® Geometry

© ¥ Top P

Offset

© Offset S.. 1.000
@ ¥ Individual

Slika 196. Postavke cvorova i rezultat postavki

Prije nego se pocne s konkretnim primjerom bilo bi dobro urediti radnu
povrsinu ili Workspace da se ukomponira tri Node Editora koja su bila
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koriStena u prijasnjim primjerima i ukljuciti traku Timeline buduci da ¢e
svi biti potrebni za ovaj zadatak. Umjesto da se svaki put prilagodava
radna povrsina kada se otvori nova scena postoji nacin da se napravi
Workspace po Zeljama korisnika te da ta varijanta Workspacea uvijek
bude dostupna kao opcija umjesto samo default radnih povrsina koje
dolaze s Blenderom. Potrebno je odabrati bilo koji Workspace, primjerice
Shading Workspace jer se on Cini kao najbliZi izgledu koji Ce biti
potreban za ovaj zadatak te ¢e biti brza prilagodba. 3D Viewport treba
podesiti da je otprilike istih dimenzija kao $to su ostali prozori, a zatim
umjesto prozora File Browser i Image Editor postaviti prozore Geometry
Node Editor i Compositor te ubaciti traku Timeline unutar prozora 3D
Viewport da se nalazi na dnu jer nije potrebno previse prostora.
Potrebno je postaviti Use Nodes unutar prozora Compositor uklju¢en da
ostane kao default postavka u tom workspaceu. Daljnja podeSavanja
dimenzija prozora izvode se prema potrebama korisnika. Kada je sve
spremno, dvostrukim pritiskom na ime workspacea treba ga
preimenovati po zelji, primjerice u Custom_Workspace. Zatim ga je
potrebno spremiti da je dostupan svaki put kada se otvori nova scena
tako da se ode na File> Defaults> Save Startup File. Workspace, bio
predefiniran (default) ili napravljen od strane korisnika, moze se pomicati
na pocetak ili na kraj trake koriste¢i Reorder to Front i Reorder to
Back te se mogu brisati i stvarati duplikati trenutnog workspacea. lkona
plusa na samom kraju trake sluzi za dodavanje workspaceova koji
dolaze s Blenderom i onih koji su slozeni i spremljeni od strane
korisnika.

Modes_animate

[T Duplicate

— Delete

14 Reorder to Front

Slika 197. Postavljanje poredka radnih povrsina

Workspace je spreman tako da se sada moze krenuti s primjerom.

Animiranje s Repeat Zone

Umijesto default kocke koja se brise, kraticom [Shift] + [A] pod Mesh
treba dodati Ico Sphere, sferu koja se sastoji od 80 trokuta. Informacije
o svakom objektu poput broja to€aka, rubova i lica dostupne su kada se
ukljuCi postavka Vieport Overlays—> Statistics. Nize na slici je lokacija
postavke Statistics i s lijeve strane koje informacije prikazuje na ekranu.
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Object 12, Global v (v G iv (= v @y T OCH
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User Perspective
(1) Collection | Icosphere

Objects 1/3
Vertices 42/42
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Faces 80/ 80
Triangles 80/80

o Text Info » 3D Cursor

o Statistics o Annotations

o Outline Selected

Slika 198. Ukljucena postavka Statistics

Ico Sphere ¢e se koristiti jer je cilj kreirati objekt s puno Spicastih
krakova da sli¢i zvijezdi, a to Ce se posti¢i Repeat Zoneom. Krenut ¢e
se prvo s prozorom Geometry Node dodajuci novu grupu &vorova na
New. Zatim treba ubaciti Evor Repeat Zone i Extrude Mesh, kao u
kratkom primjeru te ih spojiti na isti nacin. Opet ¢e se koristiti Top jer su
potrebni vrhovi. Na slici nize prikazano je kako bi to trebalo izgledati s
istim postavkama koje su se koristile u prijaSnjem primjeru.

Slika 199. Izgled Ico Sphere objekta s cvorom Extrude Mesh

No, kako bi se postigao Spicasti vrh, potrebno je ubaciti dodatni &vor, koji
bi suzio vrhove, a to se moze pomoc¢u ¢vora Scale Elements. Nalazi se
pod Mesh—> Operations—> Scale Elements te ga se ubacuje izmedu
¢vorova Extrude Mesh i Repeat Output i automatski se spaja s njima.
Koristit e se zadane postavke, pod Domain ostaje Face i pod Scale
Mode ostaje Uniform, tako da se svako lice skalira istim faktorom u
svim smjerovima, odnosno jednako u odnosu na sve osi. Pod Scale
treba upisati vrijednost 0.3. Spoijiti priklju¢ak Top na ¢voru Extrude Mesh
s priklju¢kom Selection na &voru Scale Elements tako da je skaliranje
ograni¢eno samo na vrhove. Broj iteracija odnosno broj ponavljanja na
¢voru Repeat Input treba postaviti na vrijednost 5. Krakovi trebaju biti
duzi da bi se lakSe postigao zeljeni efekt. Nize na slici vidi se sljedeci
korak u doradivanju izgleda i potrebne postavke ¢vorova.
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v Extrude Mesh

Slika 200. Izgled Ico Sphere objekta s dodanim Scale ¢vorom Elements

Osnovni oblik je podesSen do kraja, jo$ preostaje ubaciti malo
nasumicnosti za duzinu krakova. Offset Scale odreduje koliki je pomak
izmedu svake iteracije te, ako se ubaci nasumicnost u tu vrijednost,
dobit ¢e se razli¢itost u duzinama krakova. Ovo se moze postic¢i ako se
doda pod Utilities~> &vor Random Value i spoji na priklju¢ak Offset
Scale na &voru Extrude Mesh. Cvor Random Value radi s nekoliko vrsta
podataka koji se mogu odabrati na postavci Data Type. Float generira
decimalne brojeve, Integer radi s cijelim brojevima, Vector koristi
vektorske vrijednosti te Boolean daje vrijednosti koje su True ili False,
Sto omogucéuje nasumicnost generiranja krakova, ovisno o postavci
Probability. Sto je vrijednost Probability veéa, to je veci broj krakova.
Boolean nije 108 izbor, no bolji izbor je koriStenje integer tipa podatka.
Integer raspolaze trima vrijednostima, Min, Max i Seed. Min i Max
predstavljaju minimalnu i maksimalnu vrijednost moguéeg pomaka, ¢vor
Random Value nasumicno bira vrijednosti u tom rasponu vrijednosti.
Seed se koristi da se generiraju razli€iti setovi nasumicnih vrijednosti.
Promjenom vrijednosti Seed mijenja se slijed generiranih slu¢ajnih
vrijednosti, Sto daje varijaciju. Treba postaviti vrijednost Min na 1,
vrijednost Max na 3 te Seed proizvoljno po izboru korisnika, promatrati
kako se krakovi objekta mijenjaju te postaviti po osobnom izboru, svatko
¢e imati malo drugaciju varijantu. NiZe na slici vidi se dodani ¢vor
Random Value s postavkama i rezultat promjena na objektu unutar 3D
Viewporta.

Slika 201. Izgled Ico Sphere objekta nakon dodanog Random Value ¢vora

Rad u Geometry Node Editoru je gotov, preostaje dodati materijal i
efekte. Potrebno je selektirati ,zvijezdu“ te dodati novi materijal unutar
prozora Shader Editor. Cvor Principled BSDF treba ukloniti i zamijeniti
&vorom Emission te dodati &vorove Color Ramp i Noise Texture. Cvorovi
Color Ramp i Emission spajaju se koristeéi Color prikljucke, a Noise
Texture i Color Ramp koristeéi prikljucke Color i Fac. Koristit ¢e se dvije
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boje. Treba selektirati prvi kliza¢ i postaviti ga na poziciju 0.360 te
podesiti vrijednosti boje na Hue (0.75), Saturation (0.930), Value (1.0) i
Aplha(1.0) da se dobije ljubi€asta boja. Zatim treba selektirati drugi
kliza€, postaviti ga na poziciju 0.6 i podesiti vrijednosti boje na Hue (0.5),
Saturation (0.920), Value (1.0) i Alpha (1.0) za tirkiznu boju. Na ¢&voru
Emission postaviti vrijednost Strength na 0.5, viSe vrijednosti su previSe
intenzivne. Postavke za Noise Texture urediti tako da je pod Dimensions
postavljeno na 4D, a W-vrijednost neka iznosi 0.6. Scale postaviti na
0.3, na vecim vrijednostima uzorak izgleda previSe zasicen. Potrebno je
Detail postaviti na vrijednost 2 da bi se dobio magloviti izgled uzorka te
Distortion na vrijednost 1.2. NiZe su prikazani ¢vorovi sa svojim
postavkama.

~ MNoise Texture ~ Color Remp ~ Emission ~ Material Output

Fac @ Color @, Emission @

Color ® Alpha ® g Color

4D v | 8. ol ilinear v @  Strength 0.500

fBM
» MNormalize
0.600
Vector
0.600
0.300
Detail 2.000
Roughn... 0.500
Lacunar... 2.000

Distorti... 1.200

Slika 202. Cvorovi i njihove postavke u Shader Editoru

Prije nego se nastavi dalje s Compositor postavkama, treba podesiti
kameru da je veéi dio objekta vidljiv. Unutar prozora 3D Viewport, kada
se pritisne tipka [N] za otvaranje Sidebara, treba pronaci karticu View te
ukljuciti postavku Camera to View koja omoguéava da svi pomaci koji
se naprave u prikazu (povlacenje srednje tipke misa i drzeci [Shift],
zumiranije ili rotiranje) pomicu cijelu kameru. NiZze na slici prikazana je
lokacija opcije Camera to View gdje treba postaviti kvacicu za
ukljucivanje.

Clip Start

End

Local Camera

« Passepartout

!

“'&,

View Lock

Lock To 3D Cursor
/ Camera to View

Slika 203. Ukljucivanje postavke Camera to View

Potrebno je podesiti poziciju kamere prema izboru korisnika, vazno je da
glavni objekt vecinski vidljiv i da nije previSe zumiran. Sada kada je
kamera podeSena moze se krenuti na Compositor postavke. Kao i u
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drugim primjerima iz prijasnjih poglavlja, izbor ¢vorova i njihovo
postavljanje je isto, ubacuju se ¢vorovi Glare i Viewer, uz vec¢ prisutne
Cvorove Render Layers i Composite koji dolaze automatski. Jedina je
razlika Sto ¢e se na ¢voru Glare odabrati drugacdiji tip bljestavila. Pod
Glare Type treba postaviti na Simple Star koji, kao §to i sam naziv
sugerira, stvara efekt jednostavne zvjezdane svjetlosti oko svijetlih
dijelova slike. Na ¢voru Glare, pod lterations treba postaviti vrijednost 3.
postavka lteration kontrolira broj ponavljanja efekta bljestavila, Sto
povecava detalje i intenzitet efekta. ViSe iteracija znaci da Blender
ponavlja proces stvaranja bljestavila viSe puta, Sto moze uciniti zrake i
svjetlosni efekt izraZenijim, ali i zahtijeva viSe vremena za renderiranje.
ViSe iteracija daje ,meksi" izgled efektu ili da ima viSe slojeva, §to je
korisno za postizanje suptilnijeg i prirodnijeg izgleda bljesStavila.
Potrebno je postaviti da je Treshold na nizoj vrijednosti, poput 0.1, da se
viSe izrazi bljestavilo. Potrebno je ukljuiti Backdrop da se efekt Evorova
vidi u pozadini prozora te pritisnuti na Render Active Scene na ¢voru
Render Layers da je vidljiva slika na kojoj ¢e se primijeniti ti efekti. Na
slici nize je prikazan Compositor prozor sa spojenim ¢vorovima i
njihovim postavkama.

— ¥ Use Nodes %, Backdrop KWK R G

High

Tterations

w RenderLayers b Mix 0.000

Threshold

Slika 204. Prozor Compositor sa spojenim ¢vorovima

Jos preostaje postaviti kljuéne kadrove prije nego se krene sa
snimanjem animacije. U ovom zadatku samo ¢e se zarotirati objekt u
nasumicnim smjerovima, pomoc¢u naredbe Trackball Rotation ili Free
Rotation. Ona omogucava slobodnu rotaciju objekta u svim smjerovima,
bez ograni¢enja na samo jednu os, 5to daje vecu kontrolu nad
orijentacijom objekta jer mozete rotirati objekt u bilo kojem smjeru
direktno iz perspektive pogleda. Nakon selekcije objekta pritisne se tipka
[R] dva puta da bi se aktivirao Free Rotation. Prije postavljanja klju¢nih
kadrova na traci Timeline, valja postaviti da je zadnji kadar na 60,
odnosno upisati pod End vrijednost 60 radi ustede na vremenu
renderiranja. Zatim jo$ jednom provjeriti je li kamera podeSena po
osobnim Zeljama te iskljuciti opciju Camera to View, nece viSe biti
potrebna. Treba pripaziti da je Playhead postavljen na kadar O unutar
trake Timeline. Zatim je potrebno pritisnuti na karticu /fem unutar
prozora 3D Viewport te postaviti poCetne kljuéne tocke na Rotation
vrijednosti. Kada se pojave klju¢ne tocke, treba prebaciti na kadar 60 i
pomocu naredbe Free Rotation, pritiskom na tipku [R] dva puta,
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proizvoljno rotirati objekt i u jednom trenutku pustiti i ubaciti klju¢ne
kadrove unutar vrijednosti Rotation. | u sustini, to je sve za ovaj zadatak,
sad jo$ preostaje snimiti tu animaciju. Unutar prozora Render Properties
treba postaviti na EEVEE za izbor Render Enginea i staviti kvacicu na
Raytracing. Pod Output Properties promijeniti File Format na FFmpeg
Video te pod Encoding postaviti Container na MPEG-4 i za Video
Codec postaviti na H.264. Output Quality, koji je opcija nize, moze se
postavljeno kako je navedeno i onda pokrenuti snimanje animacije na
Render-> Render Animation. Treba priCekati par minuta da se
animacija renderira. Nize na slici je prikaz zadnjeg kadra renderirane
animacije.

N
%m N\

Slika 205. Prikaz zadnjeg kadra animacije
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Vjezba: Repeat Zone

Zadatak &e se bazirati prema prijaSnjem primjeru, a objekt na kojem ¢e
se raditi zadatak je bazi¢na kocka s drugacijim postavkama:

1.

Otvorite novu datoteku File> New-> General te odaberite
Custom_ Workspace ako ve¢ nije automatski postavljen.
Selektirajte defaultnu kocku te dodajte Utilities—> Repeat Zone
unutar Geometry Node Editora. Spojite Evorove Group Input i
Repeat Input te Evorove Group Output i Repeat Output kako bi
se zatvorio krug. Ubacite Mesh-> Operations—> Extrude Mesh
unutar Repeat Zonea. Spojite priklju¢ak Top na prazan priklju¢ak
Cvora Repeat Output tako da se priklju¢ak Top pojavi na obama
Cvorovima Repeat Zonea. Spojite priklju¢ak Selection na ¢voru
Extrude Mesh sa rozim priklju¢kom s desne strane (ako prijedete
miSem na priklju€ak, piSe Top) na ¢voru Repeat Input te stavite
kvacicu unutar kucice pored priklju¢ka Top.

Ubacite Mesh-> Operations—> Scale Elements te ga
pozicionirajte izmedu ¢vorova Extrude Mesh i Repeat Output.
Spoijite priklju€ak Top na &voru Extrude Mesh s prikljuCkom
Selection na ¢voru Scale Elements. Skaliranje je ograni¢eno
samo na vrhove. Broj iteracija na ¢voru Repeat Input postavite
na vrijednost 8. Scale na Scale Elements postavite na vrijednost
0.7.

Prebacite se na Shader Editor, izbriSite ¢vor Principled BSDF i
zamijenite ga ¢vorom Emission. Dodajte ¢vorove Converter->
Color Ramp i Texture> Noise Texture. Cvorove Color Ramp i
Emission spojite koristeéi prikljuc¢ke Color, a Noise Texture i
Color Ramp koristeci priklju¢ke Colori Fac.

Selektirajte prvi kliza¢ i postavite ga na poziciju 0.4 te podesiti
vrijednosti boje na Hue (0.6), Saturation (0.95), Value (0.8) i
Aplha (1.0) da se dobije plava boja. Zatim selektirajte drugi
kliza€, postavite ga na poziciju 0.6 i ostavite bijelu boju. Postavku
Strength na ¢voru Emission podesite na vrijednost 0.5. Za &vor
Noise Texture podesite Dimensions na 4D, W-vrijednost na 0.6,
te Scale i Distortion na vrijednost 2.

Unutar prozora Compositor ubacite ¢vorove Glare i Viewer.
Cvorovi Render Layers i Composite dolaze automatski. Cvor
Glare ubaciti izmedu ¢vorova Render Layers i Composite, a Evor
Viewer spojite na &vor Glare preko uti¢nice Image. Na ¢voru
Glare postavite Glare Type na Bloom, vrijednost Threshold na
0.3 i Quality na High. Selektirati kameru te ju podesiti da uhvati
cijeli objekt koristeéi opciju Camera to View, pod karticom View
(lociran na desno) unutar 3D Viewporta. IskljuCite tu opciju kada
je kamera podeSena. Ukljucite Backdrop i pritisnite na Render
Active Scene na ¢voru Render Layers.

Na traci Timeline upiSite pod End vrijednost 60. Postavite
Playhead na kadar 0 unutar trake Timeline. Pritisnite na karticu
Item unutar prozora 3D Viewport te postavite pocCetne kljuéne
to¢ke na Rotation vrijednosti. Prebacite na kadar 60, pod
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Rotation upisite X = 30°, Y = 15°, Z = 180°. Postavite klju¢ne
toCke na Rotation vrijednosti za kadar 60.

7. Unutar prozora Render Properties postavite na EEVEE i stavite
kvacicu na Raytracing. Pod Output Properties promijenite File
Format na FFmpeg Video te pod Encoding postavite Container
na MPEG-4 i za Video Codec postavite na H.264. Output Quality
postavite na High Quality. Provjerite postavke te pokrenite
snimanje na Render-> Render Animation. PriCekajte par minuta
da se renderiranje zavrsi. NiZe na slici je prikaz zadnjeg kadra
renderirane animacije.

Slika 206. Izgled zadnjeg kadra vjezbe 9.2.
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